Администрирование
Rational ClearQuest

Версия: 2001.03.00

Windows/UNIX Edition

800-023976-000

IMPORTANT NOTICE

COPYRIGHT NOTICE

ClearQuest, copyright 1997-2000 Rational Software Corporation. All rights reserved.

THIS DOCUMENT IS PROTECTED BY COPYRIGHT AND CONTAINS INFORMATION PROPRIETARY TO RATIONAL. ANY COPYING, ADAPTATION, DISTRIBUTION, OR PUBLIC DISPLAY OF THIS DOCUMENT WITHOUT THE EXPRESS WRITTEN CONSENT OF RATIONAL IS STRICTLY PROHIBITED. THE RECEIPT OR POSSESSION OF THIS DOCUMENT DOES NOT CONVEY ANY RIGHTS TO REPRODUCE OR DISTRIBUTE ITS CONTENTS, OR TO MANUFACTURE, USE, OR SELL ANYTHING THAT IT MAY DESCRIBE, IN WHOLE OR IN PART, WITHOUT THE SPECIFIC WRITTEN CONSENT OF RATIONAL.
U.S. GOVERMENT RIGHTS NOTICE

U.S. GOVERMENT RIGHTS. Use, duplication, or disclosure by the U.S. Government is subject to restrictions set forth in the applicable Rational License Agreement and in DFARS 227.7202-1(a) and 227.7202-3(a) (1995), DFARS 252.227-7013(c)(1)(ii) (Oct 1988), FAR 12.212(a) 1995, FAR 52.227-19, or FAR 52.227-14, as applicable.
TRADEMARK NOTICE

Rational, the Rational logo, ClearQuest, ClearCase, Purify, PureCoverage, and Quantify are trademarks or registered trademarks of Rational Software Corporation in the United States and in other countries.

Visual Basic, Windows NT, and Microsoft are trademarks or registered trademarks of the Microsoft Corporation. All other names are used for identification purposes only and are trademarks or registered trademarks of their respective companies.

U.S. PATENT NOTICE

U.S. Registered Patent Nos. 5,193,180 and 5,335,344 and 5,535,329. Licensed under Sun Microsystems Inc.’s U.S. Pat. No. 5,404,499. Other U.S. and foreign patents pending.

Printed in the U.S.A.

Part number: 800-023976-000
Содержание
81.
Перед началом


8Аудитория


8Другая документация ClearQuest


9Схема документации ClearQuest


9Контакты с Rational Software


102.
Понятия администрирования ClearQuest


10Запуск ClearQuest Designer


10Обзор архитектуры ClearQuest


11Как компоненты работают вместе


12Как эти компоненты используются


13Краткий обзор задач администратора


13Работа со схемами и базами данных ClearQuest


14Определение Вашего потока работ


14Работа с типами записей, состояниями и действиями


14Определение модели состояний


15Настройка Вашего потока работ


15Прежде, чем Вы начнете настройку


16Действия до начала работы ваших пользователей ClearQuest


183.
Управление базами данных


18Базы данных, необходимые ClearQuest


18Где сохранять базы данных ClearQuest


18Поддержание целостности базы данных


18Выбор поставщика базы данных


19Создание новой базы данных


19Резервное копирование данных


20Краткий обзор обслуживания базы данных


21Перемещение базы данных или смена поставщика


21Подготовка базы данных к перемещению


21Перемещение репозитория схем


23Перемещение пользовательской базы данных


24Перемещение базы данных к другой схеме


25Важные соображения при перемещении в новую схему


25Модификация пользовательской базы данных


26Представление свойств базы данных


26Использование ClearQuest Export Tool


29Удаление пользовательской базы данных


30Восстановление пользовательской базы данных


324.
Работа со схемами ClearQuest


32Краткий обзор работы со схемами


33Работа с тестовой базой данных


34Создание новой схемы


35Выбор языка написания сценария


35Проверка правильности изменений схемы


36“Возвращение” схемы


37Отмена "извлечения" схемы


37Обновление пользовательской базы данных


37Удаление схемы


37Выбор схемы ClearQuest


38Добавление пакетов к схеме


415.
Настройка схемы


41Планирование настройки Вашей схемы


42Работа с типами записей


43Типы записей, основанные на состояниях


43Типы записей, не имеющие состояний


43Добавление нового типа записей


44Выбор уникального ключа для типа записей, не имеющих состояний


44Выбор типа записей по умолчанию


44Добавление нового семейства типов записей


46Переименование типа записей


46Удаление типа записей


46Работа с полями


47Добавление нового поля


48Определение поведения поля


49Изменение имени поля


50Удаление поля


50Использование полей для связи записей


52Настройка полей добавлением обработчиков прерываний


53Определение Вашей модели состояний


54Использование State Transition Matrix


54Добавление нового состояния


55Отображение типов состояний


56Изменение имени состояния


56Работа с действиями и типами действий


57Добавление и модификация действий


57Добавление нового действия


57Создание перехода состояния


58Настройка действий добавлением обработчиков прерываний


59Использование действий по умолчанию


59Работа с формами записей


60Создание новой формы


60Работа со средствами управления формы


61Добавление поля к форме


62Редактирование свойств средства управления поля


62Редактирование форм


63Многократное использование форм


63Удаление форм


63Создание форм для различных платформ


646.
Администрирование пользователей


64Краткий обзор администрирования пользователей


65Права пользователей ClearQuest


65Работа с пользователями


65Добавление новых пользователей


66Обновление пользовательской базы данных


67Приписывание пользователей к базам данных


67Изменение параметров пользователя


68Создание неактивных пользователей


69Работа с группами пользователей


69Создание групп пользователей


70Добавление пользователя в группу


70Приписывание групп пользователей к базам данных


71Создание неактивных групп пользователей


72Управление доступом пользователя к действиям


72Экспорт и импорт пользователей и групп


737.
Использование обработчиков прерываний для настройки потока работ


73Краткий обзор обработчиков прерываний


74Планирование обработчиков прерываний для вашего потока работ


75Использование обработчиков прерываний полей


75Создание зависимости между полями


76Использование зависимых полей в ClearQuest Web


77Работа со списками выбора


77Создание обработчика прерываний динамического списка


78Определение поведения списка выбора


79Использование обработчиков прерываний действий


80Порядок выполнения обработчиков прерываний полей и действий


80Когда начинается действие


80Когда в поле устанавливается значение


81Когда подтверждается запись


81Когда запись передается


81Использование сценариев записей


82Использование глобальных сценариев


82Написание внешних приложений


83Использование ClearQuest API


83Работа с сеансами


83Работа с запросами


83Работа с записями


84Общие вызовы API


85Поиск текста сценария обработчика прерываний


86Примеры общих обработчиков прерываний


86Обработчик прерываний для создания списка зависимостей


87Обработчик прерываний списка выбора полей для отображения информации пользователя


88Обработчик прерываний инициализации действия для значения поля


89Обработчик прерываний действия для установки значения родительской записи


928.
Администрирование ClearQuest Web


92Обсуждение ClearQuest Web


92Настройка ClearQuest Web


92Ограничение доступа к ClearQuest Web


93Использование обработчиков прерываний в ClearQuest Web


93Предоставление зависимых полей для ClearQuest Web


94Отображение сообщений в ClearQuest Web


94Использование обработчиков прерываний для обнаружения web сеанса


959.
Администрирование ClearQuest E-mail


95Настройка автоматической электронной почты


95Установка правил электронной почты


96Конфигурирование клиентов ClearQuest для отправки электронной почты


97Представление записей электронной почтой


97Конфигурирование Rational E-mail Reader


98Форматирование электронной почты для представления


99Использование электронной почты “туда и обратно”


10010.
Импортирование данных в ClearQuest


100Подготовка к успешному импорту данных


100Создание схемы импортирования


101Создание базы данных для импортированных данных


101Тестирование процесса импорта


102Создание импортируемого файла ClearQuest


102Форматирование файлов импорта записей


103Форматирование файлов импорта хронологии


104Форматирование файлов импорта присоединений


104Выполнение импортирования данных


108Импортирование хронологии


109Импортирование присоединений


109Импортирование дубликатов записей


110Импортирование записей из файла ошибок


110Обновление существующих записей


11111.
Схемы и пакеты ClearQuest


111Предопределенные схемы ClearQuest


112Пакеты ClearQuest


117Модель состояний для типа записи Defect


117Модель состояний для типа записи Enhancement Request


118Модели типов состояний для пакетов


118Модель типов состояний пакета Resolution


119Модель типов состояний пакета UnifiedChangeManagement


12012.
Настройка ClearQuest для Единого управления изменениями (UCM)


120Добавление к схеме функциональности UCM


120Инсталляция пакетов UCM


122Установка действий по умолчанию для пакета UCM





1. Перед началом

Rational ClearQuest® - это гибкая система отслеживания дефектов и изменений, которая фиксирует и отслеживает все типы изменений для любого типа проекта. Это руководство объясняет концепции и начальные шаги, необходимые для того, чтобы начать администрировать Rational ClearQuest.

Аудитория

Это руководство предназначено для администраторов Rational ClearQuest. Оно предполагает, что Вы прочитали Введение в Rational ClearQuest, имеете опыт в управлении реляционными базами данных и знаете, как записать сценарии на VBScript или Perl.
Относительно специфических пошаговых инструкций см. интерактивную справку ClearQuest Designer. Выберите Help > Contents and Index. Учебная программа ClearQuest Designer содержит шесть уроков, которые охватывают основы администрирования ClearQuest. Чтобы запустить учебную программу, выберите Rational ClearQuest Designer Tutorial из меню Start.
Другая документация ClearQuest

В дополнение к этому руководству ClearQuest включает следующую печатную документацию:
Введение в Rational ClearQuest: Обеспечивает краткий обзор того, как использовать ClearQuest и простейший пример того, как Вы можете настраивать ClearQuest, чтобы приспособить его к потоку работ в вашей организации
· Инсталляция Rational ClearQuest: Объясняет, как установить ClearQuest, ClearQuest Designer, базы данных поставщика и связанные инструментальные средства
и следующую интерактивную документацию:

· Примечания к выпуску

· ClearQuest Help: Интерактивная справка для ClearQuest

· ClearQuest Designer Help: Интерактивная справка для ClearQuest Designer

· ClearQuest Designer Tutorial: Введение в основные возможности ClearQuest Designer

· ClearQuest API Reference Guide: Интерактивное справочное руководство, объясняющее синтаксис для записи обработчиков прерываний и внешних приложений
ClearQuest Web Help: Интерактивная справка для web-основанных клиентов ClearQuest

· ClearQuest Maintenance Tool Help: Интерактивная справка для инструментальных средств обслуживания ClearQuest

· ClearQuest Import Tool Help: Интерактивная справка для инструментальных средств импората ClearQuest

Схема документации ClearQuest
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Контакты с Rational Software

Если у Вас возникли технические проблемы, и Вы не можете найти решение в этом руководстве или в интерактивной справке, войдите в контакт с Технической поддержкой Rational Software. Выберите Reference > Contacting Technical Support в интерактивной справке ClearQuest, чтобы узнать адреса и номера телефонов центров технической поддержки.
Перед контактом с технической поддержкой, запишите последовательность событий, которые привели к проблеме и все сообщения программы, которые Вы видите. Если возможно, имейте программу запущеной на вашем компьютере, когда Вы звоните.
За технической информацией относительно ClearQuest, ответами на общие вопросы и информацией относительно других изделий Rational Software обращайтесь на сайт Rational Software по адресу http://www.Rational.com. Для непосредственного контакта с технической поддержкой используйте адрес http://www.Rational.com/support. 
2. Понятия администрирования ClearQuest
Вашими задачами как администратора ClearQuest должны быть устанавка, настройка и поддержка ClearQuest для ваших конечных пользователей. Эта глава описывает существенные концепции ClearQuest, чтобы помочь Вам понять вашу роль и эффективно использовать это руководство. Глава содержит следующие разделы:

Обзор архитектуры ClearQuest
· Краткий обзор задач администратора
· Понятия схем и баз данных ClearQuest
· Определение Вашего процесса управления запросом изменения
· Основные действия перед началом работы ваших пользователей ClearQuest
Примечание: Термин администратор, как он используется в этом руководстве, означает любого человека с правами доступа пользователя выше, чем у активного пользователя. Для определения прав доступа пользователей см. раздел Права пользователей ClearQuest на странице 65.

Запуск ClearQuest Designer

Для выполнения большинства административных функций ClearQuest Вы будете использовать ClearQuest Designer. Выберите Rational ClearQuest Designer из меню Start.
ClearQuest Designer устанавливается с именем пользователя по умолчанию (admin), которое Вы можете использовать, чтобы начать работу. Вы не должны печатать пароль. Учетная запись пользователя admin имеет высший приоритет и дает право исполнять все функции администратора ClearQuest.
Примечание: Первая вещь, которую Вы можете захотеть сделать - это добавить пароль для учетной записи admin или создать новую учетную запись пользователя, чтобы ограничить доступ к ClearQuest Designer. См. главу 6, Администрирование пользователей, раздел Изменение параметров пользователя на странице 67.
Обзор архитектуры ClearQuest

ClearQuest состоит из нескольких компонентов, которые работают вместе в клиент-серверной среде. 

Как компоненты работают вместе

Как администратор ClearQuest, Вы будете работать с каждым из следующих компонентов.
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Как эти компоненты используются
В таблице ниже показано, как используются компоненты ClearQuest.
	Компонент
	Кто использует
	Для чего использует

	Инструменты для клиента

	ClearQuest для Windows
	Все
	Представление, модификация и отслеживание запросов изменения, и анализ продвижения проекта при выполнении запросов, диаграмм и отчетов.

	ClearQuest для UNIX
	Все
	Представление, модификация и отслеживание запросов изменения, и анализ продвижения проекта при выполнении запросов.

	ClearQuest Web
	Все
	Обращение к ClearQuest из других платформ через Netscape Navigator® или Microsoft’s Internet Explorer®. 

Представление запросов изменения и выполнение запросов. На Windows Вы можете также выполнять диаграммы и отчеты.

	Инструменты для администратора

	ClearQuest Designer
	Администратор ClearQuest
	Настройка ClearQuest, управление схемами и базами данных ClearQuest, пользователями и группами пользователей.

	ClearQuest Import Tool
	Администратор ClearQuest
	Импорт данных, включая отчеты, хронологию и запросы изменения от других связанных систем.

	ClearQuest Export Tool
	Администратор ClearQuest
	Экспорт данных ClearQuest из одной пользовательской базы данных в другую пользовательскую базу данных, которая использует другую схему.

	ClearQuest Maintenance Tool
	Все
	Установка и соединение с репозиторием схем при инсталляции и при модификации к новой версии ClearQuest.

	Rational E-mail Reader
	Администратор ClearQuest
	Конфигурирование параметров настройки вашей электронной почты, чтобы позволить пользователям ClearQuest представлять и изменять записи электронной почтой.
См. главу 9, Администрирование ClearQuest E-mail.


Краткий обзор задач администратора
Ниже представлен краткий обзор задач администратора ClearQuest.
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Работа со схемами и базами данных ClearQuest

Схема ClearQuest содержит метаданные, которые определяют ваш поток работ, то есть то, как ваши пользователи работают с записями в пределах ClearQuest. Они содержат определения записей, определения форм и полей, состояния записей и действия, которые могут быть выполнены над записями, и необязательный код обработчика прерываний, который настраивает ваш поток работ.
ClearQuest включает несколько предопределенных схем, которые обеспечивают общие процессы потока работ и поддерживают интеграцию с различным изделиями Rational Software. Описания схем ClearQuest см. в приложении A, Схемы и пакеты ClearQuest. 

ClearQuest использует реляционные базы данных для хранения данных о вашем процессе и формах (метаданные) и данные (записи), введенные пользователями ClearQuest. ClearQuest требуется по крайней мере две базы данных:
· Репозиторий схем (главная база данных), где ClearQuest хранит схемы.
· Одна или более баз данных пользователя, которые содержат данные, введенные в систему пользователями ClearQuest и ClearQuest Web. Вы можете иметь столько баз данных пользователя, сколько Вам нужно.
Схема определяет атрибуты базы данных пользователя. Как администратор ClearQuest, Вы будете использовать ClearQuest Designer для настройки схемы и для применения схемы к базам данных пользователей.
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Определение Вашего потока работ

Ваша наиболее важная задача как администратора ClearQuest состоит в том, чтобы определить, как ваши пользователи будут работать с записями, а затем выбирать предопределенную схему ClearQuest, которая наилучшим образом соответствует вашему потоку работ, или настроить схему, чтобы приспособить ее к вашим потребностям.
Предопределенные схемы ClearQuest составлены из пакетов, которые придают схемам определенные функциональные возможности. Например, пакет Email, включенный в большинство схем, дает возможность ClearQuest автоматически посылать уведомления электронной почтой. Самый простой способ добавления к схеме функциональных возможностей состоит в том, чтобы добавить один или более пакетов ClearQuest. См. раздел Добавление пакетов к схемк на странице 38.
Работа с типами записей, состояниями и действиями

ClearQuest позволяет Вам отслеживать множество типов записей - таких, как дефекты и запросы расширения. Пользователи ClearQuest работают с записями,  перемещая их через различные стадии, или "состояния", обычно начиная с того, когда запись представляется системе, и, заканчивая тем, что она закрывается. Перемещение из состояния в состояние инициируется, когда пользователь выполняет действие над записью типа Open (Открытие) или Close (Закрытие).
Определение модели состояний

Каждый тип записи имеет модель состояний, которая определяет, как этот тип записи может использоваться. Ниже представлена типичная модель состояний, показывающая, как запись запроса изменения переходит из состояния в состояние в результате воздействий, выполняемых пользователями ClearQuest
[image: image5.png]ToE—

Broas o npw

e - edorene

Opur





Настройка Вашего потока работ
Вы можете совершенствовать вашу модель состояний,  добавляя правила, которые поддерживают поток работ. Для этого Вы можете использовать предопределенный код обработчика прерываний и средства управления, которые включены в ClearQuest. Вы можете также использовать интерфейс прикладного программирования ClearQuest (API), чтобы написать собственный код обработчика прерываний или написать внешние приложения, которые будут поддерживать ваш процесс. Вы можете:
· Управлять типом собираемых данных, настраивая поля и их поведение.
· Управлять доступом, определяя, кто может выполнять действия, и когда эти действия могут быть выполнены.
· Определять то, что случается, когда действие выполнено. Действия могут вызывать другие события, типа автоматической отправки уведомлений электронной почты, когда выполнено определенное действие.
Например, Вы можете ограничить права выполнять действия определенным пользователям или группам пользователей. Вы могли бы позволить каждому члену группы разрешать запрос изменения, но только инженеру по качеству – проверять правильность реализации запроса и закрывать запись. Вы можете также определять человека, ответственного за поставку данных прежде, чем запрос сможет перейти в следующее состояние.
Прежде, чем Вы начнете настройку
Прежде, чем Вы начнете настраивать ClearQuest, убедитесь, что читали следующие разделы:
· Главу 4, Работа со схемами ClearQuest. Эта глава содержит полезную информацию независимо от того, используете ли Вы предопределенную схему или создаете схему на пустом месте. Она детализирует процесс для работы со схемами, от извлечения их из репозитория схем до обновления базы данных пользователя самыми последними изменениями схемы.
· Главу 5, Настройка схемы, особенно раздел Планирование настройки Вашей схемы на странице 41.
· Приложение A, Схемы и пакеты ClearQuest, в котором содержится полный список предопределенных схем ClearQuest и пакетов схем.
Действия до начала работы ваших пользователей ClearQuest
Ниже представлен список задач, которые должны быть решены до начала работы ваших пользователей ClearQuest.

	Задача
	Сделайте следующее 
	Чтобы узнать как, см.

	Инсталляция ClearQuest и установка баз данных
	Создайте репозиторий схем и одну или несколько баз данных пользователя
	Инсталляция Rational ClearQuest

	Определение Вашего потока работ
	Спланируйте состояния и действия, создайте модель переходов состояний, определите типы записей, формы и поля, спланируйте код обработчиков прерываний
	Эту главу и главу 4, Работа со схемами ClearQuest. 

Главу 5, Настройка схемы

	Выбор предопределенной схемы, которая удовлетворяет вашему потоку работ
	
	Приложение A, Схемы и пакеты ClearQuest

	Настройка выбранной схемы или формирование новой схемы на пустом месте (не обязательно)
	Начните с добавления предопределенных пакетов для формирования  нужных Вам функциональных возможностей
	Раздел Добавление пакетов к схеме на стр. 38
Приложение A, Схемы и пакеты ClearQuest

	
	Настройте схему, как требуется
	Главу 4, Работа со схемами ClearQuest и главу 5, Настройка схемы

	
	Напишите код обработчика прерываний для дальнейшего совершенствования вашего потока работ (не обязательно)
	Главу 7, Использование обработчиков прерываний для настройки потока работ

	Модернизация вашей базы данных пользователя в соответствии с выбранной/настроенной схемой
	
	Главу 4, Работа со схемами ClearQuest

	Создание учетных записей для входа в систему ClearQuest и групп пользователей и определение прав доступа пользователей
	Добавьте пользователей ClearQuest, пропишите их в базе данных пользователя, создайте группы пользователей, установите права
	Главу 6, Администрирование пользователями

	Импорт данных из других систем баз данных (не обязательно)
	Примечание: Вы должны установить учетные записи пользователtq перед импортированием данных из других систем баз данных
	Главу 10, Импортирование данных в ClearQuest

	Настройка уведомлений электронной почты
	Настройте уведомления электронной почты для каждого пользователя ClearQuest 
	Справочную систему ClearQuest

	
	Установите правила электронной почты
	Главу 9, Администрирование ClearQuest E-mail

	Настройка ClearQuest Web 
(не обязательно)
	
	Инсталляция Rational ClearQuest

	
	
	Главу 8, Администрирование ClearQuest Web

	Настройка запросов, графиков и отчетов ClearQuest 
(не обязательно)
	Настройте запросы, графики и отчеты ClearQuest и сохраните их в папке ClearQuest Public Queries
	Справочную систему ClearQuest

	
	Альтернативный вариант: дайте разрешения делать это другим пользователям (например, руководителям проектов)
	Главу 6, Администрирование пользователей


3. Управление базами данных

ClearQuest использует реляционные базы данных для хранения данных о вашем процессе и формах (метаданные) и для хранения фактической информации, которую Вы планируете отслеживать (записи). Эта глава описывает, как обслужить базы данных ClearQuest. Разделы этой главы:

· Базы данных, необходимые ClearQuest
Выбор поставщика базы данных

· Создание новых баз данных
· Краткий обзор обслуживания базы данных
· Перемещение базы данных на новое место или замена поставщика
· Перемещение базы данных к другой схеме
· Использование инструментов экспорта ClearQuest
· Удаление баз данных пользователя
· Восстановление базы данных пользователя
Базы данных, необходимые ClearQuest
ClearQuest требует по крайней мере две базы данных:
· Репозиторий схем: Это  главная база данных, где ClearQuest сохраняет схемы.
· База данных пользователя: Это  то место, где сохраняются данные, введенные пользователем ClearQuest и Web. Вы можете иметь столько баз данных пользователя, сколько Вам нужно.
Чтобы прочитать описание того, как совместно работают базы данных и схемы ClearQuest, см. раздел Работа со схемами и базами данных QlearQuest на странице 13.
Где сохранять базы данных ClearQuest
Сохраняйте базы данных ClearQuest на машине, выделенной исключительно для этой цели. Это должна быть мощная машина с большой оперативной памятью и дисковым пространством. Точные требования зависят от числа пользователей, числа записей в базе данных и от того, связываете ли Вы множество ветвей с вашими записями. Выясните, не имеет ли ваш поставщик базы данных специфических требований.

Поддержание целостности базы данных
ClearQuest хранит данные, используя функциональные возможности реляционных баз данных. Однако методы сохранения и поиска данных в таблицах и представления информации определены в ClearQuest.
Предупреждение: Для сохранения целостности данных, используйте для управления данными ClearQuest только инструментальные средства ClearQuest. Не используйте для непосредственного управления данными ClearQuest или таблицами инструментальные средства поставщика базы данных. Если ваши данные будут разрушены, их чрезвычайно трудно будет восстановить.
Выбор поставщика базы данных

ClearQuest поддерживает следующие базы данных:
· База данных минимальной конфигурации: Microsoft Access (поставляется с ClearQuest)
База данных среднего уровня: Sybase SQL Anywhere (поставляется с ClearQuest)
· Базы данных большой производительности: Microsoft SQL Server или Oracle (для NT и UNIX)
Об особенностях поддержки определенных версий ClearQuest можно прочитать в примечаниях к выпуску \Rational\doc\clearquest_readme.htm.
Чтобы решить, какой поставщик лучше всего удовлетворит ваши потребности, Вы должны оценить, сколько пользователей Вы ожидаете иметь одновременно. Используйте следующие общие рекомендации:
· Для начального испытания и оценки или для маленьких групп (менее пяти пользователей) Вы можете использовать базу данных минимальной конфигурации.
· Для маленьких и средних групп (от пяти до двадцати пользователей) Вы можете использовать базу данных среднего уровня.
· Для больших групп (более двадцати пользователей), большого количества данных или для достижения большей эффективности используйте одну из баз данных высокой производительности.
Примечание: Вы можете использовать для баз данных ClearQuest базы данных различных поставщиков. Например, ваша промышленная база данных и репозиторий схем могут быть базами данных высокой производительности, а тестовая база данных – минимального или среднего уровня.
Создание новой базы данных
Когда Вы выбрали машину, которую будете использовать как сервер базы данных ClearQuest, и определили поставшика базы данных, которую Вы хотите использовать, Вы можете создать требуемые репозиторий схем и базы данных пользователей. Относительно специальных команд для создания новых баз данных, см. руководство Инсталляция Rational ClearQuest.
Примечание: Если Вы устанавливаете ClearQuest для использования с базой данных MS Access, Вам не нужно иметь эту базу данных уже установленной; Вы можете сделать это, когда используете ClearQuest.
Примечание: Вы должны создать ваш репозиторий схем прежде, чем Вы сможете начинать настраивать ClearQuest. Вы должны также установить тестовую базу данных пользователя для испытания новых настроек схемы. См. раздел Работа с тестовой базой данных на странице 33.
Когда базы данных установлены, Вы можете начать использовать и настраивать ClearQuest. См. главу 4, Работа со схемами ClearQuest.

Резервное копирование данных

Вы никогда не знаете, когда произойдет неисправность оборудования или возникнут проблемы с программой, которые могут вызывать потерю информации. Регулярное копирование – единственный способ гарантировать безопасность ваших данных ClearQuest.
Разработайте стратегию регулярного копирования базы данных. Копируйте ваши базы данных пользователя и репозиторий схем в одно и то же время. Это защитит и ваши данные и настройки.
Вы можете использовать любой инструмент, который Вам доступен. Большинство баз данных большой производительности поставляется с инструментом, который Вы можете использовать для регулярного резервного копирования.
Краткий обзор обслуживания базы данных

Следующая таблица перечисляет различные действия с базой данных и инструменты или интерфейсы ClearQuest, которые Вы должны использовать для их выполнения.
	Действие 
	Инструмент/ Интерфейс 
	Комментарии

	Создание нового репозитория схем или пользовательской базы данных
	Инструмент поставщика

и
	Используйте инструмент поставщика базы данных для создания пустых баз данных.

	
	ClearQuest Maintenance Tool

и
	Используйте ClearQuest Maintenance Tool для соединения и инициализации репозитория схем  и образца базы данных.

	
	ClearQuest Designer
	Используйте ClearQuest Designer для создания новых баз данных подьзователей.

Примечание: базы данных Microsoft Access и SQL Anywhere создаются изнутри ClearQuest

	Резервное копирование
	Специальный инструмент поставщика
	Выполняйте регулярное копирование для сохранения данных

	Модификация данных
	Клиент ClearQuest, интерфейс web, ClearQuest Designer, ClearQuest API
	Используйте только инструментальные средства ClearQuest для непосредственного изменения данных или таблиц ClearQuest.

Не используйте инструментальные средства поставщика базы данных для модификации данных ClearQuest.

	Использование новой версии схемы для пользовательской базы данных
	ClearQuest Designer
	См. Модификация пользовательской базы данных на стр. 25

	Изменение схемы для пользовательской базы данных
	ClearQuest Export Tool

и
	Используйте ClearQuest Export Tool для экспорта данных из пользовательской базы данных …

	
	ClearQuest Import Tool
	… затем используйте ClearQuest Import Tool для импорта данных из новой пользовательской базы данных, связанной с новой схемой.

	Перемещение базы данных или изменение поставщика базы данных
	ClearQuest Designer

или
	Для перемещения пользовательской базы данных в новое расположение или изменения поставщика базы данных используйте ClearQuest Designer.

	
	ClearQuest Maintenance Tool
	Для перемещения репозитория схем на новое месторасположение или изменения поставщика базы данных используйте ClearQuest Maintenance Tool.

См. раздел Перемещение базы данных или смена поставщика на стр. 21.

	Удаление и восстановление базы данных пользователя
	ClearQuest Designer
	ClearQuest Designer удаляет связь между репозиторием схем и базой данных, но не удаляет базу данных физически.
Для физического удаления базы данных, используйте инструментальные средства поставщика.

См. раздел “Удаление пользовательской базы данных” на стр. 29.

	Обновление для новой версии ClearQuest
	ClearQuest Maintenance Tool
	Для обновления к новой версии ClearQuest, используйте ClearQuest Maintenance Tool.


Перемещение базы данных или смена поставщика

Вы можете перемещать базу данных ClearQuest в новое расположение или изменить  поставщика базы данных. Чтобы перемещать репозиторий схем, используйте ClearQuest Maintenance Tool. Для перемещения базы данных пользователя, используйте ClearQuest Designer.
Примеры в этом разделе показывают, как перемещать базу данных из Microsoft Access в Microsoft SQL Server, но те же шаги относятся к преобразованию из любой поддерживаемой базы данных в другую.
Подготовка базы данных к перемещению
Следуйте этим процедурам, чтобы подготовить перемещение репозитория схем или базы данных пользователя в новое расположению или чтобы изменить  поставщика базы данных.
1. Создайте новую пустую базу данных, используя ваш инструмент поставщика (базы данных Microsoft Access и SQL Anywhere Вы можете создавать изнутри ClearQuest Designer).
Примечание: Для информации относительно создания новых баз данных см. руководство Инсталляция Rational ClearQuest.
2. Уведомите всех пользователей об отключении от ClearQuest.
ClearQuest предотвращает доступ новых пользователей к базам данных в ходе процесса, но он не может обнаружить или отключить пользователей, которые соединены с базой данных когда начинается процедура.
Примечание: Некоторые продвинутые базы данных снабжены инструментом для отключения потребителей от базы данных. Выясните, имеет ли база данных вашего поставщика такой инструмент.
3. Скопируйте все ваши базы данных.

Предупреждение: Всегда сохраняйте вашу базу данных перед ее перемещением или сменой поставщика базы данных. Процесс преобразования блокирует первоначальные базы данных в течение преобразования.
Перемещение репозитория схем

Эти примеры показывают, как использовать ClearQuest Maintenance Tool для перемещения репозитория схем под именем “CQMaster” в базу данных нового поставщика. Вы можете следовать этой же процедуре для перемещения в новое расположение любого репозитория схем.
Примечание: Вы должны иметь права Super User, чтобы переместить репозиторий схем. См. Права пользователей ClearQuest на странице 65.
Чтобы переместить репозиторий схем в новое расположение:
1. Выполните шаги, перечисленные в разделе Подготовка базы данных к перемещению на странице 21.

2. Выберите Rational ClearQuest Maintenance Tool в меню Start.

3. В Maintenance Tool выберите Move an existing schema repository, и нажмите Next.
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4. Введите ваше имя администратора ClearQuest и пароль, затем нажмите Next.

5. Представьте свойства нового репозитория схем, затем нажмите Next.
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6. Когда преобразование будет закончено, выйдите из ClearQuest Maintenance Tool.

7. Добейтесь, чтобы все пользователи ClearQuest запустили ClearQuest Maintenance Tool, чтобы соединиться с новым репозиторием схем. Убедитесь, что обеспечили их информацией, необходимой для соединения. Подробности относительно информации, необходимой для соединения, см. Установка ClearQuest для конечных пользователей в руководстве Инсталляция Rational ClearQuest.

Перемещение пользовательской базы данных

Эти примеры показывают, как использовать ClearQuest Designer для перемещения базы данных пользователя “SAMPL” в базу данных нового поставщика. Эту же процедуру Вы можете использовать, чтобы переместить любую базу данных пользователя в новое расположение.
Примечание: Если Вы уже переместили базу данных вне ClearQuest и должны только изменить свойства базы данных, используйте шаги, описанные в разделе Модификация пользовательской базы данных на странице 25.
1. Выполните шаги, перечисленные в разделе Подготовка базы данных к перемещению на странице 21.

2. Выберите Rational ClearQuest Designer в меню Start.

3. В ClearQuest Designer выберите Database > Database > Move User Database.
4. В диалоговом окне свойств Move User Database выберите базу данных пользователя, и нажмите Properties. (Заметьте, что, если Вы сейчас нажмете  OK, Вы только модифицируете изменения, которые Вы сделали в области комментария диалогового окна; база данных не будете перемещена.)
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5. В диалоговом окне Properties выберите базу данных нового поставщика и заполните свойства для новой базы данных, включая и то, является ли база данных промышленной или испытательной. Когда Вы закончите, нажмите Move.
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6. В диалоговом окне Moving Database сообщение в области Status информирует Вас, является ли перемещение базы данных успешным.
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Если Вы хотите сохранить это сообщение о состоянии в файле результатов, нажмите кнопку Save Status As... и определите имя и путь для файла результатов. Нажмите Save, и перейдите к шагу 7.
Если Вы не хотите сохранить это сообщение, сразу переходите к шагу 7.
7. В диалоговом окне Moving Database нажмите OK. Появляется сообщение подтверждения модификации: 
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8. В диалоговом окне Move User Databas нажмите OK.
Перемещение базы данных к другой схеме
Когда база данных пользователя связана со схемой, Вы можете модернизировать эту базу данных только более новыми версиями той же самой схемы. Вы не можете применять к базе данных совершенно иную схему.
Например, если база данных пользователя использует версию 1 схемы DefectTracking, Вы можете модернизировать эту базу данных к версии 2 схемы DefectTracking. Но Вы не можете модернизировать эту же базу данных для использования схемы Enterprise.
Чтобы переместить базу данных в новую схему, Вы должны сначала создать новую базу данных и связать ее с желаемой схемой. Затем Вы используете инструментальные средства ClearQuest, чтобы экспортировать данные из старой базы данных и импортировать их в новую.
Чтобы переместить базу данных в новую схему:
1. Прежде, чем Вы начнете, прочитайте подраздел Важные соображения при перемещении в новую схему на странице 25.
2. Создайте или измените схему, которую Вы хотите использовать.
См. главу 4, Работа со схемами ClearQuest и главу 5, Настройка схемы.
3. Создайте новую базу данных пользователя и свяжите ее с новой схемой.
Выберите Database > New Database в ClearQuest Designer, чтобы создать новую базу данных пользователя. ClearQuest Designer запрашивает Вас о связывании новой базы данных со схемой.
4. Используйте ClearQuest Export Tool, чтобы экспортировать данные из вашей текущей базы данных пользователя.
См. Использование ClearQuest Export Tool на странице 26.
5. Используйте ClearQuest Export Tool, чтобы импортировать данные в новую базу данных.
Для получения информации относительно использования Import Tool см. главу 10, Импортирование данных в ClearQuest. 
Важные соображения при перемещении в новую схему
Рассмотрите следующие проблемы и требования при перемещении базы данных в новую схему:
· После того, как Вы создадите новую схему, убедитесь, что проверили ее на тестовой базе данных перед обновлением вашей новой базы данных пользователя. Импортируйте малое подмножество данных и испытайте схему, чтобы убедиться, что она работает правильно. См. раздел Работа с тестовой базой данных на странице 33.
· Если ваша новая схема имеет динамические списки, убедитесь, что заполнили эти списки перед импортированием ваших данных. См. подраздел Работа со списками выбора на странице 76.
· Если ваши данные имеют зависимости для полей reference или reference_list, Вы должны импортировать данные в надлежащем порядке. Например, сначала Вы должны импортировать проектный тип записи,  затем основной тип записи данных, затем присоединенные, и наконец хронологию.
· Если Вы перемещаетесь в новый репозиторий схем, перед перемещением других данных Вы должны экспортировать информацию пользователей из старого репозитория схем и импортировать ее в новый. Вы можете использовать ClearQuest Designer, чтобы экспортировать информацию пользователя. См. Экспорт и импорт пользователей и групп на странице 72.
Если новая схема использует иные названия состояний, чем старая схема, Вы должны отредактировать экспортируемый файл, чтобы изменить названия состояний. Например, если старая схема использует название состояния submitted, а новая схема запрашивает состояния, которые называются  new, Вы должны отредактировать экспортируемый файл и заменить submitted на new перед импортом этих данных в новую базу данных.
· ClearQuest Export Tool экспортирует идентификатор записи в поле display_name для типов записи присоединенных и хронологии. (См. раздел Работа с типами записей на странице 42.) Не забывайте отображать поле display_name на первоначальное “старое” поле ID при импортировании данных.
Модификация пользовательской базы данных

Используйте опцию меню Update User Database Properties, чтобы изменить свойства выбранной базы данных, если Вы переместили вашу базу данных пользователя вне ClearQuest. (Если Вы не переместили вашу базу данных вне ClearQuest, используйте шаги, описанные в разделе Перемещение базы данных или смена поставщика на странице 21, чтобы изменить свойства до перемещения базы данных.)
1. Нажмите Database > Update User Database Properties.

2. Нажмите нужное название базы данных.

Чтобы изменить только поле Comments: используйте окно редактора Comment, сделайте ваши изменения и нажмите OK.
Чтобы изменить свойства базы данных: нажмите кнопку Properties, чтобы отобразить диалоговое окно Database Properties, и сделайте ваши изменения. Нажмите кнопку Update, чтобы сохранить изменения.
Представление свойств базы данных

1. В ClearQuest Designer нажмите Database > View Database Properties.
2. В диалоговом окне Database Property выделите нужное название базы данных, и нажмите кнопку Properties, чтобы отобразить свойства базы данных.
Примечание: Эти окна доступны только для чтения. Чтобы перемещать и-или редактировать свойства базы данных, см. Перемещение базы данных или смена поставщика на странице 21 или Модификация пользовательской базы данных на странице 25.
Использование ClearQuest Export Tool

ClearQuest Export Tool экспортирует данные из базы данных ClearQuest в формат ASCII, оптимизированный для ClearQuest Import Tool. Чтобы запустить Export Tool:
1. Выберите Rational ClearQuest Export Tool в меню Start.
2. В Export Tool выберите репозиторий схем, содержащий базу данных, из которой Вы хотите экспортировать данные. Значение по умолчанию – репозиторий схем, связанный с текущим номером версии ClearQuest.
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3. Войдите и выберите базу данных, которую Вы хотите экспортировать.
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4. Выберите тип записей и укажите, какие записи Вы хотите экспортировать. Вы можете экспортировать все записи или выбирать запрос ClearQuest, чтобы экспортировать определенные записи.
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Данные хронологии, присоединений и дубликаты для выбранного типа записи экспортируются автоматически.
5. Выберите поля для экспорта.
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6. Введите имена экспортируемых файлов. ClearQuest создает отдельные файлы для записей, хронологии, присоединений и дубликатов. Это – файлы, заданные ClearQuest Import Tool.
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7. Введите заключительные параметры экспорта.
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· Вы можете выбирать, включать ли все записи в один файл или ввести число записей, которые Вы хотите включить в файл.

· Выберите разделитель полей для файлов экспорта. Наиболее общий формат – это разделение запятой, но Вы можете также использовать двоеточия, точки с запятой или табуляцию.

· Введите путь и название для файла регистрации ошибок.

8. Нажмите Finish, чтобы начать экспорт. Когда экспорт закончен, ClearQuest отображает диалоговое окно и перечисляет все обнаруженные ошибки.
Удаление пользовательской базы данных

Удаление пользовательской базы данных разрывает связь между репозиторием схем и базой данных. Это действие не стирает базу данных физически и не стирает схему, связанную с этой базой данных.
Вы можете восстановить удаленную базу данных позднее,  восстанавливая связь между базой данных и репозиторием схем. См. раздел Восстановление пользовательской базы данных на странице 30.
Примечание: связь с удаленными базами данных окончательно теряется, если Вы стираете версию схемы, с которой была связана база данных, или если Вы модернизируете ее к более новым версиям ClearQuest.
Чтобы удалить базу данных из ClearQuest:
1. Выберите ClearQuest Designer в меню Start.
2. Выберите Database > Delete Database. Открывается диалоговое окно Delete Database.
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3. Выберите базу данных, которую Вы хотите удалить и нажмите Delete.
Примечание: Вы можете физически стереть базу данных пользователя после того, как Вы удалите связь; однако, если Вы сделаете это, Вы не сможете восстановить базу данных. Чтобы физически стереть базу данных Oracle или SQL Server, используйте инструментальные средства вашего поставщика для удаления базы данных пользователя после удаления связи. Для баз данных Microsoft Access и SQL Anywhere Вы можете вручную удалять файлы базы данных.
Восстановление пользовательской базы данных

Вы можете восстанавливать связь между базой данных пользователя и репозиторием схем,  восстанавливая базу данных. Вы должны восстановить связь с той же самой версией схемы, с которой база данных пользователя была связана раньше. Физически база данных должна быть в том же самом расположении, как это было, когда она была удалена.
Примечание: Восстановление базы данных должно быть сделано как можно быстрее после того, как Вы удаляете базу данных, чтобы избежать окончательной потери ее связи с репозиторием схем. Если Вы удалили версию схемы, связанную с базой данных, или если Вы модернизировали ее к новой версии ClearQuest, Вы не сможете восстановить связь. Восстановление базы данных возможно только, если физически база данных существует. Вы не сможете восстановить базу данных, если Вы использовали инструментальные средства поставщика для физического стирания базы данных.
Чтобы восстановить базу данных пользователя:
1. Выберите Rational ClearQuest Designer в меню Start.
2. Выберите Database > Undelete Database, чтобы открыть диалоговое окно Undelete Database.
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3. Выберите из списка удаленную базу данных и нажмите Undelete. 

4. Работа со схемами ClearQuest
Схема ClearQuest содержит метаданные (типы записей, действия, состояния, поля, формы и обработчики прерываний), которые определяют, как Вы работаете с записями в ClearQuest. ClearQuest включает несколько предопределенных схем, которые обеспечивают общие модели потока работ.
Эта глава представляет общий обзор того, как работать со схемами, изменяете ли Вы существующую схему или создаете схему на пустом месте. Сюда включены разделы:
· Общий обзор работы со схемами
· Выбор схемы ClearQuest 
· Добавление пакетов к схеме
Примечание: Для работы со схемами Вам необходимы права Schema Designer или Super User. Чтобы изучить, как устанавливать права пользователя, см. главу 6, Администрирование пользователями.
Дополнительная информация? Список предопределенных схем и пакетов см.  в приложении A, Схемы и пакеты ClearQuest. Информацию о том, как настраивать схему, см. в главе 5, Настройка схемы. 
Краткий обзор работы со схемами

Чтобы настроить схему или создать новую схему, необходимо использовать ClearQuest Designer и выполнить следующие основные процедуры:
1. Создать новую базу данных пользователя, которую нужно использовать как тестовую базу данных, и связать ее со схемой, которую Вы хотите настроить. См. раздел Работа с тестовой базой данных на странице 33.
2. Извлечь схему из репозитория схем (см. "Извлечение" схемы на странице 34) или создать новую схему (см. раздел Создание новой схемы на странице 34).

3. Установить тестовую базу данных для схемы,  выбирая Database > Set Test Database. См. раздел Работа с тестовой базой данных на странице 33.

4. Выбрать язык создания сценария, чтобы использовать его для кодирования обработчика прерываний. См. Выбор языка написания сценария на странице 35.
5. Настроить схему, часто проверяя ее достоверность, особенно при внесении сложных изменений. См. Проверка правильности изменений схемы на странице 35.
Примечание: Быстрый способ настройки схемы состоит в том, чтобы добавлять пакеты ClearQuest для получения необходимых  функциональных возможностей. См. Добавление пакетов к схеме на странице 38.
6. Сохранить вашу работу в процессе, выбирая File > Save Work. Вы можете сохранить вашу работу и выйти, когда Вы “извлечете” схему, а затем возобновить работу, когда Вы “возвратите” ее. Это действие не создает новую версию схемы и не воздействует на вашу пользовательскую базу данных.
7. Протестировать свою работу,  выбирая File > Test Work. Это – надежный и простой путь проверки вашей работы в ClearQuest client без воздействия на вашу пользовательскую базу данных. См. раздел Работа с тестовой базой данных на странице 33.
8. Повторять шаги 5 – 7 до тех пор, пока Вы не будете удовлетворены вашей схемой.
9. Возвратить схему в репозиторий схем, чтобы сохранить новую версию схемы. См. раздел "Возвращение" схемы на странице 36.
10. Модернизировать базу данных пользователя к новой версии схемы. Выберите Database > Upgrade Database, и выберите базу данных пользователя. См. Обновление пользовательской базы данных на странице 37.
Работа с тестовой базой данных

Вы должны устанавливать тестовую базу данных пользователя для каждой схемы, которую Вы планируете настраивать. Используя тестовую базу данных, Вы можете быстро и безопасно проверять ваши версии схемы в ClearQuest client без воздействия на промышленные пользовательские базы данных.
Чтобы работать с тестовой базой данных:
1. Создайте тестовую базу данных пользователя для схемы, которую Вы планируете настраивать. В ClearQuest Designer выберите Database > New Database.

Мастер New Database Wizard запрашивает Вас о продолжении процесса. Создайте новую базу данных, давая ей название, по которому Вы сможете узнавать тестовую базу данных, затем свяжите эту тестовую базу данных со схемой, которую Вы хотите настроить.
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Примечание: Вы можете выбрать опцию Visible to the designer only, чтобы тестовая база данных была не видима для обычных пользователей ClearQuest client. Если Вы выберите Visible to the designer only, тестовая база данных не будет видима из ClearQuest UNIX, ClearQuest Web или из ClearQuest Import Tool.

2. "Извлеките" схему, которую Вы хотите настраивать, затем выберите Database > Set Test  и выберите тестовую базу данных для связи с этой схемой.
3. В любой момент настройки схемы Вы можете выбрать File > Test Work. ClearQuest сохранит и проверит правильность ваших изменений схемы, сообщая о любых погрешностях в окне Validation в нижней части окна ClearQuest Designer. См. Проверка правильности изменений схемы на странице 35.

Затем ClearQuest модернизирует вашу тестовую базу данных в соответствии с текущей версией схемы. На Windows ClearQuest автоматически запускает ClearQuest client, так что Вы можете проверить, как выполняется схема. Чтобы проверить схему из клиентов UNIX или Web, войдите в тестовую базу данных вручную. (Помните, тестовая база данных не будет видима для клиентов UNIX или Web, если Вы выбрали опцию Visible to the designer only при создании базы данных.)
Примечание: Вы должны проверять самую последнюю версию схемы, выбирая File > Test Work. Если Вы попытаетесь возвратить схему без проверки работы, ClearQuest сначала запросит Вас о проверке вашей работы.
Дополнительная информация? Просмотрите разделы test databases, setting и schemas, testing в справочной системе ClearQuest Designer.
"Извлечение" схемы

ClearQuest хранит схемы под версионным контролем в репозитории схем. Чтобы настроить схему, Вы должны сначала "извлечь" схему из репозитория схем. Когда Вы "извлекаете" схему, ClearQuest создает ее новую версию, которую Вы можете редактировать.
После того, как Вы войдете в ClearQuest Designer, автоматически отображается диалог Open Schema:
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Примечание: Если Вы открываете схему только для просмотра, схема будет доступна только для чтения; и Вы не сможете ее настраивать.
Другой способ "извлечь" схему из ClearQuest Designer – выбрать File > Open Schema.
Создание новой схемы

Чтобы создать новую схему, Вы должны базировать новую схему на уже существующей.
В ClearQuest Designer выберите File > New Schema, и выберите ту схему, на которой будет базироваться новая схема.

[image: image22.png]New 5chema - Step 1 of 2

Seicc 3 3oheea on hih o b2 your s cchana. Solot
sohems "Glark,verson 1, for e rrina schena

e e e
R -
Botieprte sy, e T T—————
Voresoh Sy Sk B —
.
s e
e

e 1

Hia





Чтобы создать новую схему на пустом месте, выберите схему Blank, которая содержит только системные поля.
Выбор языка написания сценария
Обработчики прерываний – это триггеры для частей кода, которые ClearQuest выполняет при определенных условиях, чтобы правильно выполнить ваш поток работ. Вы можете записывать обработчики прерываний на VBScript (для Windows) или Perl (для Windows и UNIX).
После "извлечения" схемы Вы можете выбрать язык создания сценариев, который ClearQuest будет использовать для выполнения сценариев на Windows. Значение по умолчанию – это BASIC (VBScript).

[image: image23.png]Haxwre goaxas
Schema Properties ...

W BiGepHTe A3tk
HanMCaHyA cueHapuA —

(o] e o] e e





Дополнительная информация? См. главу 7, Использование обработчиков прерываний для настройки потока работ. Для получения информации непосредственно относительно языков создания сценариев, см. следующие ресурсы на Internet:
http://msdn.microsoft.com/scripting/

http://www.perl.com/

Проверка правильности изменений схемы
Вы не можете "возвратить" схему, если имеются в ней имеются ошибки. Когда Вы пытаетесь "возвратить" схему, ClearQuest автоматически проверяет правильность вашей схемы, чтобы гарантировать, что она не содержит ошибок. Если Вы производите сложные изменения схемы, полезно чаще вручную проверять ее на отсутствие ошибок,  подтверждая правильность схемы.
Чтобы проверить правильность схемы, выберите File > Validate. ClearQuest отображает результаты проверки в блоке Validation в нижней части окна ClearQuest Designer.
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Просмотрите результаты проверки и измените схему как необходимо, чтобы исправить ошибки. Если Вы не можете проверить правильность всех ваших изменений, Вы можете сохранить эти изменения схемы и редактировать их  позже. Вы можете также отменить "извлечение" схемы и вернуться к ее предыдущей версии. См. Отмена "Извлечения" схемы на странице 37.
Примечание: Проверка правильности не гарантирует, что схема будет функционировать так, как вы этого хотите. Убедитесь, что проверили схему с тестовой базой данных перед ее "возвращением" и сделайте резервное копирование вашей пользовательской базы данных перед ее обновлением. См. Работа с тестовой базой данных на странице 33.
Дополнительная информация? Просмотрите раздел schemas, validation в справочной системе ClearQuest Designer.
“Возвращение” схемы

После редактирования и тестирования схемы, Вы должны "возвратить" ее в репозиторий схем. Когда Вы "возвращаете" схему, ClearQuest сохраняет новую версию схемы в репозитории схем.
"Возвращенная" схема не воздействует базу данных пользователя автоматически; чтобы ваши изменения вступили в силу, Вы должны модифицировать пользовательские базы данных с новой версией схемы. Когда новая версия схемы будет "возвращена", Вы сможете использовать ее для модификации существующих баз данных или применять при создании новых. ClearQuest сохраняет историю каждой версии, так что Вы можете рассмотреть предшествующую версию и использовать ее для новой базы данных.
Чтобы "возвратить" схему, выберите File > Check In. ClearQuest проверяет правильность схемы, отображая все ошибки в блоке Validation внизу окна ClearQuest Designer.
Примечание: Вы не сможете "возвратить" схему, если при проверке правильности обнаружены ошибки. См. Проверка правильности изменений схемы на странице 35.
Отмена "извлечения" схемы

Вы можете вернуться к предыдущей версии схемы, даже если Вы изменили схему и сохранили ваши изменения. Отмена "извлечения" переводит схему в состояние последней "возвращенной" версии с удалением всех изменений, сделанных после "извлечения" схемы, даже если они были сделаны и сохранены за несколько сеансов.
Чтобы вернуться к последней "возвращенной" версии схемы, выберите File > Undo Check Out.
Примечание: Если Вы тестируете вашу работу,  выбирая File > Test Work, ClearQuest автоматически модернизирует вашу тестовую базу данных к новой версии схемы. Если затем Вы захотите отменить "извлечение" схемы, Вы должны удалить тестовую базу данных прежде, чем ClearQuest позволит Вам отменить "извлечение" схемы. Затем Вы должны будете создать новую тестовую базу данных.
Обновление пользовательской базы данных

Чтобы  ваши изменения были эффективны, после "возвращения" схемы Вы должны модернизировать базу данных пользователя с новой версией схемы.
Примечание: Перед обновлением выполните резервное копирование вашей пользовательской базы данных.
Чтобы модифицировать пользовательскую базу данных в ClearQuest Designer выберите Database > Upgrade Database.
Когда Вы модифицируете базу данных пользователя, учтите следующие ограничения:
· Когда пользовательская база данных связана с версией схемы, она может быть модифицирована только к более новым версиям той же схемы. Она не может использовать более раннюю версию той же схемы или другую схему.
· Перед обновлением пользовательской базы данных убедитесь, что никаких пользователей, связанных с базой данных, в момент начала модификации нет. ClearQuest не дает возможности соединиться с базой данных во время ее модификации. Но ClearQuest не отсоединяет тех пользователей, которые уже связаны с базой данных.
Подробная информация? Просмотрите разделы databases, upgrading в справочной системе ClearQuest Designer. Также см. главу 3, Управление базами данных.
Удаление схемы


Вы можете удалить одну версию схемы или все версии схемы:
· Чтобы удалить одну версию схемы из репозитория схем, выберите File > Delete Schema Version и выберите версию схемы, которую Вы хотите удалить.
· Чтобы удалить все версии схемы из репозитория схем, выберите File > Delete Schema и выберите схему, которую Вы хотите удалить.
Примечание: Вы не можете удалить схему или версию схемы, связанную с пользовательской базой данных. Сначала Вы должны удалить пользовательскую базу данных. Все удаления схемы окончательны. Вы не можете восстановить удаленную схему.
Выбор схемы ClearQuest
ClearQuest обеспечивает предопределенные схемы, которые Вы можете использовать такими, как они есть, или настраивать их в соответствии со своим потоком работ. Схемы ClearQuest составлены из предопределенных пакетов схем. Пакет – это часть функциональных возможностей схемы. Например, пакет Email дает возможность ClearQuest автоматически посылать сообщения электронной почты.
Вы можете добавлять предопределенные пакеты к создаваемой Вами схеме или использовать их для расширения возможностей предопределенных схем ClearQuest. См. раздел Добавление пакетов к схеме на странице 38.
ClearQuest включает следующие предопределенные схемы:
	Схема 
	Описание

	AnalystStudio 
	Совместима с Rational Suite AnalystStudio. Содержит настройку для использования с Rational RequisitePro.

	Blank 
	Содержит только системные поля. Используйте схему Blank, чтобы создавать схему на пустом месте.

	Common 
	Содержит метаданные, общие для всех схем ClearQuest.

	DefectTracking 
	Содержит поля, необходимые для начала использования ClearQuest для отслеживания дефектов в среде программирования.

	DevelopmentStudio 
	Совместима с Rational Suite DevelopmentStudio. Содержит поля и правила для работы с Rational’s Purify, Quantify и Pure Coverage.

	Enterprise 
	Для использования с Rational Suite Enterprise. Содержит поля и обработчики прерываний, которые работают со всеми продуктами Rational.

	TestStudio 
	Совместима с Rational Suite TestStudio. Содержит поля и правила для работы с Rational’s TeamTest, RequisitePro, Purify, Quantify и Pure Coverage.

	UnifiedChangeManagement 
	Поддерживает процесс UCM,  обеспечивая интегрирование с Rational ClearCase. См. Приложение B "Настройка ClearQuest для Единого управления изменениями (UCM)". 


Дополнительная информация? См. приложение A, Схемы и пакеты ClearQuest, содержащее полное описание схем и пакетов.
Добавление пакетов к схеме

Предопределенные пакеты схем ClearQuest содержат метаданные типа записей, полей и форм, которые определяют специфические функциональные возможности. Установка пакета в схему – это самый простой способ добавить к схеме функциональные возможности.
Пакет может содержать один или более новых типов записей и может изменять один или более типов записей, которые уже существуют в вашей схеме. Например, пакет Email добавляет к схеме тип записи Email_Rule и добавляет действие Send_Email_Notif к существующим типам записей в схеме.
Полный список пакетов и изменяемых  типов записей и полей см. в разделе Пакеты ClearQuest на странице 112.
При добавлении пакетов к схемам учтите следующее:
· Вы можете добавлять к любой схеме один или большее число пакетов.
· Схема не может уже содержать метаданные, которые добавляет пакет. Например, попытка установить пакет, содержащий тип записи Project в схему, которая уже содержит тип записи Project, приведет к неудаче.

· Если Вы модернизируете схему к новой версии ClearQuest, установите самую последнюю версию пакетов.
Примечание: Вы не можете создавать ваши собственные пакеты, чтобы использовать их с Package Wizard. Однако, Вы можете экспортировать схемы или версии схемы, а затем импортировать их в другой репозиторий схем, используя утилиту командной строки CQLOAD. Для получения дополнительной информации найдите cqload в оглавлении справочной системы ClearQuest Designer.
Для добавления пакета к схеме Вы используете Package Wizard. Вы можете начать со схемы, которая добавлена или извлечена из репозитория схем. (Package Wizard автоматически "извлекает" схему при необходимости добавить пакет.)
Следующие команды предполагают, что Вы начинаете со схемы, которая "возвращена":
1. Добавление пакета.

Выберите Package > Package Wizard и выберите пакет, который нужно установить.
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Примечание: Пакеты, которые уже являются частью вашей текущей схемы, не появляются в списке пакетов. Не перечисляются также пакеты, которые еще не установлены в репозиторий схем. Нажмите More Packages, чтобы сначала установить пакеты в репозиторий схем.
2. Допустимые типы записей.
Некоторые пакеты изменяют типы записей, уже существующие в вашей схеме. Вы можете выбрать допустимые для пакета типы записей.
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Описания пакетов, включая изменяемые типы записей, см. в разделе Пакеты ClearQuest на странице 112.
Подробная информация? Просмотрите record types, setting up for a package в оглавлении справочной системы ClearQuest Designer.
3. Некоторые пакеты запрашивают Вас об отображении типов состояний.

Тип состояия – это метка, которую используют пакеты типа Resolution и UnifiedChangeManagement, чтобы определить роль состояния в вашей модели состояний. Когда Вы добавляете пакет, который использует типы состояния, Вы получаете запрос об отображении типа состояния каждого из существующих состояний  в этом пакете. Вы можете отображать больше, чем одно состояние для типа состояния, но каждый тип состоояния требует наличия, по крайней мере, одного состояния.
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Модели типов сосотояний перечислены в разделе Модели типов состояний на странице 118. Чтобы изучить, как отображать типы состояния, см. раздел Отображение типов состояний на странице 55.
Подробная информация? Смотрите state types, setting up for a package в оглавлении справочной системы ClearQuest Designer.

4. Если Вы устанавливаете пакет UnifiedChangeManagement, Вы должны также создать действия по умолчанию. См. раздел Использование действий по умолчанию на странице 59.

5. Настройка схемы

Эта глава описывает использование ClearQuest Designer для настройки схемы. Освещенные разделы включают:
· Планирование настройки Вашей схемы
· Работа с типами записей

· Работа с полями

· Определение Вашей модели состояний

· Работа с действиями и типами действий

· Работа с формами записей

ClearQuest включает несколько предопределенных схем. Если одна из этих схем отвечает вашим деловым потребностям, Вы можете использовать ее без модификации. Полный список предопределенных схем и пакетов ClearQuest см. в приложение A Схемы и пакеты ClearQuest.
Прежде, чем Вы сможете настраивать схему, Вы должны "извлечь" схему из репозитория схем. Полные инструкции о том, как работать со схемами, см. в главе 4 Работа со схемами ClearQuest.
Чтобы настроить схему, Вам необходимы права Schema Designer или Super User. Для получения дополнительной информации см. главу 6, Администрирование пользователей.
Планирование настройки Вашей схемы
Настройка схемы – это многоступенчатый процесс, включающий следующие основные процедуры:
1. Определение ваших данных.

Для определения данных, которые Вы хотите собирать и которыми вы хотите управлять в ClearQuest, Вы работаете с типами записей и с полями:
· Решите, какие записи Вам необходимы. Вы можете иметь отдельные типы записей для аппаратных дефектов и программных дефектов, каждый из которых имел бы свой собственный набор полей. См. Работа с типами записей на странице 42.

· Перечислите поля, в которых Вы нуждаетесь в каждой форме записи. Вы можете использовать поля для связывания записей, и Вы можете настраивать ваш тип записей через типы данных полей и обработчики прерываний. См. Работа с полями на странице 46.

Примечание: Быстрый способ прибавлять типы записи и поля к схеме состоит в том, чтобы добавить к схеме один или более предопределенных пакетов ClearQuest. См. Добавление пакетов к схеме на странице 38.
2. Определение вашей модели состояний.

Каждый тип записи имеет свою собственную модель состояний. Модель состояний состоит из состояний, типов состояний, действий и поведений полей. Чтобы пределить модель состояний:
· Перечислите необходимые Вам состояния и действия, которые могут выполняться с записью в каждом состоянии. Нарисуйте диаграмму модели состояний, показывающую, как будут изменяться записи вашей системы как результат выполненных с ними действий. Например, в простой системе отслеживания дефектов запись может переходить из состояния "представлен" в "открыт", далее – в "разрешен", и затем – в состояние "проверен". См. Определение Вашей модели состояний на странице 53.

· Создайте необходимые Вам состояния и действия. Вы можете настраивать ваш поток работ, добавляя обработчики прерываний для действий. См. Работа с действиями и типами действий на странице 56 и Настройка полей добавлением обработчиков прерываний на странице 58.

· Используйте поведения полей для связывания полей с определенными состояниями записи. Вы можете определять, является ли поле обязательным, необязательным или только для чтения в каждом состоянии. См. Определение поведения поля на странице 48.

Примечание: Некоторые пакеты ClearQuest, типа пакетов Resolution и UnifiedChangeManagement, используют типы состояния, чтобы определить роль состояния в вашей модели состояний. Если Вы добавляете эти пакеты к вашей схеме или добавляете новое состояние к схеме, которая использует типы состояний, Вы должны отобразить новое состояние для типа состояния. См. Отображение типов состояний на странице 55.
3. Создание ваших форм записи.

Создайте для ваших пользователей формы для предстления новых записей и работы с записями. Решите, какие закладки в формах Вам необходимы и решите, где расположить каждое поле. Используя средства управления формами, добавьте поля, которые вы создали, к формам записи. См. Работа с формами записей на странице 59.
4. Добавление обработчиков прерываний, если это нужно.

· Установите отношения между полями, определяя, воздействует ли значение в одном поле на значения в других полях. Понимание этих отношений поможет Вам решить, как использовать обработчики прерываний. См. Настройка полей добавлением обработчиков прерываний на странице 52.

· Спланируйте дополнительные средства управления или возможности расширения при использовании вашей формы записи. Например, решите, кто должен быть уведомлен, когда запись представлена или изменена, и кто может выполнять некоторые действия. См. Настройка действий добавлением обработчиков прерываний на странице 58.

Дополнительная информация? См. главу 7, Использование обработчиков прерываний для настройки потоков работ.
Работа с типами записей
Тип записи – это категория запроса изменения, необходимая для управления ClearQuest. Тип записи содержит все, что Вы должны определить для данных, которые Вы хотите собирать и отслеживать: возможные состояния  записи, ее поля, формы и обработчики прерываний.
Вы можете иметь один или более типов записей в схеме. Например, Вы можете создать простую схему, которая имеет один тип записи Defect, или Вы можете создать схему, которая имеет несколько типов записи, таких как Hardware Defects, Software Defects и Enhancements.
ClearQuest поддерживает типы записей, основанные на состояниях, и типы записей, не имеющие состояний.
Примечание: Пакеты ClearQuest могут добавлять и изменять типы записи. Для получения дополнительной информации, см. Пакеты ClearQuest на странице 112.
Типы записей, основанные на состояниях
Типы записи, основанные на состояниях, используют состояния, типа Submitted, Assigned и Resolved, чтобы отследить их состояние при работе с ними пользователей. Запись этого типа всегда имеет состояние. Запись переходит из состояния в состояние в течение выполняемых с ними действий.
Примечание: Вы можете группировать два или более типов записей, основанных на состоянии, как семейство типов записей, чтобы позволить пользователям ClearQuest делать запрос к нескольким типам записи. См. Добавление нового семейства типов записей на странице 44.
Типы записей, не имеющие состояний
Типы записей,  не имеющих состояний, обычно используются для ссылки, типа списка пользователей, проектов или другая информация. Записи этого типа не изменяются в зависимости от состояния; единственные действия, которые Вы можете выполнять на записи, не имеющей состояний – Submit (представление), Modify (изменение), Delete (удаление) и Import (импортирование) .

ClearQuest поддерживает четыре системных типа записей, не имеющих состояния: History (Хронология), Attachments (Присоединения), Groups (Группы) и Users (Пользователи). Вы не можете удалять системные типы записей.
Добавление нового типа записей

Вы можете добавлять к схеме новые типы записей. Вы должны создать каждый тип записей как  основанный на состояниях или как не имеющий состояний; как только Вы создадите тип записей, Вы не сможете изменить его, будет ли он  основанным на состояниях или не имеющим состояний.

Чтобы добавить новый тип записи:

1. В ClearQuest Designer выберите Edit > Add Record Type/Family.

2. В диалоговом окне Add Record Type выберите класс для типа записей, и дайте типу записей название.
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3. Если Вы добавляете тип записей, не имеющих сотояний, Вы должны выбрать одно или более его полей, чтобы использовать их в качестве уникального ключа. См. Выбор уникального ключа для типа записей, не имеющих состояний на странице 44.

Примечание: Вы можете использовать предопределенные пакеты ClearQuest, чтобы добавлять типы записей к схеме; пакеты могут добавлять типы записей и расширять существующие типы записей,  добавляя поля, обработчики прерываний, формы и состояния. См. Добавление пакетов к схеме на странице 38.

Выбор уникального ключа для типа записей, не имеющих состояний
Когда Вы добавляете к схеме новый тип записей, не имеющих состояний, Вы должны выбрать одно или более ее полей, которые будут служить уникальным ключом. ClearQuest использует уникальный ключ, чтобы ориентироваться среди записей данного типа, не имеющих состояний.
Чтобы выбрать уникальный ключ для типа записей, не имеющих состояний:
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Подробная информация? Ищите unique keys в оглавлении справочной системы ClearQuest Designer.
Выбор типа записей по умолчанию

Каждая схема должна иметь заданный по умолчанию тип записей. Заданные по умолчанию типы записей могут быть основанными на состояниях или не имеющими состояний. ClearQuest использует заданный по умолчанию тип записей, чтобы создать кнопку действия в клиенте ClearQuest, которая может использоваться для представления записей этого типа. ClearQuest также использует заданный по умолчанию тип записей в случаях, когда никакой другой тип записей не определен явно.
Чтобы сделать тип записей значением по умолчанию, щелкните правой кнопкой мыши на типе записей в рабочей области, и выберите Default record type из контекстного меню.
Добавление нового семейства типов записей
Вы можете создать семейство типов записей для группы из двух или более  основанных на состояниях типов записей. Это позволяет пользователям ClearQuest делать запрос среди нескольких типов записей.
При создании семейства типов записей учтите следующее:
· Типы записей, включенные в семейство, должны содержать одно или более общих полей, то есть поля, которые одинаковы в каждом типе записей. Эти общие поля – единственные поля, которые могут использоваться для запроса семейства типов записей.
Общие поля должны иметь одинаковое название и иметь один и тот же тип данных. Например, если Вы группируете тип записи Defect и тип записи Enhancement, Вы можете использовать поле Description в каждом типе записи как общее поле, если эти поля имеют один и тот же тип данных (возможно, короткая строка) в обоих типах записей.
Чтобы узнать, как добавлять поля к типу записей и определять их тип данных, см. Работа с полями на странице 46.
· Так как типы записей и семейства типов записей появляются в одном и том же окне, когда пользователи ClearQuest выбирают Query > New Query, используйте соглашение об именах, которое поможет пользователям отличать различные типы записей от семейств типов записей.
Чтобы добавить новое семейство типов записей к схеме:
1. В ClearQuest Designer выберите Edit > Add Record Type/Family 

2. В диалоговом окне Add Record Type:
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3. Выберите Edit > Record Type Family Members и добавьте к семейству нужные типы записей.
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4. Добавьте общие поля к типам записей элементов, чтобы позволить пользователям ClearQuest делать запрос нового семейства. См. Работа с полями на странице 46.
Подробная информация? Просмотрите record type families, adding в содержании интерактивной справки ClearQuest Designer.
Переименование типа записей

Чтобы переименовать тип записей или семейство, выберите Edit > Rename Record Type/Family и напечатайе новое название.
Примечание: Когда Вы изменяете название типа записей, Вы должны также изменить его название в любых обработчиках прерываний, ссылающихся на этот тип записей. Если Вы не отредактируете обработчики прерываний, ваши сценарии не будут правильно работать.
Подробная информация? Выберите Defining record types > Renaming record types в интерактивной справке ClearQuest Designer.
Удаление типа записей

Чтобы удалить тип записей, выберите Edit > Delete Record Type/Family и выберите тип записей или семейство, которые нужно удалить.
Следующие ограничения относятся к удалению типов записей:
· Вы не можете удалять системные типы записей.
· Вы не можете удалять заданный по умолчанию тип записей. Вы должны сначала назначить другой тип записей по умолчанию.
· Если Вы явно упомянули название типа записей в обработчике прерываний, Вы должны изменить код сценария, чтобы удалить любые ссылки на это название.
· Типы записей, добавленные с пакетами только для чтения, не могут быть удалены.
Работа с полями
Вы используете поля, чтобы управлять типом данных, которые пользователи могут добавлять к пользовательской базе данных. С полями Вы можете делать следующее:
· Определять поведение поля
· Добавлять к полю текст Help 
· Связывать родственные записи
· Настраивать поля,  добавляя обработчики прерываний
Каждый тип записей имеет таблицу  Fields, которая показывает поля, связанные с этим типом записей. Чтобы отобразить таблицу  Fields, разверните тип записей в рабочей области, и дважды щелкните Fields. Каждое поле отображается в строке, а его свойства отображаются в столбцах.
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Вы можете использовать таблицу  Fields, чтобы добавлять новые поля к типу записей и изменять свойства существующих полей.
Каждый тип записей ClearQuest включает системные поля. Эти поля требуются для каждой записи этого типа. Системные поля в таблице Fields недоступны.
Добавление нового поля

Чтобы добавить новое поле, откройте таблицу Fields и выберите Edit > Add Field.
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DB Column Name – это название, которое ClearQuest использует для столбца таблицы. По умолчанию оно такое же, как имя поля.
Примечание: Чтобы сделать новое поле доступным пользователям, Вы должны добавить поле к форме записи. См. Добавление поля к форме на странице 61.
Добавление к полю справочного текста

Используйте закладку Help Text, чтобы добавить к полю текст, который его описывает или инструктирует ваших пользователей клиентов ClearQuest, как использовать поле. Предел текста Help - 254 символа, приблизительно две трети пространства, доступного на закладке Help Text.
Пользователи ClearQuest могут щелкнуть правой кнопкой мыши в поле на форме записи и выбрать Help из контекстного меню, чтобы просмотреть текст Help.
Выбор типа данных для поля

Когда Вы добавляете поле, Вы должны выбрать его тип данных. Тип данных определяет тип данных, которые могут быть введены в поле.
ClearQuest поддерживает следующие типы данных поля:
	Данные
	Описание/Комментарии

	ATTACHMENT_LIST 
	Позволяет записям сохранять связанные с ними файлы.

	DATE_TIME 
	Дата и время SQL.

	INT 
	Целое число SQL.

	MULTILINE_STRING 
	Строка переменной длины неограниченного размера.

	REFERENCE 
	Ссылка на уникальный ключ в типе записей. 

Для полей типа REFERENCE Вы должны выбрать тип записей, основанный на состояниях или не имеющий состояний, чтобы обеспечить возможность ссылки. Вы можете также ввести необязательное поле с  обратной ссылкой, чтобы создать ссылку от вызываемой записи назад к записи этого поля.

	REFERENCE_LIST 
	Множественные ссылки на уникальные ключи в типах записей. Поля списка ссылок позволяют Вам осуществлять множество ссылок в пределах поля. Вы можете использовать поля списка ссылок вместе с управлением предок/потомок, чтобы связать родственные записи. 

Для полей типа REFERENCE Вы должны выбрать тип записей, основанный на состояниях или не имеющий состояний, чтобы обеспечить возможность ссылки. Вы можете также ввести необязательное поле с  обратной ссылкой, чтобы создать ссылку от вызываемой записи назад к записи этого поля.

	SHORT_STRING 
	Строка символов переменной длины с максимумом 254символа. Вы устанавливаете длину в диалоговом окне Properties при определении поля. Введите значение между 1 и 254 в поле Maximum Length.


Примечание: Вы не можете изменять тип данных поля после того, как "возвратите" схему. Чтобы изменить тип данных, удалите существующее поле и создайте новое поле с типом данных, который Вам нужно.
Определение поведения поля

Каждое поле имеет одно или более связанных с ним поведений. Поля в основанном на состояниях типе записей могут иметь различное поведение для каждого состояния. Например, поле может быть необязательным в состоянии Opened и обязательным в состоянии Resolved. Поля в не имеющем состояний типе записей нуждаются только в одном поведении для каждого поля.
ClearQuest поддерживает следующие поведения поля:
	Поведение 
	Описание

	Mandatory 
(Обязательное)
	Пользователю необходимо ввести значение в это поле перед применением изменений к записи. Иначе во время выполнения произойдет ошибка проверки правильности. В форме записи обязательные поля показаны красным. 

	Optional 
(Не обязательное)
	Пользователь может вводить данные в это поле, но это не обязательно. 

Примечание: Optional – это настройка по умолчанию для новых полей.

	Read only 
(Только для чтения)
	Пользователь может просматривать содержание поля, но не может изменять его. 
Примечание: Обработчики прерываний могут изменять поля Read only.

	Use_hook 
	Используйте разрешение обработчика прерываний поля для определения уровня доступа пользователя.


Чтобы определить поведение для поля, используйте таблицу Behaviors. В рабочей области разверните Record Types > Defect > States and Actions и дважды щелкните Behaviors.
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Вы можете использовать столбец Default Behavior, чтобы установить заданное по умолчанию поведение для поля. Заданное по умолчанию поведение относится к полю в любом состоянии и автоматически применяется к полю, когда Вы добавляете новое состояние.
Примечание: Вы можете также устанавливать поведение поля,  используя обработчик прерываний. Обработчики прерываний действуют, используя права Super User, и поэтому могут изменять любое поле, даже если поведение поля – Read Only.
Подробная информация? Просмотрите fields: behaviors в оглавлении справочной системы ClearQuest Designer.
Изменение имени поля

Вы можете изменять имя поля. Однако, если Вы явно ссылаетесь на поле в сценарии по его имени, убедитесь, что модифицировали ваш сценарий, чтобы использовать новое имя..

Чтобы изменить имя поля, откройте таблицу Fields, щелкните правой кнопкой мыши на поле, и выберите Field Properties. Напечатайте новое имя для поля.

Удаление поля

Чтобы удалить поле, используйте таблицу Fields. Выберите строку, которая содержит поле, которое Вы хотите удалить и выберите Edit > Delete Field.

С удалением полейсвязаны следующие ограничения:

· Чтобы удалить поле, Вы должны также удалить поле из формы записи. См. Редактирование форм на странице 62.

· Вы не можете удалить, переименовать или изменить системное поле. Системные поля в таблице Fields выглядят серыми.

Когда Вы удаляете поле, ClearQuest сохраняет DB Column Name, которое сгенерировано для поля (по умолчанию такое же, как имя поля). Если Вы позже многократно используете одно и то же имя для создания нового поле, ClearQuest генерирует уникальное имя DB Column Name.

· Если Вы явно ссылаетесь на имя поля в коде сценария, Вы должны удалить любые ссылки на поле из вашего сценария.

· Любые запросы в клиенте ClearQuest, которые используют это поле, станут недопустимыми.
Использование полей для связи записей

Вы можете использовать поля, чтобы связывать записи одного и того же типа или записей различных типов. Вы можете связать записи чтобы:

· Совместно использовать общие данные
· Создавать иерархию предок/потомок
Связывание записей для совместного использования общих данных
Вы можете использовать поля типа REFERENCE или REFERENCE_LIST, чтобы связывать записи для совместного использования общих данных. Используйте поле REFERENCE, чтобы связать одну запись; используйте поле REFERENCE_LIST, чтобы связать много записей.

Например, Вы могли бы иметь данные одного заказчика, которые должны быть введены для множества записей.
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Чтобы связать записи для совместно использования общих данных:

1. Откройте таблицу Fields для типа записи и создайте новое поле, выбирая REFERENCE или REFERENCE_LIST как его тип.

2. Выберите Edit > Field Properties и выберите тип записи для ссылки на нее.
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3. Чтобы сделать поле доступным пользователям, Вы должны прибавить его к форме записи. Используйте управление предок/потомок с типом поля REFERENCE_LIST. См. Добавление поля к форме на странице 61.

Связывание записей для создания иерархии предок/потомок

Вы можете использовать тип полей REFERENCE или REFERENCE_LIST, чтобы связать записи одного и  того же типа для создания иерархии предок/потомок. Например, Вы можете связывать исходную запись, которая запрашивает добавление новой возможности к одной или более дочерних записей, описывающих связанные задачи, типа документирования новой возможности или добавления новой закладки в интерфейсе.
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Чтобы связать записи для создания иерархии предок/потомок:

1. Добавьте поле типа REFERENCE_LIST или REFERENCE к исходной записи.

2. Выберите поле и выберите Edit > Field Properties.

3. Введите имя для поля Back Reference. Поле Back Reference – это поле только для чтения, которое делает пересечение отношений предок/потомок проще,  позволяя Вам рассмотреть связь с точки зрения дочерней записи. Это поле автоматически добавляется к списку полей дочерней записи.
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4. Добавьте новые поля к формам записи. Используйте управление предок/потомок с типом поля REFERENCE_LIST. См. “Добавление поля к форме” на странице 61.

Подробная информация? Просмотрите records, linking related в оглавлении справочной системы ClearQuest Designer. См. также Обработчик прерываний действия для установки значения родительской записи на странице 89 этого руководства.

Настройка полей добавлением обработчиков прерываний

Обработчики прерываний позволяют Вам настраивать работу полей. Например, Вы можете настроить схему так, чтобы всякий раз, когда кто-то представляет новую запись, назначались значения полей по умолчанию.

ClearQuest обеспечивает несколько обработчиков прерываний для полей: Default Value (значение по умолчанию), Permission (разрешение), Value Changed (изменение значения), Validation (проверка правильности) и Choice List (список выбора). 

Чтобы определить обработчик прерываний для поля, используйте таблицу Fields.


[image: image39.png]Roaxast uenure,
Urafil oTipTe
ey Fiekds  —

Haxare confiew,
otpagoT-ma
pepsiear
anpegerTe bpaBoT K
pepsieaKA A non





Для создания зависимых полей используйте обработчик прерываний Value Changed (см. Создание зависимостей между полями на странице 75). Чтобы выяснить, как создать список выбора для поля, см. Работа со списками выбора на странице 76.
Вы можете настраивать обработчики прерываний ClearQuest,  оформляя сценарии, которые используют ClearQuest API. Когда Вы закончите редактировать подготовленный обработчик прерываний, выберите Hooks > Compile, чтобы проверить синтаксис вашего кода.
Подробная информация? Для полного описания обработчиков прерываний для поля и информация относительно того, как они работают с обработчиками прерываний для  действия, см. главу 7, Использование обработчиков прерываний для настройки потока работ.  Также см. Выбор языка написания сценария на странице 35. Просмотрите field hooks в оглавлении справочной системы ClearQuest Designer.
Определение Вашей модели состояний

ClearQuest использует состояния типа Submitted (Представлена), Opened (Открыта) и Closed (Закрыта), чтобы определить состояние записи во время ее движения в вашей системе. Чтобы работать с записью, пользователи выполняют действия типа Submit (Представление), Modify (Изменение) и Close (Закрытие).
Модель состояний – это диаграмма, которая показывает, как пользователи ClearQuest могут работать со специфическим типом записи. Она показывает все состояния, возможые для записи этого типа, и действия, которые могут быть выполнены над записью в каждом состоянии.
Например, модель состояний ниже показывает, как тип записи EnhancementRequest (включенный в несколько предопределенных схем) переходит от одного состояния к другому как результат выполненных над ней действий.
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Начните разработку модели состояний с перечисления состояний, которые Вы хотите иметь, и их описания. Например, следующая таблица описывает состояния для типа записи EnhancementRequest.
	Состояние 
	Описание

	Submitted 
	Первичное состояние новой записи

	Opened 
	Над записью работают

	Closed
	Зафиксированная запись проверена

	Duplicate 
	Запись продублирована другой записью


Использование State Transition Matrix

Перемещение записи из одного состояния в другое называется переходом состояния. Переход состояния состоит из исходного состояния, конечного состояния и действия, которое переводит запись из исходного состояния в конечное состояние. Текущее состояние записи - исходное состояние; состояние, в которое она переходит – конечное состояние.
Каждый  основанный на состоянии тип записи имеет State Transition Matrix (матрица переходов состояний), которая перечисляет все состояния, доступные типу записи и действия, которые перемещают запись от одного состояния к другому. Вы можете использовать State Transition Matrix, чтобы создавать, изменять и удалять состояния.
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В матрице State Transition исходные состояния перечислены в столбцах (From), а конечные состояния перечислены в строках (To). Действие, необходимое для перевода из конкретного исходного состояния в конечное состояние указано в ячейке пересечения. Если в ячейке не указанного никакого действия,  переход состояния не допускается.
Примечание: Вы не можете иметь два различных действия между теми же самыми исходным состоянием и конечным состоянием.
Добавление нового состояния

Чтобы добавить новое состояние, откройте State Transition Matrix. Выберите Edit > Add State и напечатайте название для нового состояния. ClearQuest автоматически добавляет новое состояние в строках и в столбцах State Transition Matrix.
Как только Вы создадите новое состояние, Вы должны также создать переходы состояний, которые определяют место этого состояния в модели состояний. См. Создание перехода состояния на странице 57.
Примечание: Если Вы определили состояние в вашей схеме, Вы должны использовать это состояние. Определение состояния, которое не может быть достигнуто каким либо действием – это ошибка проверки правильности.
Если ваша схема содержит пакеты, которые используют типы состояний, то когда Вы прибавляете новое состояние, Вы должны отобразить новое состояние к типу состояний вашей схемы. См. Отображение типов состояний ниже.
Подробная информация? Просмотрите states, adding to record type в оглавлении справочной системы ClearQuest Designer.
Отображение типов состояний

Некоторые пакеты схем, типа пакета UnifiedChangeManagement (UCM) и пакета Resolution, модифицируют схемы, добавляя обработчики прерываний. Эти пакеты используют типы состояний для идентификации состояний, в которых должны выполняться обработчики прерываний.
Чтобы гарантировать, что пакет с типами состояний работает с вашей схемой должным образом, Вы должны отобразить каждое состояние в каждом типе записи на соответствующий тип состояний пакета. Вы можете отображать больше, чем одно состояние на тип состояний, но на каждый тип состояний, по крайней мере, одно состояние.
Если Вы добавляете новое состояние к схеме, которая использует типы состояний, Вы должны отобразить это состояние на соответствующий типу состояний пакета.
Чтобы отобразить тип состояния:
1. Откройте State Transition Matrix для желаемого типа записи.
2. Щелкните правой кнопкой мыши на состоянии и выберите Properties, чтобы отобразить диалог свойств для состояния.
3. На закладке State Types выберите пакет, который требует отображения типа состояния, затем выберите тип состояния.
Например, чтобы отобразить состояние Closed в существующей схеме на тип состояний Complete пакета UnifiedChangeManagement:
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4. Закройте диалог, чтобы сохранить отображение состояния.
5. Повторите этот процесс для каждого нового состояния в типе записи.
Примечание: Если Вы используете схему или пакет UCM, Вы должны также назначать для ваших состояний действия по умолчанию; см. Установка действий по умолчанию для пакета UCM на странице 122.
Изменение имени состояния

Вы можете изменять имя состояния в любое время. Когда Вы изменяете имя состояния, ClearQuest автоматически модифицирует информацию с  именем состояния на любых действиях, которые относятся к этому состоянию.
Чтобы переименовать состояние, откройте State Transition Matrix. Выберите строку состояния, которое Вы хотите переименовать, и выбратьерите Edit > Rename State, чтобы открыть диалог Rename State.
Примечание: Если обработчик прерываний обращается к имени состояния явно, Вы должны вручную изменить имя состояния в коде обработчика прерываний.
Работа с действиями и типами действий

После определения состояний, Вы готовы определить необходимые действия для представления новых записей в базу данных, для изменения или удаления записи и для перемещения записи в зависимости от состояния.
ClearQuest поддерживает следующие типы действий:
	Тип действия 
	Описание/Комментарии

	Base 
	Действие Base – это вспомогательное действие, которое выполняется как побочный эффект каждого другого действия. Действие Base позволяют Вам записать действие обработчика прерываний только однажды, но использовать его с многократными действиями. Каждый раз при начале действия, действие Base выясняет, выполнены ли критерии обработчика прерываний; если это так, действие Base завершает свой процесс. Например, Вы можете добавить обработчик прерываний действия для действия Base, чтобы действие Base автоматически посылало уведомление электронной почты, когда происходит действие Close (Change_state тип действия, который перемещает запись в состояние Closed). Действие Base не появляется в списке действий в ClearQuest client.

	Change_state 
	Действия Change_state доступны только для  основанных на состоянии типов записи. Действие Change_state перемещает запись из исходного состояния в конечное состояние. Действие Change_state может относиться ко многим исходным состояниям, но только к одному конечному состоянию. Действия Change_state появляются в списке действий в ClearQuest client только, если текущая запись – это одно из исходных состояний.

	Delete 
	Позволяет пользователям удалять запись из базы данных. Действия Delete появляются в списке действий в  ClearQuest client.

	Duplicate
	Действия Duplicate доступны только для основанных на состоянии типов записи. Действие Duplicate связывает запись с другой записью, которая содержит подобную информацию. Действия Duplicate появляются в списке воздействий в ClearQuest client только, если текущая запись - одно из исходных состояний.

	Import 
	Позволяет ClearQuest импортировать записи из другого источника. Во время импортирования ClearQuest проверяет правильность содержания импортированных записй. Однако, во время импортирования ClearQuest не выполняет проверку правильности на  уровне поля. Кроме того, когда набор основанных на состояниях записей импортирован, ClearQuest назначает их к состоянию, указанному в файлах данных без проверки возможности их перехода к этому состоянию. Действия Import не появляются в списке действий в ClearQuest client.

	Modify 
	Позволяет пользователям изменять значения полей в записи без перемещения записи между состояниями. Действия Modify появляются в списке действий в ClearQuest client.

	Record_script_alias 
	Позволяет Вам связывать действие со сценарием записи. Действия Record_script_alias появляются в списке действий в ClearQuest client.

	Submit 
	Вводит новую запись в пользовательскую базу данных ClearQuest. Для основанных на состояниях записей   Submit назначает конечное состояние, но не требует исходного. Каждый тип записи может иметь только одно действие, тип которого - Submit.

	Unduplicate 
	Удаляет связь между дублированными записями. Действия Unduplicate доступны только для основанных на состояниях типов записей.


Добавление и модификация действий

Каждый тип записей имеет таблицу Actions, которая определяет действия, доступные для записей этого типа. Вы можете использовать таблицу Actions, чтобы добавлять, изменять и удалять действия, и создавать переходы состояний.
Для отображения таблицы Actions в рабочей области откройте Record Types > Defect > States and Actions и дважды щелкните Actions.
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Добавление нового действия

Чтобы добавлить новое действие, откройте таблицу Actions и выберите Edit > Add Action.
Вы должны выбрать тип действия. Если Вы планируете использовать это действие, чтобы инициализировать переход состояний, выберите CHANGE_STATE как тип.
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Создание перехода состояния

Чтобы создать переход состояний, Вы определяете действие типа CHANGE_STATE и затем выбираете исходное состояние(я) и конечное состояние для этого действия:
1. Откройте таблицу Actions и создайте новое действие, выбирая CHANGE_STATE как его тип.
Или щелкните правой кнопкой мыши существующее действие типа CHANGE_STATE, и выберите Action Properties.
2. На закладке State диалога Action Properties выберите одно или более исходных состояний и конечное состояние для действия.
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Каждое действие CHANGE_STATE должно иметь, по крайней мере, одно исходное состояние и конечное состояние. Если ни одного состояния не определено, после проверки правильности ClearQuest сообщает об ошибке.
3. После создания перехода состояний, откройте State Transition Matrix, чтобы убедиться, что ClearQuest применил переходы к состояниям. См. Использование State Transition Matrix на странице 54.
Настройка действий добавлением обработчиков прерываний
Вы можете добавлять обработчики прерываний для действия, которые осуществляют задачи в ключевых точках жизненного цикла записи. Например, по умолчанию ClearQuest предоставляет всем пользователям доступ к каждому действию. Вы можете ограничивать доступ к действию,  используя обработчик прерываний контроля доступа.
ClearQuest обеспечивает несколько обработчиков прерываний для действия: Access Control (Управление доступом), Initialization (Инициализация), Validation (Проверка правильности), Commit (Фиксирование) и Notification (Уведомление).
Чтобы определить обработчик прерываний для действия, используйте таблицу Actions.
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Вы можете настраивать обработчики прерываний действия ClearQuest включением сценариев, которые используют ClearQuest API. Когда Вы закончите редактировать подготовленный обработчик прерываний, выберите Hooks > Compile, чтобы проверить синтаксис вашего кода.
Подробная информация? Описания обработчиков прерываний для действий и информация о том, как они работают с обработчиками прерываний полей, содержатся в главе 7, Использование обработчиков прерываний для настройки потока работ. Чобы изучить, как создать обработчик прерываний для действия управления доступом, см. Управление доступом пользователя к действиям на странице 72. Также см. Выбор языка написания сценария на странице 35.
Использование действий по умолчанию

Вы можете определять для состояний действия по умолчанию. Действие по умолчанию для состояния появляется  полужирным в меню Actions ClearQuest client. Связывание состояния с действиями по умолчанию:
· помогает пользователям ориентироваться в вашей модели состояний

· требуется для некоторых схем и пакетов, типа схемы и пакета UCM
Примечание: Если Вы используете схему или пакет UCM, действия по умолчанию ваших состояний должны обеспечить допустимый путь через модель типов состояний. Для получения дополнительной информации, см. Установка действий по умолчанию для пакета UCM на странице 122.
Чтобы выбрать для состояния действие по умолчанию:
1. Откройте State Transition Matrix для типа записей.
2. Щелкните правой кнопкой мыши на состоянии, которое Вы хотите редактировать, и выберите Properties, чтобы открыть диалог Properties для этого состояния.
3. На закладке Default Action диалога Properties выберите для состояния действие по умолчанию.
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Подробная информация? Просмотрите actions, default в оглавлении справочной системы ClearQuest Designer.
Работа с формами записей

Каждый тип записи может иметь две формы, связанные с ним: форма записи и форма представления. Тип записи обязательно должен иметь форму записи, но форма представления не обязательна.
Форма представления позволяет пользователям использовать различные формы, чтобы представлять записи этого типа. Когда пользователь первоначально представляет  новую запись, ClearQuest отображает форму представления. Позже, когда пользователь просматривает и работает с записью, ClearQuest используют форму записи. Если тип записи не имеет формы представления, ClearQuest использует форму записи и для представления записей и для работы с ними.
Подробная информация? Выберите Working with record forms > Form Control Reference в справке ClearQuest Designer.
Создание новой формы

Чтобы создать новую форму:
1. В рабочей области разверните тип записей, который Вы хотите изменить.
2. Щелкните правой кнопкой мыши в поле Forms и выберите Add из контекстного меню. ClearQuest отображает новую пустую форму и высвечивает имя формы в рабочей области, чтобы Вы могли изменить его.
3. В рабочей области напечатайте имя для новой формы.
4. Щелкните правой кнопкой мыши  на имени формы и выберите Submit Form или Record Form.
После создания формы, Вы используете средства управления для добавления полей к форме. Если запись, которая имеет форму, содержит слишком много полей, чтобы отобразить их на одной закладке диалога, Вы можете добавлять дополнительные закладки диалога по мере необходимости. Каждая форма должна иметь, по крайней мере, одну закладку диалога.
ClearQuest автоматически добавляет к каждой форме три средства управления: кнопку Apply, кнопку Revert и кнопку Actions. Вы не можете удалять эти кнопки. ClearQuest использует их для инициализации и управления действиями.
Работа со средствами управления формы
Для отображения полей на форме Вы используете средства управления. ClearQuest предоставляет средства управления для текстовых блоков, блоков списков, блоков переключателей, групп переключателей и так далее. Например, Вы можете связать поле, содержащее строку с управлением-текстовым блоком. Не все средства управления работают со всеми типами полей. Например, управление представления списка или управление предок/потомок должны использоваться с полем списка ссылок.
В дополнение к отображению содержания полей, Вы можете использовать некоторые средства управления для выполнения специальных задач. Управления типа кнопок команд и списков могут быть связаны со сценариями записей. Например, в схеме TestStudio кнопка команды связана со сценарием записи Build_Properties, который позволяет пользователям рассматривать свойства компоновки, которую они выбрали.
ClearQuest поддерживает следующие средства управления для формы:
	Средство управления формы 
	Описание

	ActiveX 
	Включает в форму любое буферизованное управление ActiveX.

	Attachment 
	Отображает список присоединенных файлов и включает набор средств управления, которые позволяют пользователям добавлять, удалять или рассматривать присоединенные файлы.

	Check Box 
	Двузначное управление, которое Вы можете использовать для значений Boolean или любого поля, которое имеет только два значения. Чтобы определить два значения, щелкните правой кнопкой мыши управление на форме и выберите Properites..

	Combo Box 
	Объединяет доступное для редактирования текстовое поле со списком

	Drop-down Combo Box 
	Объединяет доступное для редактирования текстовое поле с раскрывающимся списком.

	Drop-down List Box 
	Отображает список возможных значений для конкретного поля.

	Duplicate Box 
	Отображает ID  записи, дубликатом которой является эта запись

	Duplicate Dependent 
	Отображает идентификаторы любых записей, которые являются дубликатами этой записи.

	Group Box 
	Управление используется для визуальной группировки одного или более других средств управления.

	History 
	Отображает действия, которые применялись к записи.

	List Box 
	Отображает список возможных значений для конкретного поля.

	List View 
	Позволяет Вам отображать записи, связанные с полем типа REFERENCE_LIST.

	Option Button 
	Средство управления Option button используется в группах, чтобы представить набор взаимоисключающих выборов.

	Parent/child 
	Позволяет Вам устанавливать форму, чтобы срединять связанные записи. Используется с полем типа REFERENCE_LIST.

	Picture 
	Позволяет Вам отображать статическое изображение на вашей форме.

	Push Button 
	Инициализирует конкретные задачи, связанные с записью. Вы можете связать кнопки команд с обработчиками прерываний записи или с представлениями списка.

	Static Text 
	Отображает недоступную для редактирования текстовую строку.

	Text Box 
	Отображает значение поля как доступную для редактирования текстовую строку.


Подробная информация? Для получения детальных описаний и команд о том, как использовать каждое управление, выберите Working with record forms > Form Control Reference в ClearQuest Designer.
Добавление поля к форме

Прежде, чем Вы сможете добавить поле к форме, Вы должны сначала создать поле в таблице Fields. Информацию о командах для создания нового поля, см. в Добавление нового поля на странице 47.
Вы можете добавлять управления полей, используя Control Palette, Fields List или меню Form Controls. Каждая методика имеет свои выгоды. Control Palette дает Вам визуальный ориентир относительно типа управления, который Вы добавляете. Fields List автоматически создает управление, соответствующее типу поля, которое Вы выбрали. Меню Form Controls позволяет Вам использовать мнемонику клавиатуры, чтобы быстро выбрать средство управления.
Чтобы добавить поле к форме, разверните Record Types > Record_Type_Name > Forms в рабочей области и дважды щелкните форму, чтобы открыть ее для редактирования.
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Редактирование свойств средства управления поля

После добавления к форме средства управления поля, щелкните правой кнопкой мыши управление и выберите Properties из контекстного меню.
Примечание: Если Вы создавали управление не способом перемещения поля из Fields List, Вы должны редактировать свойства управления, чтобы связать поле с управлением.
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Вы можете выбирать или изменять такие вещи, как имя поля и метку, форматы данных, контекстные обработчики прерываний меню и наличие или отсутствие  горизонтального или вертикального скроллирования поля. Параметры, которые Вам позволяют выбрать, зависят от типа поля.
Редактирование форм

Для получения информации о пошаговых командах для редактирования формы выберите Working with record forms > Editing forms в справке ClearQuest Designer. Вы можете выяснить как:
· Изменять размер формы
· Добавлять и удалять закладки диалога
· Добавлять доступ уровня закладки
· Добавлять и удалять средства управления
Многократное использование форм
После создания формы, Вы можете экономить время,  многократно используя форму в других схемах. Вы можете использовать ее такой, как есть, или изменять ее.
Щелкните правой кнопкой мыши на форме в папке Forms и выберите Export Form из контекстного меню. Теперь Вы можете импортировать форму в другие схемы.
Вы должны импортировать форму в тип записей с именем, идентичным типу записей, который экспортировал форму. Щелкните правой кнопкой мыши на форме в папке Forms и выберите Import Form. Вы не можете экспортировать форму и затем импортировать ее в иной тип записей в пределах одной и той же схемы.
При импортировании формы ClearQuest отображает поля, связанные с формой на  поля  выбранного типа записей. ClearQuest отображает поля, основываясь на их имени, и не выясняет, имеют ли поля соответствующие типы. Если поле в форме не соответствует полю в выбранном типе записей, Вы должны переназначить соответствующее управление к допустимому полю или удалить управление.
Удаление форм

Если Вы больше не нуждаетесь в форме, Вы можете удалить ее. Однако помните, что каждый тип записей должен иметь, по крайней мере, одну связанную с ним форму. Если тип записей имеет только одну оставленную форму, эта форма должна быть формой записи; ClearQuest не позволит Вам удалить последнюю форму типа записей.
Чтобы удалить форму:
1. В оабочей области разверните Record Types или Record Types - Stateless и разверните тип записей, который Вы хотите изменить.
2. Разверните папку Forms, щелкните правой кнопкой мыши форму и выберите Delete из контекстного меню.
Создание форм для различных платформ
Формы, которые Вы создаете в ClearQuest Designer, по-разному выглядят в клиентах Windows и Web ClearQuest. Например, в Windows Вы нажимаете закладку, чтобы отобразить ее, в то время как в ClearQuest Web Вы можете или нажимать связь, или прокручиваться, чтобы отобразить различные закладки. Однако, одна  и та же информация доступна независимо от того, какого клиента Вы используете.
Кроме того, некоторые обработчики прерываний работают по-разному в клиенте ClearQuest Web. См. Использование обработчиков прерываний в ClearQuest Web на странице 93 для информации относительно использования обработчиков прерываний клиентом Web.

Подробная информация? См. главу 8, Администрирование ClearQuest Web.
6. Администрирование пользователей

Параметры пользователя Windows, включая идентификатор пользователя и пароль, не могут использоваться в пределах ClearQuest. Вы должны использовать ClearQuest Designer для установки пользователей. ClearQuest сохраняет информацию о пользователях и группах пользователей в пользовательской базе данных и в репозитории схем.
Эта глава описывает, как устанавливать и администрировать пользователей и группы пользователей ClearQuest. Она охватывает следующие темы:
· Краткий обзор администрирования пользователей
· Права пользователей ClearQuest
· Работа с пользователями
· Работа с группами пользователей
· Управление доступом пользователя к действиям
· Экспорт и импорт пользователей и групп

Примечание: Чтобы управлять пользователями и группами пользователей, Вы должны иметь права User Administrator или Super User. ClearQuest Designer включает по умолчанию User Name (admin), которое Вы можете использовать, чтобы начать работу. Вы не должны печатать пароль. Учетная запись пользователя admin, установленная с правами Super User, необходима, чтобы Вы могли выполнить все функции администратора ClearQuest. Для получения дополнительной информации, см. Права пользователей ClearQuest на странице 65.
Краткий обзор администрирования пользователей

Для управления пользователями ClearQuest Вы используете диалог User Administration. В ClearQuest Designer выберите Tools > User Administration.
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Используйте диалог User Administration, чтобы:
· Создавать новых пользователей и группы пользователей: Сначала создайте пользователей, затем создайте группу, и добавьте пользователей к группе.
· Назначать права для пользователей и групп пользователей, которые определяют задачи, которые они могут выполнять в пределах ClearQuest и ClearQuest Designer. См. Права пользователей ClearQuest на странице 65.
· Управлять даннымми, к которым могут обращаться пользователи и группы,  давая им  доступу к определенным базам данных. См. Приписывание пользователей к базам данных на странице 67.
· Экспортировать пользовательские данные и импортировать их в другой репозиторий схем. См. Экспорт и импорт пользователей и групп на странице 72.
Примечание: Всякий раз, когда Вы добавляете или изменяете пользователя или группу пользователей, Вы должны модернизировать пользовательскую базу(ы) данных новой информацией. См. Обновление пользовательской базы данных на странице 66.
Вы можете также ограничить доступ пользователя и группы к определенным действиям ClearQuest,  добавляя обработчик прерываний контроля доступа к действию. См. Управление доступом пользователя к действиям на странице 72.
Права пользователей ClearQuest
ClearQuest поддерживает следующие типовые права пользователей и групп пользователей:
	Типичный пользователь
	Права пользователя/группы

	Active User 
	(По умолчанию)

Регистрироваться в ClearQuest и представлять новые записи; изменять существующие записи; создавать, изменять и сохранять персональные запросы, диаграммы и отчеты. 
Регистрироваться в ClearQuest Designer, чтобы просматривать схемы и информацию администрирования пользователем. Не может редактировать схемы или изменять информацию пользователя.

	Schema Designer 
	Выполнять все задачи Active User и: 
Создавать, изменять и сохранять общие запросы, диаграммы и отчеты в ClearQuest. 
Использовать ClearQuest Designer для создания и изменения схемы.

	User Administrator 
	Выполнять все задачи Active User и: 
Использовать ClearQuest Designer для создания и администрирования пользователями и группами пользователей.

	Super User 
	Выполнять все задачи Active User, Schema Designer, User Administrator и: 
Использовать ClearQuest Designer для создания и удаления баз данных. Редактировать параметры настройки ClearQuest Web.


Подробная информация? Просмотрите access, privileges в оглавлении справочной системы ClearQuest Designer.
Работа с пользователями
Используйте диалог User Administration, чтобы устанавливать и изменять пользователей.
Добавление новых пользователей

Чтобы добавить нового пользователя:
1. В ClearQuest Designer выберите Tools > User Administration, чтобы открыть диалог User Administration.
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2. В диалоге User Information:
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После выполнения нажмите OK.
3. В диалоге User Administration нажмите Upgrade user DB, чтобы добавить новую информацию к вашей пользовательской базе(ам) данных. См. следующий раздел Обновление пользовательской базы данных.

Подробная информация? Найдите users, editing an account profile в оглавлении справочной системы ClearQuest Designer.
Обновление пользовательской базы данных 
Всякий раз, когда Вы добавляете или изменяете пользователей или группы пользователей, Вы должны модернизировать вашу пользовательскую базу(ы) данных новой информацией.
В диалоге User Administration выберите Upgrade user DB.
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Приписывание пользователей к базам данных
Приписать пользователя к базе данных означает дать этому пользователю доступ к базе данных. По умолчанию ClearQuest приписывает пользователей ко всем базам данных. Вы можете ограничить доступ пользователя или группы к базе(ам) данных, которую Вы определяете.
Чтобы приписать пользователя к базе данных:
1. В ClearQuest Designer выберите Tools > User Administration, чтобы открыть диалог User Administration.
2. В диалоге User Administration выберите пользователя и нажмите Subscribe, чтобы открыть диалог Subscription for User.
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Когда выполните, нажмите OK.
3. В диалоге User Administration нажмите Upgrade user DB, чтобы добавить информацию к пользовательской базе данных. См. Обновление пользовательской базы данных на странице 66.

Подробная информация? Отыщите users, subscribing to databases в оглавлении справочной системы ClearQuest Designer.
Изменение параметров пользователя
Как администратор с правами User Administrator или Super User privileges, Вы можете редактировать параметры пользователя, включая права, назначенные пользователю.
Чтобы редактировать параметры пользователя, выберите Tools > User Administration, чтобы открыть диалог User Administration, затем нажмите Edit.
Пользователи Active users могут изменять часть собственной информации пользователя, включая имя, адрес электронной почты, пароль и номер телефона, из ClearQuest Designer или ClearQuest Client. Однако Active users не могут изменять свой собственный вход в систему или права пользователя.
Чтобы изменить параметры пользователя из ClearQuest Client, выберите View > Change user profile.
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Изменения, сделанные в параметрах пользователя, относятся ко всем базам данных,  где приписан пользователь.
Создание неактивных пользователей
Вы можете сделать пользователей неактивными. Это означает, что они не могут входить в ClearQuest или иметь связанные с ними записи о дефектах. Неактивные пользователи не присутствуют в списках выбора пользователей ClearQuest.
Чтобы сделать пользователя неактивным, выберите Tools > User Administration. Открывается диалоговое окно User Administration:
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Неактивный пользователь отображается в списке пользователей с меткой X.
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Имена неактивных пользователей сохраняются в базе данных, к которым этот пользователь был подписан, для сохранения исторической информации и целостности данных.
Работа с группами пользователей

Объединение индивидуальных пользователей в группу упрощает задачи администрирования. Например, Вы можете:
· Создавать группы типа “Инженеры программисты” или “Администраторы”, назначить различные права каждой группе, и приписать их к различным базам данных.
· Создавать правила электронной почты для группы (например, отправлять сообщение группе “Обеспечение качества” всякий раз, когда пользователь представляет новый дефект).
· Написать сценарии обработчика прерываний или внешние приложения с условной логикой для групп (например, только члены группы “Администраторы” могут повторно открыть дефект помеченный как “Разрешенный”).
Создание групп пользователей

Чтобы создать группу пользователей:
Выберите Tools > User Administration, чтобы открыть диалог User Administration, затем нажмите Edit Group, чтобы открыть диалог User Group.
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Вы можете использовать диалог User Group, чтобы создавать группы пользователей, добавлять пользователей к группам и удалять их, и приписывать группы к базам данных.
Добавление пользователя в группу

Чтобы добавить пользователя к группе:
Выберите Tools > User Administration, чтобы открыть диалог User Administration, затем нажмите Edit Group, чтобы открыть диалог User Group:
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Чтобы удалить пользователя, дважды щелкните на группе, чтобы отобразить ее членов, затем выберите пользователя и нажмите Remove.
Подробная информация? Просмотрите user groups, creating в оглавлении справочной системы ClearQuest Designer.
Приписывание групп пользователей к базам данных
По умолчанию, ClearQuest приписывает новые группы ко всем базам данных. Вы можете воспользоваться преимуществом работы с группой пользователей, чтобы приписать множество пользователей к одной или более базам данных.
Чтобы приписать группу к базам данных:
1. Выберите Tools > User Administration, чтобы открыть диалог User Administration, затем нажмите Edit Group, чтобы открыть диалог User Group:
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Когда закончите, нажмите Done.
2. В диалоге User Administration выберите Upgrade user DB, чтобы добавить изменения к пользовательской базе данных. См. Обновление пользовательской базы данных на странице 66.

Подробная информация? Просмотрите user groups, subscribing to a database в оглавлении справочной системы ClearQuest Designer.
Создание неактивных групп пользователей 
Чтобы сделать группу пользователей неактивной:
1. Выберите Tools > User Administration, чтобы открыть диалог User Administration, затем нажмите Edit Group, чтобы открыть диалог User Group:
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Когда закончите, нажмите Done.
2. В диалоге User Administration выберите Upgrade user DB, чтобы добавить изменения к пользовательской базе данных. См. Обновление пользовательской базы данных на странице 66.

Управление доступом пользователя к действиям
Вы можете сосредотачивать ответственность пользователя или группы пользователей,  ограничивая действия, которые они могут выполнять в ClearQuest. Например, Вы можете ограничить доступ к действию Assign вашей группой "Администраторы" и доступ к действию Verify группой "Управление качеством".
Чтобы ограничить доступ к действию, добавьте к действию обработчик прерываний Access Control:
В рабочей области откройте таблицу Actions.
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· Выберите Scripts, чтобы написать ваш собственный обработчик прерываний контроля доступа, который ограничивает доступ к этому действию, основываясь на критериях, которые Вы определяете. Например, Вы можете написать обработчик прерываний, который позволяет доступ к действию пользователям, которые имеют права Super User. Для получения дополнительной информации, см. главу 7, Использование обработчиков прерываний для настройки потока работ
· Выберите All Users (по умолчанию), чтобы разрешить доступ к действию любому пользователю ClearQuest.
· Выберите User group, и выберите группы, которым Вы хотите позволить доступ к этому действию.

Подробная информация? Просмотрите actions, restricting user access to в оглавлении справочной системы ClearQuest Designer.
Экспорт и импорт пользователей и групп
Вы можете использовать кнопки Import и Export в диалоге User Administration, чтобы передать список пользователей и групп пользователей из одного репозитория схем в другой. Когда Вы экспортируете список пользователей и групп, ClearQuest создает текстовый файл, который Вы можете импортировать в другой репозиторий схем. Текстовый файл содержит конфигурации каждого пользователя и группы.
7. Использование обработчиков прерываний для настройки потока работ

ClearQuest включает много предопределенных обработчиков прерываний, которые Вы можете использовать для настройки вашего потока работ. ClearQuest включает также прикладной интерфейс программирования (API), который Вы можете использовать для настройки предопределенных обработчиков прерываний, записи ваших собственных обработчиков прерываний и написания внешних приложений для выполнения задач над базой данных ClearQuest.
Эта глава описывает, как работать с обработчиками прерываний и ClearQuest API. Она содержит следующие разделы:
· Краткий обзор обработчиков прерываний

· Использование обработчиков прерываний полей

· Использование обработчиков прерываний действий

· Порядок выполнения обработчиков прерываний полей и действий

· Использование сценариев записей

· Использование глобальных сценариев

· Написание внешних приложений

· Использование ClearQuest API
· Общие вызовы API

· Поиск текста сценария обработчика прерываний

· Примеры общих обработчиков прерываний

Подробная информация? Для получения дополнительной информации о ClearQuest API выберите Rational ClearQuest API Reference из меню Start. Rational ClearQuest API Reference – это интерактивный справочник для всех вызовов ClearQuest API. Чтобы узнать об использовании обработчиков прерываний в среде сети, см. главу 8, Администрирование ClearQuest Web.
Краткий обзор обработчиков прерываний

Обработчики прерываний – это триггеры для частей кода, которые ClearQuest выполняет в нужный момент, чтобы настроить работу пользователей с ClearQuest. ClearQuest поддерживает четыре типа обработчиков прерываний:
· Field hooks (Обработчики прерываний поля)

Обработчики прерываний поля обеспечивают способ проверки значения поля во время выполнения и корректировки других полей по мере необходимости. Например, Вы можете проверять правильность содержания поля или назначать это значение по умолчанию.
· Action hooks (Обработчики прерываний действия)

Обработчики прерываний действия обеспечивают способ выполнения задач в ключевых точках жизненного цикла записи.
В общем случае, обработчики прерываний действия связаны с событиями, которые затрагивают запись в целом в противоположность обработчикам прерываний поля, которые связаны с событиями, затрагивающими конкретное поле. Например, Вы можете проверять правильность записи в целом и посылать уведомления, когда действие закончено.
· Record scripts (Сценарии записи)
Сценарии записи обеспечивают способ разрешения определенных задач во время выполнения. Они специфичны для типа записей и обычно связываются со средством управления формы.
· Global scripts (Глобальные сценарии)
Глобальные сценарии обеспечивают способ определения библиотек стандартных программ, которые могут быть использованы совместно всеми типами записей в вашей схеме. Например, Вы можете написать подпрограмму, типа уведомления электронной почты, которая может вызываться из любого обработчика прерываний  в любом типе записей.
Примечание: Вы можете писать обработчики прерываний на VBScript (для Windows) и на Perl (для Windows и UNIX). По умолчанию ClearQuest выполняет обработчики прерываний на VBScript для Windows. Чтобы изучить, как выполнить обработчик прерываний ClearQuest на Perl для Windows, см. Выбор языка создания сценария на странице 35. Когда Вы закончите редактировать обработчик прерываний, выберите Hooks > Compile, чтобы проверить синтаксис вашего кода.
Планирование обработчиков прерываний для вашего потока работ

Тщательно запланированный набор обработчиков прерываний может расширить и упростить поддержку потока работ в вашей организации. При планировании обработчиков прерываний рассмотрите следующее:
Учтите, что обработчики прерываний выполненяются с правами Super User и не подчиняются  обычному управлению доступом или ограничениям поведения поля. Это означает, что Вы можете использовать обработчики прерываний, чтобы устанавливать и сбрасывать значения в полях, которые обычно установлены только для чтения. (Вы не можете сбрасывать системные поля ClearQuest, которые установлены только для чтения, типа поля History). Поля Required остаются обязательными.
· Вы можете воспользоваться преимуществом внешнего кода, чтобы расширить возможности обработчика прерываний. VBScript имеет доступ к объектам COM, а Perl может получать доступ к объектам COM через пакеты третьих лиц. Кроме того, Perl может воспользоваться преимуществами многих пакетов третьих лиц. Например, обработчик прерываний может взаимодействовать с пользователем через диалоговые окна, или читать из внешних файлов и записывать в них. Вы обязаны обеспечить, чтобы надлежащие объекты третьих лиц были установлены на машине пользователя.
Хотя, чтобы выполнять запросы и отыскивать данные в пределах кода сценария, в ваши сценарии возможно включать код SQL, для лучших результатов следует использовать ClearQuest API. ClearQuest позволяет Вам переименовывать типы записей и поля, а это будет проблематично в любом коде SQL.
· Если Вы планируете выполнять ваши обработчики прерываний на ClearQuest Web, напишите их в VBScript, и убедитесь, что проверили их в среде сети. См. Использование обработчиков прерываний в ClearQuest Web на странице 93.
· Тестируйте и отлаживайте код обработчика прерываний так, чтобы Вы не записывали неправильные значения в вашу базу данных или не заставляли программу зависать при обработке бесконечного цикла или ожидания несуществующего ввода. Чтобы просмотреть информацию об отладке (выход метода OutputDebugString), Вы можете использовать dbwin32.exe, который поставляется с ClearQuest.
Использование обработчиков прерываний полей

Вы используете обработчик прерываний поля для события, которое воздействует на определенное поле в пределах записи. Обработчик прерываний поля может устанавливать начальное значение, отвечать на событие при измении значения поля, приводить в исполнение разрешение доступа, когда группа пользователей, которую Вы определили, изменяет  значение поля, и проверять правильность значений, которые вводят ваши пользователи.
Область действия обработчика прерываний поля – это текущее поле в пределах текущей записи. ClearQuest обеспечивает следующие предопределенные обработчики прерываний поля:
	Обработчик прерываний поля 
	Использование

	Choice List 
	Возвращает набор разрешенных значений. Используйте этот обработчик прерываний с полями, которые отображены с использованием управления типа списка, таких как блок списка или поле со списком. Вы можете также обеспечивать значения без того, чтобы писать сценарий,  используя константу или динамический список. См. Работа со списками выбора на странице 77.

	Default Value 
	Устанавливает первоначальное значение поля. Этот обработчик прерываний вызывается в начале действия Submit. Вы можете также назначать постоянное значение как значение по умолчанию.

	Permission 
	Возвращает одну из констант BehaviorType, указывающую пользовательский доступ к полю. Используйте этот обработчик прерываний, чтобы форсировать поток работ и-или защиту. (См. интерактивную справку ClearQuest API Reference для перечисления констант.) Если Вы добавляете к полю обработчик прерываний Permission, Вы должны изменить таблицу Behaviors так, чтобы, по крайней мере, одно из поведений поля было установлено к USE_HOOK. Отсутствие этого приведет к ошибке проверки правильности.

	Validation 
	Проверяет правильность содержания поля. Этот обработчик прерываний вызывается, когда изменяются значения, обеспечивая пользователя немедленной обратной связью относительно правильности содержания поля перед передачей записи в базу данных.

	Value Changed 
	Отвечает на изменения в значении поля. Используйте этот обработчик прерываний, чтобы запустить модификации для других полей (например, зависимого списка). После выполнения этого обработчика прерываний, ClearQuest проверяет правильность изменения сценария любого поля,    вызывая обработчик прерываний поля Validation (если он есть в наличии).


Подробная информация? Инструкции о том, как определить обработчики прерываний поля, см. Настройка полей  добавлением обработчиков прерываний на странице 52. Чтобы узнать о последовательности, в который выполняются обработчики прерываний, см. Порядок выполнения обработчиков прерываний полей и действий на странице 80.
Создание зависимости между полями
Вы можете создать зависимость между двумя полями так, чтобы при изменении значения исходного поля, изменялось также и значение поля потомка (зависимого поля).
Примечание: При проектировании вашей схемы тщательно планируйте зависимости полей. Зависимые поля требуют использования обработчиков прерываний, которые могут вводить ошибки во время выполнения программы, если запись неправильна. Убедитесь, что полностью проверили сценарии обработчиков прерываний перед тем, как сделать их доступными вашим пользователям.
Чтобы создать зависимость между двумя полями, добавьте к исходному полю обработчик прерываний Value Changed:
1. Откройте таблицу Fields.
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2. В таблице Fields нажмите ячейку Value Changed исходного поля и выберите из раскрывающегося списка BASIC или Perl.

Если допускается Instant Edit Mode, ClearQuest Designer автоматически открывает редактор сценариев. Чтобы допустить или отключить быстрое редактирование, выберите Edit > Instant Edit Mode. Дважды щелкните ячейку, чтобы открыть редактор сценариев, если он не появляется автоматически.
3. В редакторе сценариев напишите сценарий, который вычисляет значение исходного поля и использует его, чтобы установить значение дочернего поля. (Об установке исходного значения, основанного на дочерних значениях, см. Обработчик прерываний действия для установки значения родительской записи на странице 89.)

4. Когда Вы закончите редактировать ваш сценарий, выберите Hooks > Compile, чтобы проверить синтаксис вашего кода сценария.

Использование зависимых полей в ClearQuest Web
Если Вы хотите, чтобы зависимые поля допускались в ClearQuest Web, при добавлении поля к форме записи Вы должны использовать одно из следующих средств управления:
· Drop-down list box (Раскрывающийся список)
·  Combo box (Поле со списком)
·  Drop-down combo box (Поле с раскрывающимся списком)
Когда Вы добавляете управление к форме записи, Вы должны также отредактировать свойства управления, чтобы определить поле, на котором основана зависимость.
Подробная информация? См. Предоставление зависимых полей для ClearQuest Web на странице 93.
Работа со списками выбора
Прежде чем требовать, чтобы пользователи напечатали значение для поля, Вы можете использовать обработчик прерываний списка выбора для предоставления списка значений для выбора. Вы можете обеспечить постоянный список параметров, использовать сценарий, чтобы генерировать список допустимых значений, или устанавливать динамический список.
Чтобы создать список значений выбора для поля:
1. Откройте таблицу Fields.
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2. Выберите один из следующих списков выбора:

· Выберите Scripts, чтобы записать сценарий для списка выбора. Вы можете определять зависимый список, значения которого изменяются, когда пользователь выбирает некоторое значение в другом управлении формы. (Для примера, см. Обработчик прерываний для создания списка зависимостей на странице 86.)

· Выберите Constant List, чтобы представить набор значений для списка выбора.

· Выберите Dynamic List, чтобы создать список выбора, значения которого могут быть изменены из ClearQuest client любым пользователем, имеющим права Schema Designer или Super User. Обработчики прерываний поля с  динамическим списком удобны для списков, которые Вы хотите часто изменять, потому что они дают возможность модифицировать значения списка без изменения схемы. См. Создание обработчика прерываний динамического списка на странице 77.

· Выберите None (значение по умолчанию) только для типов поля Reference и Reference_List. Система предоставляет выбор всех активных записей данного типа как заданный по умолчанию список выбора для этих типов поля.

Создание обработчика прерываний динамического списка
Чтобы создать обработчик прерываний динамического списка:
1. В рабочей области создайте название динамического списка.
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2. Откройте таблицу Fields. Нажмите ячейку Choice List для нужного поля и выберите Dynamic List из раскрывающегося списка.
3. При запросе выберите имя динамического списка, который Вы только что создали.
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4. Далее Вы должны определить значения для динамического списка. Вы должны иметь права Schema Designer или Super User, чтобы редактировать список. (См. Права пользователей ClearQuest на странице 65.)
В ClearQuest client выберите Edit > Named Lists и выберите список, который Вы хотите редактировать.
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Определение поведения списка выбора
Когда Вы определяете обработчик прерываний Constant Value, Constant List или Dynamic List, Вы можете выбирать следующие поведения:
· Выберите Limit to List, чтобы предотвратить пользователей от ввода значений, которых нет в списке выбора. Любое значение вне  пределов списка приводит к сбою проверку правильности. Если Вы не выберете Limit to List, пользователи смогут вводить значение не из списка выбора.
Выберите Recalculate Choice List, чтобы ClearQuest повторно инициализировал список во время выполнения взаимодействия, если он зависит от изменений другого значения. Для подготовленного списка выбора эта операция регенерации может привести к некоторым издержкам эффективности. Если Вы не выберете Recalculate Choice List, ClearQuest регенерирует значения только в начале каждого действия.
Использование обработчиков прерываний действий

Обработчики прерываний действия могут управлять тем, кто имеет разрешение  измененять значения записи и проверять правильность вводов пользователя прежде, чем ClearQuest передает их базе данных. Обработчики прерываний действия могут также проверять правильность записи в целом и посылать уведомление электронной почты, когда действие закончено.
Область действия обработчика прерываний – текущая запись. ClearQuest обеспечивает следующие предопределенные обработчики прерываний действия. Они перечислены в том порядке, в котором они выполняются.
	Обработчик прерываний действия 
	Использование 
	Выполняется

	Access Control 
	Возвращает индикатор, может ли указанный пользователь инициализировать указанное действие на записи. Этот обработчик прерываний вызывается прежде, чем пользователь сможет выполнить действие. 
Вы можете написать обработчик прерываний Access Control как подпрограмму VBScript или Perl. 
См. Управление доступом пользователя к действиям на странице 72.
	Перед началом действия.

	Initialization 
	Устанавливает начальные значения поля (или любой задачи, которую Вы определяете). 
Позволяет комплексную инициализацию записи. Вы можете использовать этот обработчик прерываний, чтобы установить значения поля прежде, чем ClearQuest начинает действие. Этот обработчик прерываний вызывается после того, как действие было инициализировано, но прежде, чем содержание записи отображается в форме. 
Вы должны написать обработчик прерываний Initialization как подпрограмму сценария.
	Когда действие начинается.

	Validation 
	Проверяет правильность значений поля, которые Вы определяете. Если данные типов пользователя ошибочны, ClearQuest запрашивает пользователя относительно достоверных данных. 
Вы можете использовать этот обработчик прерываний, чтобы проверить условия, которые трудно проверить внутри отдельных обработчиков прерываний проверки правильности поля. Например, Вы можете использовать этот обработчик прерываний, чтобы проверить информацию по группе полей. ClearQuest выполняет этот обработчик прерываний до передачи любых изменений в базу данных. 
Обработчики прерываний Validation должны использовать сценарий.
	Когда пользователь передает действие.

	Commit 
	Связывает действие на множестве записей в единую транзакцию (например, разрешая все дубликаты запроса изменения, когда разрешен оригинал). 
Модифицирует набор внешних источников данных так, чтобы они остались параллельными с содержанием базы данных. Этот обработчик прерываний вызывается после того, как изменения добавлены к базе данных, но прежде, чем эти изменения переданы. 
Вы можете написать обработчик прерываний Commit как подпрограмму VBScript или Perl.
	Непосредственно перед тем, как ClearQuest передает транзакцию базе данных.

	Notification 
	Запускает действие post-commit, которое уведомляет пользователей, когда действие выполнено. См. главу 9, Администрирование ClearQuest E-mail. 
Обработчики прерываний Notification должны использовать сценарий.
	После того, как ClearQuest передает транзакцию.


Подробная информация? Информацию о командах для определения обработчиков прерываний действия, см. Настройка действий  добавлением обработчиков прерываний на странице 58. Чтобы узнать о последовательности, в который выполняются обработчики прерываний, см. Порядок выполнения обработчиков прерываний полей и действий ниже.
Порядок выполнения обработчиков прерываний полей и действий
ClearQuest выполняет обработчики прерываний полей и действий в предопределенное время и в предопределенном порядке. Когда запись открыта, есть четыре точки выполнения обработчика прерываний:
· Когда начинается действие
· Когда в поле устанавливается значение

· Когда подтверждается запись
· Когда запись передается
Когда начинается действие 
Когда пользователь инициализирует действие, ClearQuest выполняет обработчики прерываний в следующем порядке:
1. Обработчик прерываний Action Access Control останавливает обработку действия, если пользователю не позволено инициализировать действие. В этом случае остальные обработчики прерываний не выполняются.
2. Обработчик прерываний Field Permission определяет, является ли каждое поле обязательным, необязательным или только для чтения.
3. Обработчик прерываний Action Initialization выполняет задачи инициализации, такие как установки значений полей прежде, чем ClearQuest начинает действие.
4. Обработчик прерываний Field Default Value устанавливает значение для каждого поля (только для действия Submit).
Когда в поле устанавливается значение
Когда пользователь редактирует запись, ClearQuest выполняет обрабтчики прерываний в следующем порядке:
1. Обработчик прерываний Field Value Changed выполняется для каждого поля, которое изменяется. Если опция Limit to List List установлена и пользователь вводит недопустимое значение, ClearQuest отмечает поле как недопустимое. Только тогда, когда пользователь вводит допустимое значение, выполняется следующий обработчик прерываний.
Примечание: Если обработчик прерываний Field Value Changed вызывает SetFieldValue, чтобы изменить значение другого поля, ClearQuest немедленно выполняет обработчик прерываний Field Value Changed другого поля.
2. Обработчик прерываний Field Validation выполняется для каждого поля.
3. Обработчик прерываний Field Choice List выполняется для каждого поля, которое использует опцию Recalculate Choice List.
Если Вы используете зависимые поля с опцией Recalculate Choice List, ClearQuest сначала выполняет обработчик прерываний Field Validation, а затем обработчик прерываний Field Choice List для каждого поля, пока все измененные поля не будут установлены и проверены.
Примечание: В ClearQuest Web обработчики прерываний поля выполняются только, когда пользователь вызывает действие Submit. См.  Использование обработчиков прерываний в ClearQuest Web на странице 93.
Когда подтверждается запись
Перед передачей изменений в базу данных, ClearQuest проверяет правильность записи выполнением обработчиков прерываний в следующем порядке:

1. Обработчик прерываний Field Validation выполняется для каждого поля в записи.

2. Обработчик прерываний Action Validation выполняется для действия, которое было выполнено.
Когда запись передается
Обработчик прерываний Commit выполняется после того, как база данных уже модифицирована изменениями в текущей записи, но прежде, чем транзакция модификации была передана базе данных. Это означает, что Вы не можете использовать обработчик прерываний Commit, чтобы изменить текущую запись; такие модификации не применяются к записи.
Используйте обработчик прерываний Commit только для действий на других записях, которые Вы хотите иметь частью той же транзакции базы данных, что и основное действие. (Например, разрешая дубликат дефекта, когда исходный дефект разрешен.)
После того, как ClearQuest проверит правильность записи, он передает запись в базу данных через выполнение следующих обработчиков прерываний:
1. Выполняется обработчик прерываний Action Commit.
2. ClearQuest передает транзакцию в базу данных.
3. Выполняется обработчик прерываний Action Notification. Например, ClearQuest может посылать сообщение электронной почты различным пользователям, основываясь на правилах электронной почты, которые Вы устанавливаете.
Использование сценариев записей
Вы можете написать сценарий, который исполняет заказное поведение в контексте записи. Подпрограмма со  сценарием записи специфична для одного типа записей. Например, сценарий записи может посылать данные относительно текущей записи на другую систему.
Имеются три способа вызова сценария записи:
· Связать сценарий записи с управлением формы, кнопкой или (щелчок правой кнопкой мыши) контекстным меню.
Например, в схеме TeamTest, сценарий записи Build_Properties позволяет пользователям рассматривать свойства компоновки, которую они выбрали. Сценарий связан с кнопкой, которая, когда она нажата, выполняет сценарий. В этом случае сценарий записи Build_Properties отыскивает информацию компоновки в Rational Repository и отображает информацию в диалоговом окне.
· Использовать действие для вызова сценария записи. Создайте действие Record_script_alias, и свяжите его со сценарием записи. Когда пользователь выбирает действие, немедленно вызывается сценарий записи. Чтобы модифицировать текущую запись изнутри такого сценария, начните действие в сценарии, используя ClearQuest API метод EditEntity в объекте сеансе.
· Вызовите сценарий записи изнутри другого сценария или обработчика прерываний,  используя ClearQuest API методо FireNamedHook в объекте сущности.
Подробная информация? Просмотрите record scripts в оглавлении справочной системы ClearQuest Designer и обратитесь к интерактивной справке ClearQuest API Reference.
Использование глобальных сценариев
Вы можете использовать глобальные сценарии, чтобы определять общие функции, которые Вы можете вызывать из  любого обработчика прерываний вашей схемы. Глобальные сценарии  подобны библиотеке подпрограмм; ClearQuest не вызывает их непосредственно.
Глобальные сценарии полезны, когда Вы имеете множество типов записей, которые вызывают один и  тот же код обработчика прерываний. Они дают возможность Вам централизовать техническое обслуживание кода обработчика прерываний и избежать копирования кода обработчика прерываний во множество мест. Например, глобальный сценарий, включенный в пакет электронной почты ClearQuest, позволяет множеству действий посылать уведомление,  вызовом одного глобального сценария.
Подробная информация? Отыщите global scripts в оглавлении справочной системы ClearQuest Designer.
Написание внешних приложений

Вы можете писать внешние приложения на VBScript или Perl, чтобы выполнять задачи в базе данных ClearQuest. Вы можете использовать внешнее приложение, чтобы создавать запрос, выполнять сохраненный запрос, создавать новые записи и выполнять действия на существующих записях. Например, внешнее приложение может:
· В полночь каждый день выполнять предопределенный набор запросов, и отправлять результаты в группу ваших администраторов.
· Каждое воскресенье отыскивать все дефекты, которые были обнаружены более месяца назад, и указывать их состояние.
Внешнее приложение должно начинаться  созданием объекта сеанс и регистрацией в базе данных ClearQuest. См. Работа с сеансами на странице 83.
Примечание: ClearQuest поставляет свою собственную версию Perl (CQPerl.exe, CQPerl.dll). При создании внешних приложений, использующих Perl, удостоверьтесь, что Вы используете пакет CQPerlExt. См. Using the ClearQuest API в интерактивной справке ClearQuest API Reference.
Использование ClearQuest API
Вы можете использовать ClearQuest API, чтобы настраивать предопределенные обработчики прерываний ClearQuest, писать ваши собственные обработчики прерываний, и писать внешние приложения, которые выполняют задачи баз данных ClearQuest.
Подробная информация? См. интерактивную справку ClearQuest API Reference для подробностей относительно объектов, методов, свойств и констант, которые Вы можете использовать, когда записываете обработчики прерываний и/или внешние приложения.
Работа с сеансами
Объект Session представляет текущий сеанс доступа к базе данных и является  исходной точкой всех действий. Если Вы пишете обработчики прерываний, ClearQuest обеспечивает доступ к текущему объекту Session методом GetSession объекта Entity. Поскольку обработчики прерываний оперируют в контексте изменения записи (сущности), Вы всегда имеете соответствующий объект Entity,  чтобы вызвать GetSession.
Если Вы пишете внешнее приложение, чтобы обратиться к базам данных ClearQuest, Вы должны создать объект Session и зарегистрироваться в базе данных. Чтобы работать с сущностью, Вы должны вызвать API, который возвращает объект сущность.
Подробная информация? См. Working with sessions в интерактивной справке ClearQuest API Reference.
Работа с запросами
Вы можете выполнять запросы, чтобы отыскивать данные в базе данных ClearQuest, основываясь на наборе поисковых критериев, которые Вы обеспечиваете. Чтобы создать запрос:
· Сформируйте запрос, используя объект QueryDef, чтобы определить нужные данные.
· Создайте объект ResultSet, содержащий данные.
· Выполните запрос, чтобы отыскать данные в наборе результатов.
· Обратитесь к данным.
Подробная информация? Чтобы изучить, как формировать запрос, используя объекты типа QueryDef и ResultSet, см. Working with Queries в интерактивной справке ClearQuest API Reference API.
Работа с записями

Когда один из ваших пользователей вводит запрос изменения, ClearQuest сохраняет данные в логической записи, называемой сущностью. Вы можете создавать, редактировать и рассматривать данные записи, также как рассматривать данные относительно типа сущности записи. Метод BuildEntity дает возможность создавать новую запись; метод EditEntity дает возможность редактировать существующую запись. ClearQuest API обеспечивает также методы проверки правильности ваших изменений и передачи модифицированной записи в базу данных.
Подробная информация? См. Working with Records в интерактивной справке ClearQuest API Reference.
Общие вызовы API
Этот раздел перечисляет стандартные конструктивные блоки, из которых Вы можете создавать обработчики прерываний. Каждый вызов API представлен сначала в VBScript, а затем в Perl. Используется синтаксис в формате <object.><method>.
Примечание: В Perl текущий объект Entity и объект Session определен как entity и session (нижний регистр). Для VBScript принят текущий объект Entity, и Вы не должны явно идентифицировать его при вызове.
Подробная информация? См. интерактивную справку ClearQuest API Reference.
	Вызов API (VBScript/Perl) 
	Функция

	[entity.]GetSession
$entity->GetSession 
	Устанавливает сеанс, необходимый для вызова многих других API.

	session.OutputDebugString
$session->OutputDebugString 
	Фиксирует информацию, которую Вы можете использовать для отладки вашего кода обработчика прерываний или внешнего приложения.

	session.GetEntity
$session->GetEntity 
	Отыскивает записи в базе данных.

	session.EditEntity
$session->EditEntity 
	Редактирует запись, которую ClearQuest отыскал в базе данных.

	[entity.]SetFieldValue
$entity->SetFieldValue 
	Назначает значение для поля.

	[entity.]Validate
$entity->Validate 
	Гарантирует, что данные в записи допустимы перед попыткой ClearQuest сохранить запись в базе данных.

	[entity.]Commit
$entity->Commit 
	Передает запись, включая все редактирования, в базу данных.

	[entity.]Revert
$entity->Revert 
	Отменяет изменения. Хороший метод, если происходит сбой проверки правильности и не происходит передачи.

	[entity.]GetFieldValue
$entity->GetFieldValue 
	Отыскивает объект информации поля для определенного поля.

	FieldInfo.GetValue
$FieldInfo->GetValue 
	Отыскивает значение(я) поля.

	session.BuildQuery 
$session->BuildQuery 
	Формирует запрос.

	QueryDef.BuildField
$QueryDef->BuildField 
	Включает поле в результаты поиска запроса.

	QueryDef.BuildFilterOperator QueryFilterNode.BuildFilterOperator

$QueryDef->BuildFilterOperator $QueryFilterNode->BuildFilterOperator 
	Формирует оператор фильтра для запроса типа “равно” или “более чем“.

	QueryFilterNode.BuildFilter
$QueryFilterNode->BuildFilter 
	Создает поддержку для сложного запроса.

	session.BuildResultSet
$session->BuildResultSet 
	Создает объект ResultSet, необходимый для выполнения запроса.

	ResultSet.Execute
$ResultSet->Execute 
	Выполняет запрос с текущим объектом ResultSet.

	ResultSet.MoveNext
$ResultSet->MoveNext 
	Перемещает курсор в следующую запись в наборе данных.

	ResultSet.GetColumnValue
$ResultSet->GetColumnValue 
	Отыскивает значение в столбце, который Вы определяете для текущей строки.

	session.GetUserLoginName
$session->GetUserLoginName 
	Устанавливает ID пользователя для входа в систему.

	entity.Revert
$entity->Revert 
	Отбрасывает любые изменения, сделанные к объекту Entity.
Не используйте Revert API, чтобы прерывать текущее действие изнутри обработчика прерываний. Этот API – только для возвращения действия, которое было явно начато в пределах обработчика прерываний или сценария. Если Вы должны прервать текущее действие, используйте механизмы исключения языка сценария, чтобы отбросить исключение или заставить обработчик прерываний проверки правильности действия возвращать “false”.


Поиск текста сценария обработчика прерываний
Используйте эту опцию меню, чтобы находить или редактировать определенный текст сценария в обработчиках прерываний, используемых данной схемой. Вы не должны определять данный обработчик прерываний; эта опция отыскивает все обработчики прерываний для определенного текста сценария.
1. Откройте схему,  для которой Вы хотите отыскать текст сценария обработчика прерываний.
2. Выберите Edit > Find in Hooks и введите текстовую строку, которую Вы хотите отыскать, используя следующие поля:
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· Find What

Напечатайте текст,  который Вы хотите отыскать.
· Match Case
Нажмите переключатель, если Вы хотите, чтобы ClearQuest Designer искал текстовую строку точно такую, как Вы напечатали (с учетом регистра).
3. Окно Validation отображает результаты поиска:
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Дважды щелкните определенный ввод, который Вы хотите рассматривать или редактировать. Появляется окно с определенным сценарием и текстом для редактирования.
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Примеры общих обработчиков прерываний
Этот раздел приводит несколько примеров обработчиков прерываний, которые обычно используются администраторами ClearQuest:
· Обработчик прерываний для создания списка зависимостей
· Обработчик прерываний списка выбора полей для отображения информации пользователя
· Обработчик прерываний инициализации действия для значения поля
· Обработчик прерываний действия для установки значения родительской записи
Обработчик прерываний для создания списка зависимостей
Пример ниже предполагает, что значения, которые Вы хотите иметь для операционной системы клиента, зависят от выбора значений вашими пользователями для операционной системы сервера.
1. В поле server_os создайте обработчик прерываний Choice List с перечислимым списком наборов значений для Windows NT и UNIX:
VBScript:

choices.AddItem("NT")

choices.AddItem("Unix")

Perl:

push(@choices,"NT","Unix");

return @choices; #ClearQuest Designer provides this line of code

2. Чтобы предотвратить добавление новых членов к списку вашими пользователями, выберите свойство Limit to List.
3. Чтобы очистить старое значение в client_os, когда в server_os выбрано новое значение, добавьте следующее к обработчику прерываний Value Changed server_os:
VBScript:

SetFieldValue "client_os", ""

Perl:

$entity->SetFieldValue("client_os", "");

4. В поле client_os создайте обработчик прерываний Choice List:
VBScript:

dim server_os_choice

set server_os_choice = GetFieldValue("server_os")

select case server_os_choice.GetValue()

case "NT"

choices.AddItem ("Win95")

choices.AddItem ("NT")

choices.AddItem ("Web")

case "Unix"

choices.AddItem ("Web")

end select

Perl:

$server_os_choice = $entity->GetFieldValue("server_os");

$svalue = $server_os_choice->GetValue();

if ($svalue eq "NT") {

push(@choices, "Win95","NT","Web");

} elsif ($svalue eq "Unix") {

push(@choices,"CQWeb");

}

5. return @choices; #ClearQuest Designer provides this line of code

6. В свойствах для обработчика прерываний client_os, выберите Recalculate choice list так, чтобы всякий раз, когда server_os изменяет поле, значения вычислялись заново.
7. Добавьте поля client_os и server_os к вашей форме, используя средства управления списком.
Обработчик прерываний списка выбора полей для отображения информации пользователя
Этот обработчик прерываний автоматически извлекает имена входящих в систему пользователей с доступом к этой базе данных и загружает их в ваш список выборов для этого поля.
VBScript:

Sub AssignedTo_ChoiceList(fieldname, choices)

’ fieldname As String

’ choices As Object

’entityDef = Defect

Dim sessionObj

Dim queryObj

Dim filterObj

Dim resultSetObj

Set sessionObj = GetSession()

’ start building a query of the users

Set queryObj = sessionObj.BuildQuery("users")

’ have the query return the desired field of the user object(s)

queryObj.BuildField ("login_name")

’ filter for members of group "MyGroup" (whatever group you want)

Set filterObj = queryObj.BuildFilterOperator(AD_BOOL_OP_AND)

filterObj.BuildFilter "groups", AD_COMP_OP_EQ, "MyGroup"

Set resultSetObj = sessionObj.BuildResultSet(queryObj)

’ run it

resultSetObj.Execute

’ add each value in the returned column to the choicelist

Do While resultSetObj.MoveNext = AD_SUCCESS


choices.AddItem resultSetObj.GetColumnValue(1)

Loop

End Sub

Perl:

sub AssignedTo_ChoiceList {

my($fieldname) = @_;

my @choices;

# $fieldname as string scalar

# @choices as string array

# record type name is Defect

# field name is myuser

# use array operation to add items. Example:

# push(@choices, "red", "green", "blue");.136 Administering Rational ClearQuest

my $session = $entity->GetSession();

# start building a query of the users

my $queryDefObj = $session->BuildQuery("users");

# have the query return the desired field of the user object(s)

$queryDefObj->BuildField("login_name");

# filter for members of group "MyGroup" (whatever group you want)

my $filterOp = $queryDefObj->BuildFilterOperator(

$CQPerlExt::CQ_BOOL_OP_AND);

my @array = ("MyGroup");

$filterOp->BuildFilter("groups", $CQPerlExt::CQ_COMP_OP_EQ, \@array);

my $resultSetObj = $session->BuildResultSet($queryDefObj);

# run it

$resultSetObj->Execute();

# add each value in the returned column to the choicelist

while ($resultSetObj->MoveNext() == $CQPerlExt::CQ_SUCCESS) {

push(@choices,$resultSetObj->GetColumnValue(1));

}

return @choices;

}
Обработчик прерываний инициализации действия для значения поля
В этом примере, когда пользователь вызывает   действие Submit, обработчик прерываний действия инициализирует поле problem_description с именем входящего в систему того человека,  который представляет запись. Таким образом, пользователи знают, кто создавал первоначальный запрос изменения.
VBScript:

Dim session

Dim loginName

‘ Get the session

set session = GetSession

‘ Get the logon name

loginName = session.GetUserLoginName

SetFieldValue "problem_description", loginName

Perl:

# session is preset for Perl. No GetSession is required.

# Get the logon name

$loginName = $session -> GetUserLoginName();

$entity -> SetFieldValue("problem_description",$loginName);
Обработчик прерываний действия для установки значения родительской записи

Используйте следующее действие обработчика прерываний вместе со связью предок/потомок,  чтобы создать базирующиеся на состоянии отношения между исходной записью и ее дочерними записями. Этот обработчик прерываний позволяет Вам автоматически перемещать исходную запись в следующее состояние, если все дочерние записи находятся в этом состоянии (см. Использование полей для связи записей на странице 50).
Примечание: Этот код принимает некоторые имена поля и типы записей. Если Вы "вырезаете и вставляете", Вы должны будете сделать некоторые изменения.
VBScript:

Dim SessionObj

Dim ParentID ‘Dimension variables that hold objects

Dim ParentObj

Dim ChildRefList

Dim ChildArray

Dim ChildID

Dim DefectChildEntityObj

Dim StateStatus

Dim SameState

Dim CurrentState

Dim RetValue

Dim ActionJustPerformed

set SessionObj = GetSession

ThisID = GetDisplayName

ActionJustPerformed = GetActionName

SessionObj.OutputDebugString "action is: " & _

ActionJustPerformed & vbCrLf

StateStatus = ""

SameState = 0

SessionObj.OutputDebugString "current db id is: " & ThisID _

& vbCrLf

ParentID = GetFieldValue("parent").GetValue()

SessionObj.OutputDebugString "parent id is: " & ParentID _

& vbCrLf

if ParentID <> "" then

set ParentObj=SessionObj.GetEntity("defect", parent_id)

ChildRefList=ParentObj.GetFieldValue("children").GetValue

ChildArray=split (ChildRefList, vbLf)

For Each ChildID In ChildArray

set DefectChildEntityObj=SessionObj.GetEntity("Defect", _

ChildID)

CurrentState=DefectChildEntityObj.GetFieldValue _

("State").GetValue

SessionObj.OutputDebugString "StateStatus is: " & _

StateStatus & vbCrLf

SessionObj.OutputDebugString "CurrentState is: " & _

CurrentState & vbCrLf

SessionObj.OutputDebugString "SameState is: " & _

SameState & vbCrLf

if StateStatus = "" then

StateStatus = CurrentState

SameState = 1

SessionObj.OutputDebugString "coming to statestatus _

is null" & vbCrLf

elseif StateStatus = CurrentState then

SessionObj.OutputDebugString "coming to same state" & _

vbCrLf

SameState = 1

else

SessionObj.OutputDebugString "states are different" & vbCrLf

SameState = 0

end if

Next

if SameState = 1 then

SessionObj.OutputDebugString "samestate = 1, setting _

parent state" & vbCrLf

SessionObj.EditEntity ParentObj, ActionJustPerformed

status = ParentObj.Validate

if (status <> "") then

SessionObj.OutputDebugString "error when updating parent _

state: " & status & vbCrLf

ParentObj.Revert

exit sub

end if

ParentObj.Commit

end if

end if

Perl:

$SessionObj=$entity->GetSession();

$ThisID=$entity->GetDisplayName();

$ActionJustPerformed->GetActionName();

$ParentID=$entity->GetFieldValue("parent1")->GetValue();

$StateStatus="";

$SameState=0;

# ClearQuest has a message monitor to display

# ClearQuest messages and your messages

$SessionObj->OutputDebugMessage ("perl current db id is: $ThisID\n");

$SessionObj->OutputDebugMessage ("perl parent id is: $parent_id\n");

if ($ParentID ne "") {

$ParentObj = $SessionObj->GetEntity("defect", $ParentID);

$ChildRefList=$ParentObj->GetFieldValue

("children")->GetValue();

$SessionObj->OutputDebugMessage ("children are:

$ChildRefList\n");

@ChildArray = split (/\n/,$ChildRefList);

foreach $ChildID (@ChildArray) {

$DefectChildEntityObj = $SessionObj->GetEntity("defect",

$ChildID);

$CurrentState =$DefectChildEntityObj->

GetFieldValue("State")->GetValue();

$SessionObj->OutputDebugMessage("perl StateStatus is:

$StateStatus\n");

$SessionObj->OutputDebugMessage("perl Current Status is:

$CurrentStatus\n");

$SessionObj->OutputDebugMessage("perl SameState is:

$SameState\n");

if ($StateStatus eq "") {

$StateStatus = $CurrentState;

$SameState = 1;

$SessionObj->OutputDebugMessage("coming to

statestatus is null\n");

} elsif ($StateStatus eq $CurrentState) {

SessionObj->OutputDebugMessage ("coming to same

state\n");

$SameState = 1;

} else {

$SessionObj->OutputDebugMessage("states are

different\n");

$SameState = 0;

} #nested if statements

} #End foreach Loop

if ($SameState == 1) {

$SessionObj->OutputDebugMessage("samestate = 1, setting

parent state\n");

$SessionObj->EditEntity($ParentObj, $ActionJustPerformed);

$status = $ParentObj->Validate();

if ($status ne "") {

$SessionObj->OutputDebugMessage ("error when updating

parent state: $status\n");

$ParentObj->Revert

return -1; # Exit

}

$ParentObj->Commit();

} #end if for ($SameState == 1) 

} #end if for ($ParentID ne "")

8. Администрирование ClearQuest Web
ClearQuest Web позволяет пользователям обращаться к данным ClearQuest из броузера сети. Эта глава описывает, как управлять ClearQuest Web. Она содержит следующие разделы:
· Обсуждение ClearQuest Web
· Ограничение доступа к ClearQuest Web
· Использование обработчиков прерываний в ClearQuest Web
Примечание: Чтобы установить поддержку сети для ваших пользователей, см. руководство Инсталляция Rational ClearQuest.
Обсуждение ClearQuest Web
Когда ваши пользователи используют ClearQuest Web, Вы должны их уведомить относительно следующего:
· Пользователи не могут конкретизировать запросы для диаграмм.
· Пользователи могут использовать только общие диаграммы и отчеты (они не могут создавать своих собственных).
· Пользователи могут генерировать отчеты только в формате HTML.
· Для движения через приложение пользователи должны использовать кнопки ClearQuest Web. Они не могут использовать для этого кнопки Back и Forward броузера сети.
Настройка ClearQuest Web
Вы можете настраивать интерфейс ClearQuest Web. Например, Вы можете изменять используемые шрифты и систему цветов интерфейса. Вы можете также редактировать связанные с эффективностью параметры настройки.
Чтобы редактировать параметры настройки ClearQuest Web, Вы должны иметь права Super User. Зарегистрируйтесь в ClearQuest Web и выберите Operations > Edit Web Settings.
Ограничение доступа к ClearQuest Web
Вы можете ограничивать доступ к ClearQuest Web, ограничивая возможности пользователей или группы пользователей следующими действиями:
· Представление записей
· Выполнение представляемого Вами одиночного запроса
Эта “web entry” версия ClearQuest Web обеспечивает новый уровень прав пользователей.
Например, Вы можете дать возможность участникам бета-тестирования обеспечивать обратную связь через защищенный паролем “extranet”. Сначала, Вы создадите группу пользователей ClearQuest (см. Работа с группами пользователей на странице 69), состоящую из заказчиков, с которыми Вы хотите иметь обратную связь, а затем распределите ClearQuest URL для этой группы. Эта группа сможет только представлять записи и использовать запрос, который Вы им обеспечите. Результаты запроса доступны только для чтения.
Для конфигурирования ClearQuest Web с целью иметь “web entry” клинтов для определенных пользователей или групп пользователей, выберите Operations > Edit Web Settings в ClearQuest Web. Вы должны иметь права Super User, чтобы конфигурировать входы сети.
Подробная информация? Для получения дополнительной информации, выберите Editing Settings в справке ClearQuest Web.
Использование обработчиков прерываний в ClearQuest Web
При работе с ClearQuest Web, обработчики прерываний, которые Вы создаете в вашей схеме,  выполняются на  сервере сети. Когда использование касается ClearQuest Web, имейте в виду следующее:
· Обработчики прерываний для сети должны быть написаны на VBScript.
· Вы должны допустить зависимые поля для ClearQuest Web.
· Вы не можете использовать окна сообщений.
· Обработчики прерываний с  контекстным меню не поддерживаются.
· Вы можете использовать обработчики прерываний для выявления сеанса сети.
Предоставление зависимых полей для ClearQuest Web
ClearQuest Web не знает о зависимостях, которые существуют между полями. Чтобы допустить зависимые поля для ClearQuest Web:
1. Создайте зависимые отношения поля, используя обработчик прерываний поля Value Changed.
При работе ClearQuest Web, обработчики прерываний поля могут устанавливать значения зависимых полей, но они не могут связывать значения полей, иных, чем их собственные.
2. Используйте соответствующее управление, чтобы добавить поле к форме записи. И поле, которое создает зависимость, и зависимые поля, должны использовать одно из следующих средства управления. Вы можете соединять и сочетать их:
· Drop-down list box (Раскрывающийся список)
· Combo box (Поле со списком)
· Drop-down combo box (Поле с раскрывающимся списком)

3. Щелкните правой кнопкой мыши управление на форме и выберите Properties из контекстного меню.
В окне свойств управления используйте закладку Web Dependent Fields, чтобы определить поля, которые зависят от значения соответствующего поля. Только исходное поле зависимости должно допускаться сетью.
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Примечание: Чтобы модифицировать список выбора, связанный с зависимым полем, выберите Recalculate Choice List, когда Вы создаете список выбора в поле. ClearQuest повторно вычисляет содержание списка перед отображением его пользователю. Это может уменьшать эффективность сети.
Отображение сообщений в ClearQuest Web
Функции, которые вызывают другие приложения Windows, типа окна сообщений, вызывают зависание пользователя сети. Например, если функция окна сообщений выполняется на сервере сети, окно сообщений появляется на экране сервера. Так как пользователь не может нажать OK на сервере, пользователь вынужден ждать. Это требует, чтобы Вы перезагрузили сервер сети.
Однако, если обработчики прерываний сценария записи возвращают строковое значение, эта строка отображается пользователю.
Использование обработчиков прерываний для обнаружения web сеанса
При записи обработчиков прерываний Вы можете использовать ClearQuest API, чтобы обнаружить, находится ли пользователь в броузере сети раньше, чем в собственном клиенте. Это позволяет Вам произвести соответствующее действие, если Вы не корректировали вашу схему, чтобы соответствовать функциональным возможностям, доступным на сети. Например, когда Вы обнаруживаете сеанс сети в функции, которая создает окно сообщений или новое окно, Вы можете вызывать код, модифицированный для среды сети или выйти из функции.

Обнаружение Web сеанса на VBScript
dim currDBSession 
’ Current Db session

set currDBSession = GetSession

’ Test for existence of the web session variable

if currDBSession.HasValue ("_CQ_WEB_SESSION") then

’ Either exit or do something else

end if
Обнаружение Web сеанса на Perl
my $currDBSession; # Current Db session

$currDBSession = $entity->GetSession();

# Test for existence of the web session variable

if ( $currDBSession->HasValue ("_CQ_WEB_SESSION") {

# Either exit or do something else

}
9. Администрирование ClearQuest E-mail

ClearQuest использует возможности электронной почты  двумя способами:
· ClearQuest может посылать уведомления электронной почты пользователю или группе пользователей, когда запись отвечает критерию, которые Вы определяете. Например, Вы можете посылать электронную почту вашей группе тестирования, как только будет исправлен дефект. Чтобы сделать это, Вы устанавливаете правила электронной почты в ClearQuest Client.
· Пользователи ClearQuest могут представлять и изменять записи с помощью электронной почтой. Например, пользователи могут ответить на уведомление электронной почты своими примечаниями, которые могут быть приобщены к записи в базе данных ClearQuest. Чтобы установить возможность представлениязаписей с помощью электронной почты, Вы используете Rational E-mail Reader.
Примечание: Вы можете комбинировать уведомления электронной почты с представлениями электронной почты для модификации записей, используя электронную почту “туда и обратно”.
Эта глава описывает, как допустить возможности электронной почты ClearQuest. В ней освещаются следующие темы:
· Настройка автоматической электронной почты
· Передача записей электронной почтой
· Использование электронной почты “туда и обратно”
Настройка автоматической электронной почты
Чтобы дать возможность ClearQuest посылать автоматическую электронную почту:
· Вы должны установить правила электронной почты в ClearQuest Client.
· Каждый пользователь ClearQuest Client должен допустить уведомление электронной почты на своей собственной машине.
Установка правил электронной почты
Правила электронной почты используются, чтобы установить уведомление электронной почты для пользователей ClearQuest. Например, Вы можете создать правило электронной почты, которое посылает электронную почту группе обеспечения качества, когда дефект разрешен. Вы можете устанавливать правило электронной почты, чтобы включать в сообщение любое из полей разрешенного дефекта.
Вы создаете правила электронной почты,  представляя записи Email_Rule из ClearQuest Client. Чтобы добавить или изменить правило электронной почты, Вы должны иметь права Super User или Schema Designer  (см. Права пользователей ClearQuest на странице 65).
Для установки правил электронной почты, выберите Actions > New  в ClearQuest Client, и выберите тип записей Email_Rule.
Используйте тип записей Email_Rule, чтобы установить параметры для определения, когда электронная почта послана, каким пользователям или группам пользователей она послана и содержания сообщения электронной почты.

[image: image72.png]



Когда Вы создаете правило электронной почты, Вы устанавливаете критерий, который запускает уведомление электронной почты. Вы можете посылать электронную почту, основываясь на следующих событиях:
· Значение поля в записи изменилось.
· Над записью произведено определенное действие.
· Запись соответствует критериям определенного запроса.
Примечание: Большинство предопределенных схем ClearQuest включает тип записей Email_Rule. Если схема, которую Вы используете, не имеет этого типа записей, Вы можете добавить эти функциональные возможности,  добавляя пакет Email (см. приложение A, Схемы и пакеты ClearQuest).
Подробная информация? Просмотрите e-mail в оглавлении справочной системы ClearQuest.
Конфигурирование клиентов ClearQuest для отправки электронной почты
Чтобы посылать сообщения уведомлений электронной почты, пользователи ClearQuest должны сконфигурировать параметры настройки своей электронной почты и допустить уведомление электронной почты. Это позволяет индивидуальным клиентским машинам использовать правила электронной почты ClearQuest, установленные Вами.
Пользователи устанавливают свою электронную почту,  выбирая View > E-mail Options в ClearQuest.
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Если Вы нажали e-mail notification, нажмите Next, чтобы определить параметры провайдера электронной почты.
Примечание: О конфигурировании ClearQuest Web для отправки электронной почты см. Установка ClearQuest Web в руководстве Инсталляция Rational ClearQuest.
Подробная информация? Просмотрите e-mail в оглавлении справочной системы ClearQuest.
Представление записей электронной почтой
Чтобы дать возможность вашим пользователям представлять и изменять записи электронной почтой, Вы должны сконфигурировать Rational E-mail Reader. Rational E-mail Reader – это обрабатывающий инструмент электронной почты, который анализирует представления электронной почты и передает новые записи или изменения в базу данных. Вы должны запустить только один экземпляр Rational E-mail Reader на машине в то же домене, что и сервер базы данных ClearQuest.
Конфигурирование Rational E-mail Reader

E-mail Reader (mailreader.exe) автоматически инсталлируется в каталоге \Rational\common. Вы можете перетащить копию mailreader.exe на рабочий стол, чтобы создать для него ярлык.
Чтобы запустить E-mail Reader, дважды щелкните mailreader.exe.
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При конфигурировании E-mail Reader учтите следующее:
· E-mail Reader требуется сообщению специализированной электронной почты для синтаксического анализа записей.

· Вы должны определить одну машину для выполнения E-mail Reader. Чтобы гарантировать, что услуги электронной почты всегда доступны, запустите E-mail Reader на той же машине, что и ваш сервер базы данных.
· Любая посланная электронная почта должна быть в требуемом формате. См. Форматирование электронной почты для представления на странице 98. Нажмите Help и следуйте инструкциям, чтобы установить E-mail Reader.
· Вы должны установить необходимые для использования значения по умолчанию. Это позволит пользователям быстро отвечать на уведомление электронной почты, не задумываясь о необходимом формате.
· Значения полей, представленые электронной почтой, перезаписывают существующие данные. Если Вы хотите добавить имеющиеся данные, Вы должны определить поле, которое позволяет пользователям добавлять данные, типа Notes Log (доступного в большинстве предопределенных схем).
Форматирование электронной почты для представления
Любая посланная электронная почта должна соответствовать формату, показанному ниже. Если она не соответствует этому формату, представление электронной почты потерпит неудачу, и электронная почта будет удалена.
Subject: 
<тип записей> <действие> <идентификатор записи>

Body: 

<fieldname: допустимое значение>




<fieldname: допустимое значение>

{<multiline_fieldname: это - пример значения поля для поля, чей тип данных - многострочный текст. Этот тип требует фигурных скобок>

} Обратите внимание, что закрывающая фигурная скобка (}) должен быть на отдельной строке от многострочного текста, который она заключает
Строка Subject должна подчиняться следующим рекомендациям:
· Тип записей всегда необходим и он перечисляется первым.
· Название действия помещено в списке после типа записей. Если Вы установили значения по умолчанию, Вы можете опустить действие (см. пример ниже). Пользователи могут отменять значения по умолчанию,  определяя иное действие. Если Вы не указываете действие, и значения по умолчанию не установлены, представление будет отклонено.
· Идентификатор записи находится в списке после действия, но он необязателен при представлении новых записей.
Примечание: Вы можете конфигурировать E-mail Reader для отслеживания ошибок и для отправки электронной почты, когда записи для передачи в базу данных ошибочны.
Пример форматирования E-mail
В этом примере Вы устанавливаете действие по умолчанию как Modify и заданное по умолчанию поле как Notes Log. Строка Subject требует тип записей и идентификатор записи, но из-за значений по умолчанию имя действия необязательно.
Subject: 
RE: defect SAMPL00000017

Body: 

{ Сегодня мы поместили "заплату" (patch) для этой проблемы на интранет компании. Пожалуйста, загрузите patch, чтобы решить проблему вашего заказчика.




}

Подробная информация? Просмотрите e-mail в оглавлении справочной системы ClearQuest Designer.

Рекомендации для использования формата электронной почты
Имейте в виду, что правила вашей схемы, типа требуемых полей и допустимых значений, применяются, когда пользователи представляют или изменяют записи с использованием электронной почты. Например, если пользователь определяет действие Submit, но будет не в состоянии включить все требуемые поля для состояния Submit, электронная почта вернется к отправителю с сообщением об ошибках.
Используйте следующие рекомендации при посылке электронной почты:
· Используйте фигурные скобки для текстового многострочного поля. Заметьте, что правая фигурная скобка (}) должна быть на отдельной строке от многострочного текста, который она заключает.
{description: мы описываем здесь ... следуют строки текста ...

}

· Если используются недопустимые значения, Rational E-mail Reader посылает представляющему сообщение об ошибках.
· Представление электронной почты не поддерживает добавленных присоединений.
· Поля могут перечисляться в любом порядке.
· Электронная почта должна включать значения для всех обязательных полей.
· Включайте только те поля, которые Вы хотите записать поверх. Чтобы избежать записывания поверх модификаций, сделанных другими пользователями, используйте поле, которое присоединяет текст и сохраняет более ранние вводы.
· Не устанавливайте значения поля только для чтения (например, идентификатор дефекта), потому что ClearQuest не изменяет такие поля.
· Собственное уведомление электронной почты ClearQuest использует необходимый формат автоматически. Пользователи могут использовать эту почту как шаблон для посылки дополнительных записей или модификаций через электронную почту.
Примечание: Вы можете конфигурировать E-mail Reader, чтобы сохранять файл регистрации или посылать электронную почту Вам всякий раз, когда представление потерпит неудачу.
Использование электронной почты “туда и обратно”
Ваша группа может использовать уведомление электронной почты наряду с представлением с помощью электронной почты для модификации записей. Эта комбинация называется электронной почтой “туда и обратно”. Электронная почта туда и обратно требуется, когда Вы используете одно и то же значение, указанное в конфигурации mailreader для From Address в правиле вашей электронной почты.
Рассмотрим пример типичной последовательности событий:
1. Пользователь представляет запись электронной почтой, используя требуемый формат. (См. Форматирование электронной почты для представления на странице 98.) ClearQuest назначает новый идентификатор дефекта PROD0000137.
2. Правило электронной почты, которое Вы установили, уведомляет ведущего инженера относительно этого дефекта. (См. Установка правил электронной почты на странице 95.)
3. Ведущий инженер читает сообщение электронной почты “PROD0000137”, затем отвечает электронной почтой, используя требуемый формат, включая замечания в поле описания.
Примечание: Ответ должен включать только те поля, которые Вы хотите изменить. Любое поле, включенное в сообщение, запишется поверх существующих данных.

4. Rational E-mail Reader обрабатывает сообщение электронной почты, и представляет измененную запись в базу данных ClearQuest. 

10. Импортирование данных в ClearQuest

Эта глава описывает, как импортировать данные из существующей системы управления запросами изменения в ClearQuest.
Содержание этой главы:
· Подготовка к успешному импорту данных
· Создание импортируемого файла ClearQuest 
· Выполнение импорта данных 
Подготовка к успешному импорту данных
Прежде, чем Вы начнете импортировать данные, тщательно спланируйте ваше преобразование:
· Проанализируйте ваши текущие данные и поток работ для того, чтобы Вы знали, как это осуществить в ClearQuest. Для краткого обзора того, как работать с ClearQuest, см. главу 2, Понятия администрирования ClearQuest.
· Создайте схему импорта, чтобы поддержать данные, которые Вы хотите импортировать. См. Создание схемы импортирования на странице 100.
Модернизируйте существующую пользовательскую базу данных или создайте новую базу данных, и свяжите ее с импортируемой схемой. См. Создание базы данных для импортированных данных на странице 101.
· Экспортируйте ваши существующие данные в текстовые файлы, которые используют формат импорт-файла ClearQuest. См. Создание схемы импортирования на странице 100.
· Используйте ClearQuest Import Tool для импортирования данные из файлов импорта в вашу пользовательскую базу данных. См. Выполнение импортирования данных на странице 104.
Примечание: Перед импортированием всех ваших данных, сначала проверьте весь процесс импорта на подмножестве ваших данных. См. Тестирование процесса импорта на странице 101.
Создание схемы импортирования
Перед импортированием данных в ClearQuest, Вы должны создать схему импортирования, или изменить существующую схему, чтобы поддержать данные, которые Вы хотите импортировать. При создании схемы импортирования учтите следующее:
· Схема импортирования должна содержать типы записей и поля с соответствующими поведениями и типами данных, чтобы поддержать ваши данные. Схема должна также содержать действия и переходы состояния, которые Вы хотите использовать с импортированными записями.
· Схема должна содержать форму, которую пользователи могут использовать для рассмотрения и изменения импортированных данных.
· Для записей, которые содержат списки ссылок, схема должна содержать тип записей, который является адресатом для ссылки.
Например, если Вы импортируете записи дефектов, которые содержат поле для проекта, Вы должны создать тип записей проекта перед импортированием записей дефектов, а затем заполнить тип записей проекта названиями проектов.
· Если Вы импортируете хронологию, присоединения или дублируете записи, или если Вы модернизируете существующие записи, схема должна содержать поле для сохранения старых значений идентификаторов.
· Если Вы импортируете списки выбора, удостоверьтесь, что схема содержит значения для списка выбора, которые соответствуют значениям, указанным импортируемыми записями.
Примечание: В процессе импорта ClearQuest не проверяет правильность типов данных. Если записи, которые Вы импортируете, содержат типы данных, которые ClearQuest не поддерживает, Вы можете отображать эти типы данных в другие типы ClearQuest. По умолчанию ClearQuest отображает неподдерживаемые типы данных как тип STRING. См. Типы данных, поддерживаемые в ClearQuest на странице 103.
Важно отобразить все поля и состояния в вашей существующей системе в поля и состояния ClearQuest. Если Вы не обеспечите отображение между экспортируемым полем и полем ClearQuest, данные для этого поля не импортируются. Если состояние поля не отображено, ClearQuest по умолчанию отображает все такиеи записи в состояние Submitted, делая, таким образом, вашу модель состояний неэффективной.
Подробная информация? См. главу 4, Работа со схемами ClearQuest и главу 5, Настройка схемы.
Оригинальный идентификатор записи

ClearQuest назначает новый идентификатор для каждой импортированной записи. Поэтому, убедитесь, что ваша схема импортирования имеет поле, содержащее первоначальный идентификатор записи. ClearQuest использует первоначальный идентификатор записи при импортировании дубликатов, хронологии и присоединения. Он также полезен для обнаружения записей, основанных на первоначальном идентификаторе записи.
Примечание: Если Вы используете ClearQuest Export Tool для экспора данные из другой базы данных ClearQuest, отобразите поле идентификатора в файле импорта в первоначальное (старое) полю идентификатора.
Создание базы данных для импортированных данных
Перед импортированием данных в ClearQuest, Вы должны создать пользовательскую базу данных, соодержащую импортируемые данные и связать эту базу данных со схемой импортирования. Вы можете использовать существующую пользовательскую базу данных, если она уже связана со схемой, которую вы настроили как схему импортирования. Только модернизируйте пользовательскую базу данных более новой версией схемы. Помните, однако, что Вы можете модернизировать пользовательскую базу данных только с более новой версией той же схемы, но не с другой схемой.
Подробная информация? См. Обновление пользовательской базы данных на странице 37. Просмотрите databases, creating в оглавлении справочной системы ClearQuest Designer.
Тестирование процесса импорта
Прежде, чем Вы начнете импортировать все ваши данные в ClearQuest, Вы должны проверить весь процесс импорта на подмножестве ваших данных:
· Экспортируйте подмножество ваших существующих данных в файлу импорта ClearQuest.
· Выполните ClearQuest Import Tool, чтобы импортировать данные.
Поработайте с данными в ClearQuest client, чтобы увидеть, функционирует ли ваша схема импортирования как ожидается.
· Измените схему импортирования по мере необходимости, основываясь на вашем тестировании, затем проверьте процесс еще раз.
Создание импортируемого файла ClearQuest
Прежде, чем Вы сможете импортировать данные в ClearQuest, Вы должны использовать инструмент вашей системы, чтобы экспортировать данные из этой системы в разграниченный текстовый файл, который использует формат импорт-файла ClearQuest  . Вы должны создать отдельные файлы импорта для каждого типа записей и для хронологии и присоединений. Этот раздел описывает требования к формату файла для импорта файлов записей, хронологии и присоединений.
Примечание: Удостоверьтесь, что Вы имеете надежный способ экспортировать данные из вашей старой системы. Проверьте экспорт несколько раз, чтобы убедиться, что  результаты непротиворечивы.
Форматирование файлов импорта записей
Файл импорта для типа записей – это список строк, заканчивающихся символом окончания строки.

Первая строка файла импорта содержит список экспортируемых имен полей. Последующие строки содержат значения полей для индивидуальных записей, упорядоченных согласно порядку имен полей в первой строке.

Имена и значения полей заключенны в двойные кавычки. Наиболее общий формат разделителя в пределах строки – это запятая, но Вы можете также использовать двоеточие, точку с запятой, звездочку или метку табуляции.
В течение импорта ClearQuest преобразует значение каждого поля в поле соответствующего типа, определенного в схеме ClearQuest. Например:
"id","state","submitdate","severity","priority","summary","description"

"1","Submitted","4/11/00 7:00.00","3-Workaround","3","The shortcut for ""Printing"" is grayed out","See summary --John"

"2","Opened","4/14/00 11:32.00","1-Crash","1","Can’t login to the system","I typed my login and the hourglass sign appears, but after 15 minutes, I still can’t type my password. There’s an infinite loop somewhere."

Значение поля State определяет текущее состояние записи на момент импортирования. ClearQuest проверяет правильность полей импортированных записей, но не проверяет правильность действий, требуемых для достижения определенного состояния.
Важные соображения по форматированию файла импорта
При форматировании файла импорта учтите следующее:
· В разграниченном запятыми файле данных, значения поля могут содержать внутренние запятые, так как они были ранее включены в пределы кавычек, окружающих поле. Например:
"I typed my login and the hourglass sign appears, but after 15 minutes,

I still can’t type my password. There’s an infinite loop somewhere."

· Внутренние двойные кавычки в значениях поля, должны быть заключены в добавочные двойные кавычки. Например:
"The shortcut for ""Printing all"" does not work."

Если поле не заполнено, используйте " ", "<<None>>" или "<<Unassigned>>".
· Не включайте пробелы перед или после символа - разделителя.
· Прежде, чем Вы сможете импортировать ссылочные поля, Вы должны сначала импортировать значения для упомянутых типов записей. Значения, которые файл импорта имеет для этих полей, должны уже существовать в ClearQuest. Это относится и к пользователелям.
· Пункты в ссылочном списке должны быть отделены запятыми в файле импорта (например, "Ref1, Ref2, Ref3").
Типы данных, поддерживаемые в ClearQuest
Значения полей в файле импорта интерпретируются согласно типу данных, определенному для соответствующего поля в схеме ClearQuest. ClearQuest поддерживает следующие типы данных:
	Тип данных 
	Описание 
	Поведение

	ATTACHMENT_LIST 
	Список полей с типом Attachment
	Интерпретирован как список имен для присоединений 

	DATE_TIME
	SQL дата и время 
	Преобразован в дата/время 

	INT 
	Целое число SQL 
	Преобразован в целое число 

	MULTILINE_STRING 
	Строка символов переменной длины неограниченного размера 
	Установлен к максимальной длине в схеме для этого типа 


	REFERENCE 
	Ссылка на отображение имени в основанном на состоянии или не имеющем состояний типе записей 
	Интерпретирован как ключ к не имеющему состояний типу записей 

	REFERENCE_LIST 
	Множественные ссылки для отображения имени в основанном на состоянии или не имеющем состояний типе записей 
	Интерпретирован как список ссылок. Заметьте, что запись не поддерживается для полей REFERENCE_LIST.

	SHORT_STRING 
	Строка символов переменной длины с максимальной длиной 254 символа 
	Установлена как есть 

	STATE 
	Резервировано для системных полей 
	CQ проверяет правильность значения поля, но запускает действия, необходимые  для достижения состояния 


Примечание: ClearQuest отображает неподдерживаемые типы данных как STRING. Вы отображаете типы данных и поля в ходе фактического процесса импорта, используя ClearQuest Import Tool (описан позже в этой главе).
Форматирование файлов импорта хронологии
Формат для файла импорта хронологии требует, чтобы каждая хронология была своей собственной строкой, и каждый элемент имел оригинальный идентификатор, идентифицирующий запись,  которой принадлежит хронология. Остальные поля содержат информацию относительно действия, которое было выполнено, и должны быть следующими:
· Оригинальный идентификатор записи
· Отметка времени
· Имя пользователя
· Выполненое действие
· Старое состояние
· Новое состояние
Примечание: Если Вы используете ClearQuest Export Tool, чтобы экспортировать данные из другой базы данных ClearQuest, Export Tool сохраняет оригинальный (старый) идентификатор записи в поле, называемом “display_name”. Отобразите поле display_name для оригинального (старого) идентификатора записи.
Ниже представлен пример файла импорта хронологии. Он использует оригинальные идентификаторы записей,  для которых он является хронологией:
"id","timestamp","user_name","action_name","old_state","new_state"

"1","Apr 6 2000 8:31AM","srahman","close","open","closed"

"2","Apr 6 2000 9:40AM","srahman","verify","closed","verified"

Дата должна полностью определять год. Вы можете использовать следующие форматы даты:
"6 April 2000"

· "April 6, 2000 8:30:00"

· "8:30:00 Apr 6 2000"

· "4/6/2000 8:30:00PM"

Форматирование файлов импорта присоединений
Формат файла импорта для присоединений требует, чтобы каждый элемент имел оригинальный идентификатор, идентифицирующий запись,  которой принадлежит присоединение. Остальные члены каждого элемента перечисляют присоединенные файлы, связанные с каждым полем присоединенной записи. Имена путей для присоединенных файлов одного типа данных поля присоединения сгруппированы вместе внутри одного набора кавычек и отделены символами - разделителями.
Примечание: Если Вы используете ClearQuest Export Tool, чтобы экспортировать данные из другой базы данных ClearQuest, Export Tool сохраняет оригинальный (старый) идентификатор записи в поле, называемом “display_name”. Отобразите поле display_name для оригонального (старого) идентификатор записи.
Следующий пример связывает три присоединенных файла с записью, оригинальный идентификатор которой - 101. Схема содержит два поля присоединения, attfield1 и attfield2:
"id","attfield1","attfield2"

"101","c:\temp\101_1.txt,c:\temp\101_2.txt","c:\temp\101_3.txt"

В этом примере, attfield1 имеет два связанные с ним присоединенных файла. Запятая отделяет имена путей для файлов. ClearQuest сохраняет фактическое содержание присоединений, а не только ссылки на них, и использует имя пути, чтобы найти и прочитать файл.
Выполнение импортирования данных

После того, как Вы установите пользовательскую базу данных, чтобы принять ваши данные и экспортировать данные в файл импорта, Вы готовы выполнить импорт данных. Вы должны выполнить импорт, по крайней мере, три раза: для каждого типа записей, для хронологии и для присоединений.
Если Вы имеете множество типов записей, Вы должны импортировать их в порядке, который позволяет ссылаться на них. Например, если Вы имеете тип записей дефектов, который ссылается на тип записей проектов,  сначала импортируются записи проектов, затем импортируются записю дефектов.
Рассмотрите импортирование всех записей в вашей системе, даже тех,  которые были разрешены. Для включения всех записей, Вы можете обращаться к исторической информации относительно ваших проектов и немедленно генерировать записи, полезные для управления.
Примечание: Вы можете также отдельно импортировать дубликаты записей. См. Импортипрование дубликатов записей на странице 109.
1. Выберите Rational ClearQuest Import Tool из меню Start. Напечатайте ваше имя пользователя и пароль, затем выберите базу данных, в которую вы будете импортировать. Нажмите OK, чтобы открыть диалог Setup Import files and Format.
2. В диалоге Setup Import files and Format:
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Когда сделаете это, нажмите Next, чтобы открыть диалог Setup Destination Entity and Data Type to Import.
Примечание: Если преобразование записи терпит неудачу, она сохраняется в файле ошибок, который Вы определили. Вы можете использовать этот файл, чтобы установить проблемы и повторно импортировать запись. См. Импортирование записей из файла ошибок на странице 110.
3. В диалоге Setup Destination Entity and Data Type to Import:
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Примечание: В ClearQuest Import и Export Tools термин Сущность (Entity) относится к типу записей.
Если сущность адресата имеет состояния, выберите Imported field with State information. Определите экспортируемое поле, которое отображается в поле состояния, которое Вы определили в схеме импортирования. Поле состояния определяет состояние импортированной  записи. Если это поле пусто, значения ClearQuest устанавливает значения по умолчанию  к Submit.
Примечание: Имена состояний в вашем файле импорта должны соответствовать тем, которые Вы определили в схеме импортирования. Если Вы хотите использовать иные имена состояний, Вы должны редактировать ваш файл импорта, чтобы использовать новые имена. Например, если ваше текущее приложение использует состояние, именуемое Submitted, но в схеме импорта Вы назвали это состояние New, Вы должны редактировать ваш файл импорта и заменить Submitted на New.
Если импортированные записи содержат дубликаты, нажмите Import Duplicates, и выберите экспортируемое имя поля, которое содержит дубликат информации. Для получения дополнительной информации об импортировании дубликатов, см. Импортирование дубликатов записей на странице 109.
Выберите ClearQuest field containing original ID. Это - поле в схеме импортирования, которое содержит оригинальный идентификатор записи экспортируемых данных. Это поле важно для импортирования хронологии, присоединений и дубликатов записей.
Примечание: ClearQuest позволяет Вам модифицировать записи, которые Вы предварительно импортировали. Если Вы модернизируете предварительно импортированные записи, хронологию или присоединения, нажмите Upgrade existing records.
Если Вы использовали ClearQuest Export Tool, чтобы экспортировать дубликат информации записи отдельно,  нажмите Upgrade existing records и Import Duplicates. Это добавляет дубликат информации к существующим записям. Если Вы импортируете дубликаты записей из другого приложения, см. Импортирование дубликатов записей на странице 109.
После выполнения нажмите Next, чтобы открыть диалог Setup Field Mapping.
4. В диалоге Setup Field Mapping создайте соответствие "один к одному" между полями в файле импорта и полях, которые Вы создали в схеме импортирования ClearQuest. Если имена полей те же самые, отображение произойдет автоматически.
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· Вы не можете отобразить поле в файле импорта  больше, чем в одном поле в схеме ClearQuest.

· Если поле время отображается в поле дата-время ClearQuest, ко времени присоединяется сегодняшняя дата. Также, если поле дата отображается в поле дата-время  ClearQuest, к дате присоединяется текущее время.
Нажмите Save, чтобы сохранить отображения в текстовом файле. Это позволит Вам повторно открывать файл отображения, если Вы должны будете повторить процесс импорта.
После выполнения нажмите Next, чтобы открыть диалог Perform Import.
5. В диалоге Perform Import:
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Импортирование хронологии
После импортирования записей, Вы готовы импортировать вашу информацию хронологии. Информация хронологии важна, если Вы хотите иметь для работы анализ истории и тенденций записей.
Перед импортированием информации хронологии, убедитесь, что Вы имеете файл импорта, содержащий поля хронологии. См. Форматирование файлов импорта хронологии на странице 103.
При импортировании хронологии следуйте за процедурой Выполнение импортирования данных на странице 104, со следующими изменениями:
· В шаге 2 в диалоге Setup Import files and Format:
· В поле Import File напечатайте путь к файлу импорта хронологии.

· В поле Error File напечатайте расположение и имя для файла ошибок. Если Вы имеете файл ошибок импортирования записей, используйте иное имя для файла ошибок хронологии.

· В шаге 3 в диалоге Setup Destination Entity and Data Type to Import:
· В поле Destination Entity выберите тип записей – владельцев хронологии.

· В поле Import выберите History.

· Введите имя поля ClearQuest типа записей – владельцев, содержащее оригинальный идентификатор записи в файле импорта. ClearQuest должен знать запись, которой принадлежит информация хронологии.

· В шаге 4 в диалоге Setup Field Mapping отобразите ваши поля хронологии в соответствующие поля в вашей схеме ClearQuest, и сохраните файл отображения.
Все остальные шаги остаются теми же самыми.
Импортирование присоединений

После импортирования записей, Вы готовы импортировать ваши присоединения. Перед импортированием присоединений, убедитесь, что Вы имеете файл импорта, содержащий информацию присоединения. См. Форматирование файлов импорта присоединений на странице 104.
Чтобы импортировать присоединения, следуйте за процедурой Выполнение импортирования данных на странице 104, со следующими изменениями:
· В шаге 2 в  диалоге Setup Import files and Format:
· В поле Import File напечатайте путь к файлу импорта присоединения.

· В поле Error File напечатайте расположение и имя для файла ошибок. Если Вы имеете файл ошибок импортирования записей, используйте иное имя для файла ошибок присоединения.

· В шаге 3 в диалоге Setup Destination Entity and Data Type to Import:
· В поле Destination Entity выберите тип записей – владельцев присоединений.
· В поле Import выберите Attachments.
· Введите имя поля ClearQuest типа записей – владельцев присоединений, содержащее оригинальный идентификатор экспортируемых данных. ClearQuest должен знать запись, которой принадлежит присоединение.

· В шаге 4 в диалоге Setup Field Mapping отобразите ваши поля присоединения в соответствующие поля в вашей схеме ClearQuest, и сохраните файл отображения.
Вся другие шаги остаются теми же самыми.
Импортирование дубликатов записей

Вы можете импортировать дубликаты записей при импортировании всех ваших записей. При импортировании дубликатов записей учтите следующие требования:
· Импортируемые дубликаты должны иметь указатель на их оригинальный идентификатор.
· Вы должны указать, какое поле в вашей ClearQuest схеме импортирования отображает идентификатор оригинальной записи. ClearQuest использует оригинальную запись для поиска предка дубликата записи.
· В пределах ClearQuest дубликаты записей обрабатываются с использованием состояния Duplicate и действия Duplicate. Убедитесь, что ваша схема включает и то и другое.
Примечание: Если Вы используете ClearQuest Export Tool, чтобы экспортировать данные из другой базы данных ClearQuest, отдельный файл импорта для дубликатов записей создается автоматически.
Чтобы импортировать дубликаты записей:
1. Следуйте за процедурой Выполнение импортирования данных на странице 104.
2. В шаге 3 в диалоге Setup Destination Entity and Data Type to Import нажмите Import Duplicates и введите имя поля, которое содержит идентификатор оригинальной записи (идентификатор записи, которую дублирует эта запись).
3. Выполните импортирование. Любой дубликат, который не сможет сослаться на свою исходную запись (потому что он был импортирован перед предком), сохранится в файле ошибок.
4. Когда импорт будет закончен, используйте файл ошибок, чтобы импортировать дубликаты, которые не импортировались успешно в первый раз.
Отдельное импортирование дубликатов записей
Другой способ импортирования дубликатов записей состоит в том, чтобы создать отдельный файл импорта для дубликатов записей, также как Вы это делаете для хронологии и присоединений. Тогда Вы можете импортировать все ваши другие записи (исключая дочерние записи) и импортировать дубликаты позже.
Импортирование записей из файла ошибок
Если в течение импортирования происходят ошибки, ClearQuest создает следующие файлы:
· error file: ClearQuest сохраняет неимпортированные записи в файле ошибок, название и расположение которогоВы определили в шаге 2 выше.
· errlog.txt: ClearQuest сохраняет сообщения об ошибках в текстовом файле в вашем системном каталоге Temp.
Чтобы повторно импортировать эти проблемные записи:
1. Просмотрите файл errlog.txt и сделайте обзор типов ошибок, с которыми Вы столкнулись.
2. Откройте файл ошибок, содержащий неимпортированные записи.
3. Исправьте ошибки в записях. Убедитесь, что  файл ошибок использует формат файла импорта. См. Форматирование файлов импорта записей на странице 102.
4. Выполните процесс импорта снова, на сей раз определяя файл ошибок как файл импорта.
Обновление существующих записей
Вы можете использовать ClearQuest Import Tool, чтобы модифицировать записи, которые Вы предварительно импортировали. Например, если Вы изменили в вашей старой системе записи, которые уже были импортированы в ClearQuest, Вы можете модифицировать импортированные записи новыми данными.
Предупреждение: Убедитесь, что Вы не изменяете записи в обоих местах. Если Вы модернизируете существующие записи, которые уже изменили в ClearQuest, Вы потеряете эти ваши изменения.

Чтобы модернизировать существующие записи, следуйте за процедурой Выполнение импортирования данных на странице 104. В шаге 3 в диалоге Setup Destination Entity and Data Type to Import выберите Upgrade existing records. Вся остальные шаги остаются теми же самыми.
11. Схемы и пакеты ClearQuest
ClearQuest предлагает несколько предопределенных схем. Прежде всего, это схемы, соответствующие каждому из наборов программ Windows Rational. Кроме того, ClearQuest предоставляет схему “Blank”, которая содержит только минимально необходимые системные поля.
Каждая предопределенная схема ClearQuest состоит из ряда пакетов. ClearQuest использует эти пакеты для формирования законченной схемы. Пакет содержит часть функциональных возможностей схемы. Например, пакет Email добавляет запись типа Email_rule, которая позволяет администраторам приводить правила конфигурирования электронной почты в согласие с их процессом.
Это приложение описывает схемы и пакеты. Оно содержит следующие разделы:
· Предопределенные схемы ClearQuest
· Пакеты ClearQuest
· Модели состояний для типа записей Defect
· Модели состояний для типа записей EnhancementRequest
· Модели типов состояний для пакетов
Примечание: Когда Вы модернизируете к новой версии ClearQuest, может возникнуть необходимость применить к вашей существующей схеме обновленные версии пакетов, чтобы воспользоваться преимуществом новых функциональных возможностей ClearQuest. См. примечания к выпуску для списка обновленных версий пакетов, которые Вам, вероятно, придется применить.
Подробная информация? Инструкции о том, как добавлять пакеты к схеме, см. Добавление пакетов к схеме на странице 38. Для информации относительно того, как настраивать схему, см. главу 5, Настройка схемы.
Предопределенные схемы ClearQuest

ClearQuest предлагает следующие предопределенные схемы.

	Схема
	Описание
	Включенные пакеты

	Blank
	Содержит только системные поля. Используйте эту схему для создания схемы на пустом месте.
	Нет

	Common
	Содержит типы полей и записей, которые являются общими для всех предопределенных схем. Каждая схема ClearQuest состоит из этой схемы и одного или большего количества пакетов.
	Нет

	DefectTracking
	Содержит поля, необходимые для начала использования ClearQuest для отслеживания дефектов в среде программирования.
	Attachments, Customer, Email, History, Notes, Project, Resolution.

	AnalystStudio
	Для использования с Rational Analyst Studio. Содержит поля и правила для работы с Rational Rose и Rational RequisitePro.
	Attachments, Email, EnhancementRequest, History, Notes, Repository, RequisitePro, Resolution, RequisiteProSupplement.

	DevelopmentStudio
	Для использования с Rational DevelopmentStudio. Содержит поля и правила для работы с Rational Purify, Quantify и Pure Coverage.
	Attachments, Email, EnhancementRequest, History, Notes, PQC, Repository, RequisitePro, Resolution, RequisiteProSupplement.

	TestStudio
	Для использования с Rational TestStudio. Содержит поля и правила для работы с Rational TeamTest, RequisitePro, Purify, Quantify и Pure Coverage.
	Attachments, Email, EnhancementRequest, History, Notes, PQC, Repository, RequisitePro, Resolution, TeamTest, RequisiteProSupplement.

	Enterprise
	Для использования с Rational EnterpriseStudio. Содержит поля и обработчики прерываний, которые работают со всеми программами Rational Suite.
	Attachments, BaseCMActivity, Email, EnhancementRequest, History, Notes, PQC, Resolution, Repository, RequisitePro, TeamTest, UCMPolicyScripts, UnifiedChangeManagement, RequisiteProSupplement.

	Unified Change Management (UCM)
	Поддерживает процесс единого управления изменениями (UCM),  обеспечивая интеграцию с Rational ClearCase.
	Attachments, BaseCMActivity, Email, History, Notes, Resolution, UCMPolicyScripts, UnifiedChangeManagement.


Пакеты ClearQuest
Следующая таблица перечисляет пакеты, включенные в ClearQuest. Некоторые пакеты предназначены только для чтения; их функциональные возможности не могут быть изменены.
	Пакет
	Описание
	Добавленные/
модифицированные типы записей
	Поля

	Attachments
(только чтение)
	Позволяет Вам добавлять и удалять присоединения, связанные с записью.
	Добавляется закладка "Attachment" к допустимому типу записи.
	Поля, добавляемые к допустимому типу записи:
Attachments

	BaseCMActivity
	Обеспечивает поддержку для типа записи BaseCMActivity. Включается в схему UCM и в схему Enterprise как простое действие типа записи. Вы можете использовать его как альтернативу к типу записи о дефекте, как есть, допуская его для унифицированного управления изменениями (UCM), или включать его в новый тип записи.

Для получения дополнительной информации см. Управление проектами программного обеспечения с использованием ClearCase.
	Добавляется к типу записи BaseCMActivity.
	Поля, добавляемые к типу записи BaseCMActivity:
Owner
Description
Headline

	ClearCase
(только чтение)
	Обеспечивает поддержку интеграции с Rational ClearCase.
Об интеграции с UCM, см.  “UnifiedChangeManagement (UCM) (только чтение)” в этой таблице.
	Добавляется к типам записей cc_change set и cc_vob_object.

Добавляется закладка "ClearCase" к допустимому типу записи.
	Поля в типе записи cc_change_set:
objects

Поля в типе записи cc_vob_object:
name
object_oid
vob_Family_uuid

Поля, добавляемые к допустимому типу записи:
cc_change_set

	Customer
	Поддерживает интеграцию данных заказчика с вашей системой управления запросами изменения.
	Добавляет не имеющий состояний тип записи Customer.
Кроме того, добавляет поля ссылки на информацию о заказчике к выбранному Вами типу записи.
	Поля, добавляемые к типу записи Customer:
Attachment
CallTrackingID
Company
Description
Email
Fax
Name
Phone

Поля, добавляемые к допустимому типу записи:
Customer
Customer_Severity

	Enhancement
Request
	Поддерживает дополнительный тип записи для запросов расширения изделия.
	Добавляет тип записи EnhancementRequest.
	Поля в типе записи Enhancement
Request:
Customer_ Company
Customer_Email
Customer_Name
Customer_Phone
Customer_Priority
Description
Headline
Keywords
Owner
Priority
Product
Product_Area
Request_Type
Submit_date
Submitter
Target_Release

	Email 
(только чтение)
	Поддерживает автоматическое уведомление электронной почты об изменении записей.
	Создает не имеющий состояний тип записи Email_Rule.

Добавляет основное действие “Send_Email_Notif” к допустимому типу записи. Это основное действие выполняет правило электронной почты всякий раз, когда вызывается любое действие.
	Поля в типе записи Email_rule:
Actions
Action_Types
CC_Actioner
CC_Addr_fields
CC_Additional
CC_Groups
CC_Users
Change_Fields
Display_Fields
Entify_Def (record type)
From_Addr
Include_Defect
Is_Active_Rule
Filter_Query
Name
Show_Previous
Source_States
Subject_Fields
Target_States
To_Additional
To_Addr_Fields
To_Groups
To_Users

	History 
(только чтение)
	Позволяет Вам сохранять историю всех действий, которые выполняются над записью.
	Добавляет закладку "History" к допустимому типу записи.
	Поля не добавляются

	Notes
	Позволяет Вам сохранять историю всех заметок, которые были сделаны к записи, даты ввода и пользователей.
	Добавляет закладку "Notes" к допустимому типу записи.

Также добавляет основное действие “Init_Note_Entry” к допустимому типу записи.
	Поля, добавляемые к допустимому типу записи:
Note_Entry
Notes_Log

	PQC
(только чтение)
	Обеспечивает поддержку для интеграции с Rational Purify, Quantify и Pure Coverage.
	Добавляет закладку "PQC" к форме допустимого типа записи.
	Поля, добавляемые к допустимому типу записи:
PQC_DiagnosticTool
PQC_Executable
PQC_TestCommand
PQC_TestTool
PQC_Stack
PQC_StackID

	Project
	Позволяет Вам отслеживать записи, соответствующие проекту.

Примечание: Не имеет никакой связи с концепцией UCM “Project”
	Создает не имеющий состояний тип записи Project. 
	Поля в типе записи Project:
Name
Description

Поля, добавляемые к допустимому типу записи:
Project

	Repository
(только чтение)
	Обеспечивает поддержку, необходимую для Rational RequisitePro и Rational TeamTest.
	Создает не имеющий состояний тип записи repoproject, который позволяет Вам использовать проекты TeamTest или RequisitePro с ClearQuest.

Также добавляет основное действие RepoConnect к допустимому типу записи.
	Поля в типе записи repoproject:
Name
TT_Repo (Ссылка на TeamTest Repository)

Поля, добавляемые к допустимому типу записи:
RepoProject

	RequisitePro
(только чтение)
	Обеспечивает поддержку для интеграции с Rational RequisitePro.
	Добавляет не имеющие состояний типы записей Requirements и RequirementsMap.
Добавляет закладку "Requirements" к допустимому типу записи.

Также добавляет основное действие ASCQIBase к допустимому типу записи.
	Поля в типе записи Requirements:
Project_Name
Req_GUID 
Req_ID
Requirement
Tag

Поля в типе записи RequirementsMap:
CQDatabase
CQDatabasePath
CQEntityDefName
CQReqListAttName
CQBackReqListAttName
CQRepoProjectAttName
CQModifyAction
CQDialogTitle
RPProjectName
RPProjectPath
RPReqTypeKey
RPAttrKey
HelpFileName
CQHelpContextID
RPHelpContextID
Поля, добавляемые к допустимому типу записи:
Requirements_List

	RequisitePro
Supplement
	Предоставляет дополнительную поддержку для интеграции с RequisitePro когда Вы используете схемы AnalystStudio, DevelopmentStudio, TestStudio иEnterprise.

Примечание: последняя версия пакета RequisitePro должна быть установлена раньше, чем Вы установите RequisiteProSupplement.
	Выполняет дополнительную установку для типов записей EnhancementRequest and Defect.
	Поля, добавляемые к типу записи Requirement:
Defects_List
EnhancementsRequests_List

	Resolution
	Добавляет поддержку отслеживания пользователей, которые принимали решение по записи.

Требует, чтобы Вы, для отображения состояния схемы в следующем состояни напечатали: Not_Resolved; Resolved
	Добавляет закладку "Resolution" к допустимому типу записи.
	Поля, добавляемые к допустимому типу записи:
Resolution
Resolution_statetype (только чтение)

	TeamTest
(только чтение)
	Обеспечивает поддержку для интеграции с Rational TeamTest.
	Добавляет закладки  "Test Data" и "Environment" к типу записи, который Вы определили.
	Поля, добавляемые к допустимому типу записи:
Build
Company
Computer
Contact
Custom1 (настраивается)
Custom2 (настраивается)
Custom3 (настраивается)
Fixed_in_Build
Hardware
Log
Log_Folder
Old_internal_ID
Operating_System
Other_Environment
Resolution_Description
Requirement
Requirement_ID
Test_Script
Verification_Point

	UCMPolicyScripts
	Обеспечивает поддержку для пакета UnifiedChangeManagement (UCM),  добавляя три глобальных сценария.
	Не добавляет никаких типов записей.
	

	UnifiedChange
Managеment (UCM)
(только чтение)
	Обеспечивает поддержку для процесса UCM,  допуская интеграцию с Rational ClearCase 4.0 и выше; связывает ClearCase Project VOB с пользовательской базой данных ClearQuest. Требует пакета UCMPocyScripts. Может использоваться с пакетом BaseCMActivity.

Требует, чтобы Вы, для отображения состояния схемы в следующем состояни напечатали: Waiting; Active; Ready; Complete.
	Добавляет тип записи UCMUtilityActivity.

Добавляет не имеющий состояний тип записи UCM_Project.

Кроме того, добавляет запросы к рабочему пространству пользователя.
	Поля в типе записи UCMUtilityActivity:
Description
Owner
Headline

Поля в типе записи UCM_Project:
name
ucm_vob_object
ucm_chk_before_deliver
ucm_chk_before_work_on
ucm_cq_act_after_
deliver
Поля, добавляемые к допустимому типу записи:
ucm_statetype
ucm_vob_object
ucm_stream_object
ucm_stream
ucm_view
ucm_project

	Visual SourceSafe
(только чтение)
	Обеспечивает поддержку для интеграции с Microsoft VisualSourceSafe.
	Добавляет не имеющие состояний типы записи SSObject и SCSnapObject.

Добавляет закладку "VisualSourceSafe" к форме допустимого типа записи.
	Поля, добавляемые к допустимому типу записи:
VSSChangeSet

Поля в типе записи SCObject:
CQDefects
VSSCheckOutState
VSSFileName
VSSSpec
VSSUser
VSSVersion

Поля в типе записи SCSnapObject:
CreatedBy
CreatedOn
Label
SnapElements


Модель состояний для типа записи Defect

Тип записи Defect имеет следующие состояния:
	Состояние 
	Описание

	Submitted
	Первое состояние нового дефекта.

	Assigned
	Назначен для решения члену группы.

	Opened 
	Принят в работу.

	Resolved 
	Был разрешен.

	Closed 
	Был проверен.

	Duplicate 
	Дублирует другой дефект.

	Postponed 
	Отложен до другого выпуска или итерации.



Модель состояний для типа записи о дефекте – одна и та же для каждой предопределенной схемы. Вы можете также увидеть эту информацию в матрице переходов состояний (State Transition Matrix) записи типа Defect.
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Все действия Duplicate могут быть отменены с использованием действия Unduplicate.
Модель состояний для типа записи Enhancement Request

Тип записи EnhancementRequest имеет следующие состояния:
	Состояние 
	Описание

	Submitted
	Первое состояние нового запроса изменения.

	Opened 
	Принято в работу.

	Closed 
	Было проверено.

	Duplicate 
	Дублирует другой запрос изменения.


Следующая диаграмма модели состояний показывает, как тип записи EnhancementRequest переходит из одного состояния в другое как результат действия. Вы можете также увидеть, что эта информация содержится в матрице переходов состояний типа записи EnhancementRequest.
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Модели типов состояний для пакетов

Тип состояния – это метка, которая определяет роль состояния в вашей модели состояний. Некоторые схемы и пакеты ClearQuest требуют, чтобы каждое состояние в модели состояний было назначено или отнесено к определенному типу состояний. Например, схема и пакет UnifiedChangeManagement используют типы состояний, чтобы вызвать некоторые сигналы перехода в другое состояние ClearCase. Пакет ClearQuest Resolution использует типы состояний, чтобы вызвать некоторые обработчики прерываний ClearCase, когда запись меняет текущее состояние на состояние, отнесенное к типу “Resolved”.
Примечание: Когда Вы добавляете новое состояние к схеме, которая использует типы состояний, Вы должны сопоставить новое состояние типу состояний. См. Отображение типов состояний на стр. 55.
Модель типов состояний пакета Resolution

Следующие таблица и диаграмма показывают типы состояний и пример правильного отображения состояний для пакета Resolution.
	Тип состояния
	Описание

	Not_resolved
	Запись не разрешена.

	Resolved
	Запись разрешена.
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Модель типов состояний пакета UnifiedChangeManagement

Следующие таблица и диаграмма показывают типы состояний и правильные отображения состояний для пакета UCM. Действия по умолчанию в каждом состоянии должны обеспечить законченный маршрут движения через модель типов состояний.
	Тип состояния
	Описание
	Отображаемые состояния в схеме UCM

	Waiting
	Запись еще не назначена, не отсортировона и не запланирована.
	Submitted
Postponed

	Ready
	Запись назначена для разрешения пользователю и содержится в списке назначений.
	Assigned

	Active
	Пользователь начал работать над записью, которая может теперь содержать информацию об элементе ClearCase.
	Opened

	Complete
	Пользователь завершил работу над записью, которая теперь связана с проектом ClearCase и его элементами ClearCase.
	Resolved
Closed
Duplicate
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12. Настройка ClearQuest для Единого управления изменениями (UCM)

Интеграция ClearQuest/Единое управление изменениями (UCM) связывает проектные действия ClearCase UCM с записями ClearQuest. Для интеграции необходимо следующее:
· Схема ClearQuest, допустимая для UCM
· ClearCase 4.x с проектом, допустимым для работы с ClearQuest
ClearQuest обеспечивает две предопределенные схемы, которые поддерживают UCM: схема UnifiedChangeManagement и схема Enterprise. Самый простой способ выполнения UCM состоит в том, чтобы воспользоваться одной из этих схем.
Вы можете также добавлять интеграцию с UCM к существующей схеме,  устанавливая в схему следующие пакеты:
· UCMPolicyScripts
· UnifiedChangeManagement
Пакеты UCM должны быть добавлены в порядке, указанном выше. Следуйте инстукциям в разделе Добавление к схеме функциональности UCM ниже. Для полного описания этих пакетов, см. раздел Пакеты ClearQuest на странице 112.
Подробная информация? Для полной информации относительно установки и использования интеграции с UCM, см. руководство Управление проектами программного обеспечения с использованием ClearCase, поставляемое с ClearCase.
Добавление к схеме функциональности UCM
Этот раздел описывает, как добавить функциональности UCM к существующей схеме,  устанавливая следующие пакеты UCM:
· Пакет UCMPolicyScripts

· Пакет UnifiedChangeManagement

Эти пакеты UCM должны быть установлены в порядоке, указанном выше. Кроме того, пакет UnifiedChangeManagement требует, чтобы Вы отобразили состояния и добавили к вашей схеме действия по умолчанию.
Инсталляция пакетов UCM
Для добавления к схеме пакетов UCM:
1. В ClearQuest Designer выберите Package > Package Wizard.
2. Выберите пакет UCMPolicyScripts и нажмите Next. (Если пакета UCMPolicyScripts нет в списке, нажмите More Packages и выберите самую последнюю версию, чтобы сначала установить ее в репозиторий схем.)
3. Выберите схему, к которой нужно применить пакет UCMPolicyScripts и нажмите Finish.
Package Wizard "извлекает" схему и устанавливает пакет UCMPolicyScripts.
4. Выберите File > Check In, чтобы "возвратить" схему.
5. Затем, установите пакет UnifiedChangeManagement. Выберите Package > Package Wizard.
6. Выберите пакет UnifiedChangeManagement и нажмите Next. (Если пакета UnifiedChangeManagement нет в списке, нажмите More Packages и выберите самую последнюю версию, чтобы сначала установить ее в репозиторий схем.)
7. Выберите схему, к которой нужно применить пакет UCMPolicyScripts и нажмите Finish.
Package Wizard "извлекает" схему и устанавливает пакет UnifiedChangeManagement.
8. Выберите тип(ы) записей, чтобы допустить их для UCM и нажмите Next, чтобы отобразить диалог Setup State Types.
Примечание: Если Вы допускаете тип записей для работы с пакетами UCM, требуется отдельная форма представления.
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9. В диалоге Setup State Types отобразите состояния в вашей схеме на типы состояний UCM. Нажмите в поле State Types для каждого состояния, и выберите соответствующий тип состояния UCM.
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10. Повторите отображение типа состояния для каждого типа записей, которые Вы допустили в шаге 8. Когда сделаете это, нажмите Finish
Теперь Вы должны назначить действие по умолчанию для каждого состояния в каждом из типов записей, которыеВы допускаете для UCM. См. следующий раздел.
Подробная информация? См. Модель типов состояний  пакета UnifiedChangeManagement на странице 119 этого руководства и руководство Управление проектами программного обеспечения с использованием ClearCase, поставляемое с ClearCase.
Установка действий по умолчанию для пакета UCM
State Transition Matrix в вашей схеме должна обеспечить, по крайней мере, один путь через модель типов состояний для пакета UCM, из состояния типа Waiting к Ready, далее к Active и к Complete. (См. Модель типов состояний  пакета UnifiedChangeManagement на странице 119.)
Для каждого состояния в вашей схеме, кроме состояния, отображенного на состояние Complete UCM, Вы должны назначить действие по умолчанию, которое перемещает  запись из этого состояния к следующему типу состояний в модели состояния UCM.
Чтобы назначиать действия по умолчанию:
1. Откройте State Transition Matrix для типа записей, который Вы допустили для UCM.

2. Щелкните правой кнопкой мыши состояние и выберите Properties, чтобы открыть диалог Properties для этого состояния.

3. На закладке Default Action диалога Properties выберите действие по умолчанию для состояния. Закладка Default Action перечисляет действия, которые Вы создали для ваших переходов состояний в State Transition Matrix.
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Для каждого состояния выберите действие, которое перемещает запись в состояние, которое отображено в следующем типе состояний в модели UCM. Например, состояние Submitted (Waiting) переходит в состояние Assigned (Ready) через действие по умолчанию Assign. Если ваша схема имеет состояние Closed, и оно отображено на тип состояний Complete, действия по умолчанию не требуетс.

Подробная информация? См. Использование действий по умолчанию на странице 59 и Модель типов состояний  пакета UnifiedChangeManagement на странице 119. Просмотрите actions, default в оглавлении справочной системы ClearQuest Designer.
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